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Notices

Danger

This symbol indicates the presence of dangerous voltage within and
A outside the product enclosure that may constitute a risk of electric

shock, serious injury or death to persons if proper precautions are not
followed.

Caution

This symbol alerts the user to the presence of hazards that may cause
& minor or moderate injury to persons, damage to property or damage

to the device itself, if proper precautions are not followed.

Note

This symbol directs the user’s attention to important installation,
% operating and maintenance instructions.

Installation Considerations

Installation and maintenance of the ION8800 meter should only be performed by
qualified, competent personnel that have appropriate training and experience
with high voltage and current devices. The meter must be installed in accordance
with all local and national electrical codes.

If this equipment is used in a manner not specified by the manufacturer, the
protection from electric shock, fire, etc. provided by this equipment may be
impaired.

/\ DANGER

Failure to observe the following instructions may result in severe injury or death.

¢ During normal operation of the ION8800 meter, hazardous voltages are present
on its connector pins, and throughout the connected potential transformer (PT),
current transformer (CT), direct connect without PTs, digital (status) input,
control power and external I/O circuits. PT and CT secondary circuits are
capable of generating lethal voltages and currents with their primary circuit
energized. Follow standard safety precautions while performing any installation
or service work (i.e. removing PT fuses, shorting CT secondaries, etc).

¢ Do not use digital output devices for primary protection functions. These
include applications where the devices perform energy limiting functions or
provide protection of people from injury. Do not use the ION8800 in situations
where failure of the devices can cause injury or death, or cause sufficient energy
to be released that can start a fire. The meter can be used for secondary
protection functions.



¢ The ION8800 meter’s chassis ground must be properly connected to a good
earth ground for safety, and for the noise and surge protection circuitry to
function correctly. Failure to do so will void the warranty, and create a risk of
electric shock, injury or death.

¢ When installing the meter, all voltage paths (measurement voltage and all
auxiliary circuits such as the power supply and the tariff control voltage) must
be fused according to applicable local safety standards.

/\ CautioN

Observe the following instructions, or permanent damage to the meter may occur.

¢ The ION8800 meter offers a range of hardware options that affect input ratings.
The ION8800 meter’s serial number label lists all equipped options. Applying
current levels incompatible with the current inputs will permanently damage
the meter. This document provides installation instructions applicable to each
hardware option.

¢ Do not HIPOT/Dielectric test the digital (status) inputs, digital outputs, power
supply terminals or communications terminals. Refer to the label on the
ION8800 meter for the maximum voltage level the device can withstand.

¢ Replacing the meter battery with the wrong type or voltage rating could result
in damage to the meter. Use only a lithium LiSOCl, battery with a rated voltage

of 3.6 V, and the same construction as the original battery, as a replacement.

Network Compatibility Notice for the Internal Modem

The internal modem in meters equipped with this option is compatible with the
telephone systems of most countries in the world. Use in some countries may
require modification of the internal modem’s initialization strings. If problems
using the modem on your phone system occur, please contact Schneider Electric
Technical Support.

Standards Compliance

C€

Made by Power Measurement Ltd.

PowerLogic, ION, ION Enterprise, MeterM@il and Modbus are either trademarks
or registered trademarks of Schneider Electric.

Covered by one or more of the following patents:

U.S. Patent No's 7010438, 7006934, 6990395, 6988182, 6988025, 6983211, 6961641,
6957158, 6944555, 6871150, 6853978, 6825776, 6813571, 6798191, 6798190, 6792364,
6792337, 6751562, 6745138, 6737855, 6694270, 6687627, 6671654, 6671635, 6615147,
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Chapter

1

Introduction

This manual discusses ION8800 meter features and provides configuration
instructions.

By the time you are ready to use this guide, your meter should be installed, most
basic setup should have been performed, and communications/basic operation
should have been verified. If the unit is not yet installed and operational, refer to
the Installation Guide shipped with the meter.

This chapter provides an overview of ION8800 meters and summarizes many of
their key features.

In This Chapter

¢ ION88OOMeters ........covniiiiiiiiiiiiiiiiiiinenennnnnnnn 10
The ION meter in an Enterprise Energy Management System ............... 11

@ MeterFeatures ....... ...ttt i i i 12
Measured Parameters .......... ... ... .. i 12
Rack-mount Installation ........... ... .. ... . o o i 14
Data Display and Analysis Tools .................. ... o ... 14
Supported Protocols .......... . .. 14
Communications Options . ........ ... ... ... ... ... 15
IRIG-B GPS Time Synchronization ................. ... ... i, 15
IO OPHONS ...t 15
ION Enterprise Software Support ............. ... i 16
ION Setup Software Support .............. i 17
ION EEM Software SUpport . ...t 17
UsingthisGuide .. .......ciitiiiiii ittt ittt ineennnnnn 18
Getting More Information ...........c.ciiiiiiiiiiiiinnnnnnnn.. 20
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ION8800 Meters
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The ION8800

IONB8800 intelligent metering and control devices provide revenue-accurate, true
RMS measurements of voltage, current, power and energy, and are complemented
by extensive I/O capabilities, comprehensive logging, and advanced power quality
measurement and compliance verification functions. The meters come with an

extensive selection of pre-configured data screens and measurements, so you can
use the meters “out of the box” or customize them to fit your unique requirements.

IONB8800 meters can replace numerous transducers, traditional meters, and control
circuits. You can integrate the meters with ION® software or other energy
management, SCADA, automation and billing systems, using multiple industry-
standard communication channels and protocols.

Common Meter Applications
Transmission and distribution metering
Revenue and tariff metering

Power quality compliance monitoring
Power quality analysis

Load management

System stability monitoring

Energy pulsing and totalization
Instrument transformer calculation

Transformer\line loss calculation

® 6 6 6 6 6 O O 0 o

Real-time system loss measurements

Page 10
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The ION meter in an Enterprise Energy Management System

Power System Connections

Phase voltage, phase current, ground current, @ - Power Monitoring Network

and neutral current from Wye, Delta, or - Third-Party Software for 3
N single-phase power systems Modbus, DNP 3.00, Mv90,
! DLMS

Onboard 1/0

- Pulses
- Breaker Status

- Control Signals
- Energy Pulses

You can use ION8800 meters as standalone devices, but their extensive capabilities
are fully realized when used with ION software as part of an enterprise energy
management (EEM) system.

EEM systems give energy suppliers, service providers, and large industrial and
commercial energy consumers the tools to meet all the challenges and
opportunities of the new energy environment. EEM systems use real-time
information and control to directly address a broad range of requirements
throughout the power delivery chain and across an entire enterprise. These
systems offer an integrated solution to managing new billing structures,
distributed generation, energy purchasing, energy cost control, operational
efficiency, and power quality and reliability.

Applications that include the meter typically require additional equipment.
Display and analysis software tools are almost always used to manage, interpret
and distribute the data measured or logged by a meter. There are usually a variety
of tools used, and often these tools are connected using different communications
standards and protocols. In many cases, a meter must also provide control
capabilities and device-level data sharing.

The meter can adapt to many situations. Advanced communications allow data to
be shared simultaneously across multiple networks, built-in I/O provides
monitoring and control capabilities, and a variety of display and analysis tools to
help you get the most from your power system.

Internet Connectivity

- MeterM@il
- WebMeter functionality

- XML compatibility Data Analysis Tools

/ Corporate Network [

Communications

. . - RS-232 and high speed RS-485
On-Site Data Display imtormal Modem

- 240 by 64 pixel LCD - Front IEC optical port

- 10 Base-T and 10 Base-FL Ethernet

- Protocols: ION, Modbus Master, Modbus RTU,
Modbus TCP, DNP 3.00, ModemGate (modem

Remote Data Display

- Vista screens to RS-485 gateway), EtherGate (Ethernet to RS-
- WebReach screens 485 gateway), GPS: Arbiter, GPS: True Time/
- WebMeter screens Datum, DLMS

© 2007 Schneider Electric. All rights reserved. Page 11
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Meter Features

The IONS8S800 offers three base models: ION8800A, ION8800B, and IONS8800C.
¢ Feature Set C -- Energy/tariff meter

¢ Feature Set B -- Feature Set C + EN50160 and IEC 61000-4-30 Class A compliant
power quality monitoring

¢ Feature Set A -- Feature Set B + power quality analysis (waveforms and transient
capture with 1024 samples/cycle resolution)

Measured Parameters

All ION8800 meters provide fully bi-directional, 4-quadrant, revenue-accurate or
revenue-certified energy metering. The following is a selection of some parameters
measured by these meters.

Energy

The meters provide all common active, reactive and apparent energy parameters.
kWh delivered and received

kWh, kvarh, kVAh net (delivered - received)

kWh, kvarh, kVAh total (delivered + received)

kvarh, kVAh delivered and received

Volt-hours and amp-hours

® 6 6 6 ¢ o

Integration of any instantaneous measurement
Energy registers can be logged automatically on a programmed schedule.

All energy parameters represent the total for all three phases. Energy readings are
true RMS. Maximum range of energy readings is 999,999,999. Beyond this value,
readings roll over to zero (0).

Demand

The meters support all standard demand calculation methods, including block,
rolling block, and predicted demand. They can measure demand on any
instantaneous value and record peak (maximum) and minimum demand with
date and time-stamps to the second. Peak demand registers can be reset manually
(password protected) or logged and reset automatically on a programmed
schedule. Measurements include:

& kW, kvar, kVA demand, min/max
¢ Amps, Volts demand, min/max

¢ Demand on any instantaneous measurement

Page 12 © 2007 Schneider Electric. All rights reserved.
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Instantaneous

ION8800 meters provide a choice of high-accuracy 1 second, or high-speed 1/2
cycle measurements, including true RMS, per phase and total for:

Voltage and current

Active power (kW) and reactive power (kvar)
Apparent power (kVA)

Power factor and frequency

Voltage and current unbalance

® 6 6 6 o o

Phase reversal

Harmonics

The meter offers complete harmonic distortion metering, recording and real-time
reporting, up to the 63rd harmonic for all voltage and current inputs.

¢ Individual harmonics (including magnitude, phase and inter-harmonics for the
IONS8800A meter)

& Total even and odd harmonics

& K-factor, Crest factor

Min/Max Recording

The meters record each new minimum and new maximum value with date and
time-stamp for the following parameters:

¢ Voltage and current min/max
kW, kvar, and kVA min/max
Power factor

Frequency

Voltage unbalance

* 6 6 o o

Plus any measured value

Power Quality

The meters measure and record the following parameters:

¢ Sag/Swells

¢ Transients (feature set A only)

ION8800 meters with feature sets A and B comply with the following power
quality standards:

¢ EN50160

¢ IEC 61000-4-30 (Class A)

© 2007 Schneider Electric. All rights reserved.
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Rack-mount Installation

The ION8800 meter easiléé installs into new or existing IEC/DIN 43862 19" racks.
The meter’s rear Essailec™ connectors provide common voltage and current
measurements and energy pulsing pin-outs for reduced installation costs.

Data Display and Analysis Tools

Display and analyze meter data with a wide variety of tools.

The Front Panel

Use the meter’s front panel interface for local monitoring and standalone
applications. The bright LCD display lets you view real-time values and perform
basic device configuration. The front panel is often used in combination with an
ION software system, providing an interface for field personnel.

WebMeter® Embedded Web Server Feature

Ethernet-equipped meters include WebMeter functionality -- an on-board web
server that provides quick and easy access to real-time energy and basic power
quality information without special software. The meter’s built-in web pages
display a range of energy and basic power quality information via an Ethernet
connection, and support basic meter configuration tasks.

MeterM @il® Internal E-Mail Client Feature

Configure the meter to automatically email high-priority alarm notifications or
scheduled system-status update messages to anyone, anywhere within the facility
or around the world. Specify the type of event that triggers an email alert, such as
power quality disturbances or logged data at any pre-determined interval, and
have your ION software administrator program the meter to respond with a
MeterM@il message when these events occur. MeterM@il messages are received
like any email message by a workstation, cell phone, pager, or PDA.

XML Compatibility

Your meter can exchange information using industry-standard XML format. This
simple machine-readable format supports easy integration with custom reporting,
spreadsheets, databases, and other applications.

Supported Protocols

You can integrate the meter into various industry-standard networks. Measured
meter data can be made available to other devices using Modbus RTU, Modbus/
TCP, DLMS and DNP 3.0 protocols, as well as the Itron MV-90 revenue billing
system. You can also configure the meter to import and log data from other devices
on these networks. With these advanced communications functions, the power of
the meter can be utilized in most existing power monitoring systems.

Page 14 © 2007 Schneider Electric. All rights reserved.
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Any data display and analysis software that works with Modbus RTU or DNP 3.0
devices also functions with the meter.

Communications Options

The standard meter includes an IEC 1107 front optical port for communications in
the field. Ordering options include a Communications Module which offers a
high-speed RS-485 port, a selectable RS-232/RS-485 port, a 10Base-T Ethernet port
or 10Base-FL fiber-optic port, and a 56 kbps internal modem. Depending on the
hardware options purchased, up to five separate ports can communicate
simultaneously.

2\ NOTE

The communications module can be retrofit — it can be installed or replaced while the meter is in the field.

IRIG-B GPS Time Synchronization

1/0 Options

Meters ordered with the optional IRIG-B configuration can receive input from any
GPS receiver that outputs unmodulated IRIG-B time code data, enabling time
synchronization with an accuracy of +/- 1 millisecond.

The meter’s digital inputs and outputs connect to the Essailec connector on the
back of the meter. Two different I/O configurations are available, each providing
different capabilities. Additionally, two infrared ports (and corresponding LEDs)
on the front panel are configured by default for energy pulsing.

Digital Inputs

The meter can be ordered with externally-excited digital inputs capable of
detecting a pulse rate of 20 pulses/second and timestamping transitions with 1 ms
resolution. They can be used for tariff inputs or other pulse counting applications.

Relay Outputs

The meter can be ordered with both Form C and Form A solid-state outputs; one
mechanical Form C relay is standard on all meters. The solid-state outputs have a
maximum voltage rating of 250 VDC, 210 VAC or 300 volts peak and 100 mA AC/
DC. The mechanical relays are rated at 250 VAC /125 VDC and can switch up to
1 A loads.

© 2007 Schneider Electric. All rights reserved.
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ION Enterprise Software Support

The complete ION Enterprise software package integrates the meter into a fully
networked information system with other meters and local and wide-area
computer networks. ION Enterprise is recommended for all power monitoring
systems where advanced analysis and control capabilities are required.

ION Enterprise provides tools for managing your power monitoring network,
logging data, analyzing real-time and logged data, generating power system
reports, and creating custom functionality at the meter level.

Vista

Vista presents a graphical view of your power system, allowing you to view and
analyze real-time data from power meters and historical data from the ION
database. Vista reports on the status of your system components, informing you of
alarm conditions and providing you with control capabilities for initiating
intelligent device functions or actuating field machinery. Vista includes
sophisticated tools for analyzing real-time and logged power data and system
events.

For more information, refer to the Vista section in the online ION Enterprise Help.

WebReach (online Vista)

The WebReach component of ION Enterprise adds thin-client support
functionality to the ION Enterprise software. With the WebReach feature you can
use the web browser from any machine on your network to view the Vista
diagrams of all the meters on your network, regardless of whether they are located
locally or across the country. You can create custom screens in Vista for display in
your web browser, including real-time numeric data, background graphics or
diagrams, and basic views of event, data and waveform logs.

Reporter

Reporter lets you define and create comprehensive database reports using
Microsoft Excel. Configured Power Quality, Load Profile, Energy and Demand,
EN50160 and IEC 61000-4-30 reports are available for Reporter.

For more information, refer to the Reporter section in the online
ION Enterprise Help.

Management Console

Management Console is used to build your ION Enterprise power-monitoring
network to reflect the way the physical communications network is wired, so ION
Enterprise software can communicate with your devices. The network is created
using sites, servers, modems, and intelligent devices that can be added, removed,
configured, or duplicated.

Page 16 © 2007 Schneider Electric. All rights reserved.
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You can access the following tools from the Management Console menus:

¢ Diagnostics Viewer is the primary source of troubleshooting information in
ION Enterprise.

¢ Device Upgrader lets you upgrade the operating software inside an ION meter.
¢ Remote Modem Setup lets you set up modems for remote sites.

¢ Database Manager lets you manage your ION Enterprise databases with both
manual tasks and scheduled tasks.

¢ User Manager lets you configure ION Enterprise software user accounts that
define different operations permitted within the ION software, such as viewing
meter data, performing control actions, or configuring the meters.

¢ License Manager lets you upgrade the number of devices you can have without
re-installing the software.

For more information, refer to the Management Console section in the online
ION Enterprise Help.

Designer

Use Designer to customize the operation of hardware nodes, such as ION meters,
and software nodes, such as the ION Virtual Processor, the Log Inserter, and the
Query Server. Designer uses a WYSIWYG graphical user interface to pictorially
represent a node’s configuration (i.e., how the different ION modules are linked
together in a framework). In addition to giving you the ability to change the
settings of any ION module, Designer also lets you change existing links between
modules, add new links, add new modules or delete modules. Designer helps you
visualize the logic when you are programming custom functionality in an ION
device.

For more information, refer to the Designer section in the online
ION Enterprise Help.

ION Setup Software Support

ION Setup is a software tool designed specifically to configure and test meters.
ION Setup offers an intuitive graphical interface for performing basic meter setup,
installing templates into meters, viewing real-time and resetting accumulated
values, verifying meter calibration and measurements, and setting up advanced
security. Versions 2.1 and later support ION8800 meters.

ION EEM Software Support

ION EEM is web-based software that gathers, cleanses, and integrates real-time
and archived data - from new or legacy meters, weather service feeds, real-time
pricing, and other sources - and translates it into precise and actionable
information via a fully accessible dashboard. It enables organization-wide
collaboration by offering custom information to decision makers, planners, and
front line staff: analysis and reporting tools, real-time monitoring, and alerting
capabilities.

© 2007 Schneider Electric. All rights reserved.
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Using this Guide

This User Guide is directed at three types of user: the typical user or operator, the
system administrator, and the advanced user. You might not fit into any of these
groups directly, or perhaps you are both an operator and an administrator. These
classifications are intended to make this guide easier to navigate with respect to
which information is appropriate to your needs.

Typical User or Operator

Most users simply want to display the data provided by the factory-configured
meter. These users want fast access to data through the front panel, ION software,
or a third-party protocol such as Modbus or DNP.

System Administrator or Manager

Some users need to make minor adjustments so that their meters “fit” their power
systems: data recording intervals, demand sub-intervals and other parameters
may need to be set before the meter’s setup is complete. These users will use the
front panel, or ION software to change settings in the device’s operating software
(ION Enterprise is highly recommended.)

Advanced User or Systems Integrator

Advanced users can make use of the flexibility and power provided by the meter’s
operating software. These users need to become familiar with the ION
architecture, and the ION software tools used to customize the device’s operation.

Symbols

The following symbols are used in this manual to warn you about the risk of
injury, damage to the equipment, inconvenience if the proper procedure is not
followed, or additional information you may want to consider.

/\ CAuTION

This symbol alerts you to things that may cause loss of data, damage to your computer or your device.

/A\ DANGER

This symbol alerts you to things that may cause serious injury to a person. Only qualified, properly trained

personnel should perform these procedures.

2\ NOTE

A note provides you with additional information that you might want to consider.

O ™

This symbol draws your attention to information that will help you perform a task more quickly or easily.

Page 18
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Terminology

Clear: Place the mouse cursor over the check box for the specified
option then click the mouse button so that the check mark is
removed from the check box.

Click: Place the mouse cursor over the specified option or button,
then press and release the mouse button.

Double-click:  Place the mouse cursor over the specified option or button,
then press and release the mouse button twice.

Drag: Hold down the mouse button while moving the mouse cursor
to the appropriate location, then release the button.

Enter: Type the information, then press the Enter or Return key.

Point: Position the mouse pointer over a submenu or menu
command. For example, point to the File menu.

Press: Press the specified key or key combination on your keyboard,
for example, press Ctrl+Alt+Del.

Select: Place the mouse pointer over the check box for the specified
option, then click the mouse button so that an X or check mark
appears in the check box.

OR

Place the mouse pointer over the specified box or button, then
click the mouse button.

Type: Type the information. Do not press the Enter or Return key.

PDF Documents

This manual is also provided in PDF (Portable Document Format) on the website.

Use Acrobat Reader to view and print the PDF version of the manual. When
printing the manual, please print the entire manual, including the copyright and
disclaimer statements.

The PDF files for all Schneider Electric products are available from the website.
Each Schneider Electric device has installation information and a user guide to
teach you about the features of your device.

ION meters are programmed using ION modules that are linked to create
unlimited custom functionality. Your meter has many pre-configured modules
that provide most functionality that you need. If you want to extend or customize
the functionality of your meter consult the online ION Reference for general
information and ION module descriptions. For information on configuring
specific meter features, search the technical notes.

© 2007 Schneider Electric. All rights reserved.
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Getting More Information

Additional information is available from Schneider Electric:
¢ visit our website at www.powerlogic.com

¢ contact your local Schneider Electric representative

¢ contact Schneider Electric directly

Documents that are related to the installation, operation and application of the
meter are as follows:

ION8800 Installation Guide

This brief manual is shipped with each meter. It details the mounting, wiring and
basic setup of the device.

ION Reference

The ION Reference describes ION architecture (the common software architecture
in all ION devices) and provides an explanation for each of the ION modules.

Online ION Enterprise Help & Online ION Setup Help
In-depth online help systems for ION Enterprise and ION Setup software.

Technical Notes

Technical notes provide instructions for using meter features and for creating
custom configurations.

Product Option Documents

These documents include instructions on how to retrofit your current product with
your new option, and how to utilize the option.

Protocol Documents

Each protocol document contains information explaining how our products
interact with a protocol, such as DNP 3.0, DLMS, Modicon Modbus, and MV-90.

Page 20
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Front Panel

The front panel of the ION8800 provides a user-friendly interface from which you
can view system data or configure meter settings. A scrollable display and three
distinct modes (NORM, ALT and TEST) provide easy access to a full range of
functions through a simple three-button keypad.

Another set of buttons, protected under a sealable cover, provides advanced
functionality.

This chapter describes the front panel and explains how to use it to display data,
perform tests, and set up basic configuration options.

In This Chapter

¢ FrontPanelFeatures ..........cooivuiiiiiiiiiiiiiiiinnnenn. 22

o Display Screen Types .. ..vviiitiiiiii ittt it it 26

¢ Modesof Operation .........ccoviiiiiiiiiiniiiiinnneeennnnnn 29

& Configuring the Meter with the FrontPanel ........................ 31
Setup MeNUS . ... 32

© 2007 Schneider Electric. All rights reserved.
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Front Panel Features

The front panel of the ION8800 includes:
¢ aliquid crystal display with detailed graphics and text

¢ navigation buttons to move from screen to screen, and for basic setup
procedures

operational LEDs to indicate meter conditions
energy pulser ports and LEDs to aid in meter testing

IEC 1107 optical serial port

* 6 o o

protected (sealable) buttons for advanced meter configuration

This section outlines the features available on the front panel of the meter.

Main display

Operational ARG D
e | | KVAblock peak deiiver m%‘éﬁ’nﬂ
o kvarblmkpeakd&l%er 008:436'00 e buron
OAO8E006 9450 i o

Status bar 5451 04150006

| 7 e 3 Sealed buttons
Optical port - : ‘ / R s (under cover)

varh pulser Wh pulser
and LED and LED

Meter display

The meter’s display shows numeric data screens, event logs, phasor diagrams, bar
graphs and harmonics histograms. As the graphic above illustrates, the display
screen is divided into two sections: the main display area and the status bar.

The main display area presents meter data, while the status bar provides time,
date, phase, quadrant, and mode information. During normal operation, the main
display area automatically cycles through a series of several displays. If you prefer,
you can use the Up or Down arrow buttons to step manually through these
displays. By default, the automatic scrolling will resume 60 seconds after you have
last pressed a button.

Page 22
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Navigation buttons

The navigation buttons are the Up and Down arrow buttons and the round
Alt/Enter button. Pressing the Up or Down arrow buttons to manually scroll back
or forth through the available displays temporarily halts the display screen’s
automatic scrolling function. Pressing Alt/Enter toggles between NORM and ALT
display modes. The automatic scrolling function restarts 60 seconds after a button
was last pressed.

Hold the Alt/Enter button for approximately three seconds to display the Setup
menu. You can then use the navigation buttons to view the device's configuration
or edit communication settings. See “Setup Menus” on page 32 for further
instruction on modifying the device's configuration using the front panel buttons.

Operational LEDs

Three operational LEDs are located to the left of the display screen.

Alarm (top): The alarm output flashes to alert maintenance personnel should any
internal diagnostic errors occur. Contact Technical Support if this happens.

Indicator (middle): This LED is user programmable and is not linked by default.

Power (bottom): This LED indicates the meter is powered. The light should always
remain on when the meter is in service.

Energy pulser ports and LEDs

Two red LED pulsers located below the front panel display represent Wh - to the
right - and varh - in the middle. On the left is the optical port.

These LEDs are preconfigured for energy pulsing. Located directly beneath each
LED is an infrared output, which is connected to the LED and pulses at the same
rate. Pulse rates can be adjusted by re-configuring the Calibration Pulser module;
for a detailed description of LED pulsers operation, see “Energy Pulsing with
Infrared Ports and LEDs” on page 137.

Optical port and LED

An optical port facilitates infrared communication with the device. For details on
how to configure and use this port, see “Optical Port Connections (COM1)” on
page 74.

A green LED pulser, located above the optical port, flashes to indicate
communications activity on the port.

© 2007 Schneider Electric. All rights reserved.
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The following protected buttons can only be accessed when the meter cover is
open:

Demand reset button (B1)

The recessed Demand Reset button resets the peak demand values logged in the
meter. When the meter is in TEST mode, the Demand Reset button resets the test
demand parameters.

The ION setup register labeled Demand Lockout Time sets the minimum time
allowed between consecutive demand resets; the meter ignores any attempts to
reset the demand outside the bounds of the register. The default value for the
Demand Lockout time is 25 days. For details on the Demand Lockout Time setup
register, see “Demand and Peak Demand Module Overview” on page 120.

TEST Mode button (B2)

The recessed TEST Mode button is located under the meter's front cover; it places
the meter into TEST mode. While in TEST mode, the meter ceases accumulation of
billable quantities; energy and demand measurements are accumulated in TEST
mode registers.

See “TEST Mode” on page 30 for more details on this mode of operation. Billable
quantities do not accumulate when the meter is in TEST mode.

ALT Config button (B3)

The recessed ALT Config button is located under the meter's front cover; press this
button to access the Alternate Configuration menu.

Use the Alternate Configuration menu to control setup access via the front optical
port, lock and unlock the meter, and clear alarms.

Master Reset button (B4)

The recessed Master Reset button is located under the meter's front cover; it resets
meter values. Use the Master Reset button to delete most accumulated values and
all derived revenue measurements from the meter.

To use the Master Reset button:

1. Open the meter front cover.

2. Using a pen or similar instrument, press the Master Reset button.

3. At the confirmation screen, select Yes to confirm the reset.

/\ CAuTION

After initiating a Master Reset, wait until the “Master Reset Completed” message appears on the front
panel (or about two minutes, depending on your firmware). This allows the meter to completely reset

parameters. This is especially important if you are powering down the meter after a Master Reset.
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Hardware-Locked Meters and Master Reset

A hardware-locked ION8800 meter must first be unlocked to perform a master
reset. To perform a master reset on a hardware-locked meter, you must first unlock
the meter via the ALT Config menu. Then you can continue the master reset using
the previous instructions.

Parameters affected by a Master Reset

The Master Reset button resets many of the device's measurements and logs.

The following parameters are reset to zero:
¢ Energy and Demand

¢ Peak Demand

¢ Loss Calculation

¢ Power Quality disturbance counters

& Time of Use

The following are cleared:
¢ Event Log

¢ All Data Recorders

& All Waveform Recorders

Spare button (B5)

This button is currently not used.
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Display Screen Types

The front panel displays measurements, configured settings and configuration
data in a variety of forms. The types of display screens are described below. For
information on customizing the display on your meter, see “Configuring Front
Panel Displays” on page 166.

The status bar

The status bar runs along the bottom of the front panel display and contains
information about the following settings:

& Date and time.

¢ Voltage phases present. The labels and rotation of phases correspond to the
configuration of the power monitoring system. 12 31 is for Delta configuration
and 123 is four wire Wye configurations.

¢ Quadrant where the system power factor resides.
& Mode (NORM, ALT or TEST).

¢ Time remaining in the Rolling Block Demand interval. If the interval has
counted to zero the letters EOI (End Of Interval) appear on the status bar. If the
interval is counting down then a time remaining indicator appears.

\

! 5800

9:36:54  12/09/2005 123 Q1 TEST W]

Numeric displays

All NORM mode data and some of the ALT mode display screens use numeric
displays. Numeric displays show up to four parameters at a time. If no numeric
values are available for a parameter, N/A is displayed.

Uin 1 MAX
0000347.9 «w

Updated at: 12/09/2005 9:15:33
9:36:54 12/09/2005 123 Q1  NORM WM

The front panel automatically scales the units for basic measurements (i.e. voltage,
current and power parameters). For example, a measurement of 2,000 Watts is
displayed as 2 kW. A measurement of 2,000,000 Watts is displayed as 2 MW. The
meter makes these conversions using your PT and CT Ratios.
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Nameplate display and event log

Nameplate displays and event logs appear in ALT mode and are organized in
tabular format. Nameplate displays show owner, meter and power system details:

OWNER Best Utility
TAG 1 Substation 13A
TAG 2 Main Feed 13kV
FW Rev, FEATURE SET 8800V310, A
BATTERY LIFE 96.9% DIAG NUM 40/999
15:36:54 12/09/2005 Q1T ALT W1 3:39m

The Event Log displays recent high priority events. You must use ION software to
retrieve all logged data:

DATE TIME EVENT CODE
12/08/2005 10:23:45  Shutdown SD25
12/08/2005 10:42:03  Power Up SD25

12/08/2005 11:19:26  Changed Setup  SD25
VIEW EVENT LOG THROUGH COMMUNICATIONS
9:36:54  12/09/2005 123 Q1 NORM W]

Histogram displays

Harmonic content is displayed in histogram format. The 2" to the 63" harmonics
are displayed in the histogram. The total harmonic distortion (THD) is displayed
above the histogram.

Ut HARMONICS
THD: 50%

R 10 30 0

93654 120092005 123 Q1 NORM W

Phasor diagram displays

Phase information can be displayed in phasor diagram format. Phasor diagrams

are accompanied by tables that show phase, voltage and current magnitudes. In

cases where a phase vector is too small to be represented graphically, it is shown
as a table entry only.

us 13 Ul 846KV 0

U2 885KV 240
U3 846KV 120

ul N 2006A 20

12 n 2 2106A 220

v2 13 204.5A 100
9:36:54 12092005 123 Q1 NORM W
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Disk simulator

This display simulates the behavior of a mechanical watt-hour meter indicating
power received or delivered by the direction of the pulse.

KWh delivered 1.29

9:36:54  12/09/2005 123 Q1 NORM W ]

Time and date

This display supports time and date formats, enabling displays with nothing but
date and/or time and/or time remaining in the current interval.

9:36:54
12/09/2005

9:36:54  12/09/2005 123 Q1 NORM N ]

Time-stamped values

Up to three timestamped parameters can display on the same screen. The
timestamp indicates the time that the displayed parameter was last updated.

kW  block peak deliver 000001
12/09/2005 7:30:00
kVA block peak deliver 000002
12/09/2005 7:30:00
Kvar block peak deliver 000001
12/09/2005 7:30:00
9:36:54 12/09/2005 123 Q1 NORM W]
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Modes of Operation

The ION8800 has three modes of operation: NORM, ALT and TEST. Both NORM
and ALT are display modes, providing various power system data and meter
properties screens. TEST mode is used to perform diagnostics and verify the
meter’s calibration and function.

2\ NOTE

If your meter has the optional hardware lock, you must open the meter’s cover to put it into TEST mode.
See “Meter Security Features” on page 50 for more information.

Basic operation (NORM mode)

The ION8800 meter defaults to NORM mode when powered up, and remains in
this mode until you manually switch to ALT or TEST.

2\ NOTE

You can customize NORM mode display screens and alter the front panel’s scrolling characteristics by
editing the configuration of the meter’s Display and Scroll modules — see “Display Setup Menu” on
page 35 for more details.

If you have a meter without the hardware lock, all of the settings available in the
panel Setup menu can be changed while the meter is in NORM mode, provided
you have the correct password. If you have a hardware-locked meter, only the
basic communications parameters in the COM Setup menu can be changed in
NORM mode. (You must unlock the meter to change other meter parameters on
the hardware-locked meter — see “ALT Config Menu” on page 37 for more
details.)

ALT mode

ALT mode provides scrolling display screens that show power system data, billing
information (including extensive Time of Use data) and meter properties such as
Nameplate information.

See “ALT mode default display screens” on page 170 for a description of ALT
mode screens.

Switching to ALT mode

Press the Alt/Enter button to switch to ALT mode. Press the Alt/Enter button again
to switch back to NORM mode at any time. If no buttons are pressed, the meter
automatically reverts to NORM mode after five minutes. As with any mode,
pressing any button temporarily suspends display screen scrolling, allowing you
to press the Up or Down arrow buttons to manually browse the available screens.
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TEST Mode

TEST mode is typically used for verifying meter calibration and function. The
meter is usually reading data from a test power supply while these functions are
performed.

All of the billing quantities that are recorded when the meter is in NORM and ALT
mode will stop accumulating when the meter is switched to TEST mode — the data
is sent to special TEST mode registers instead. The values accumulated in these test
registers are displayed on the front panel (and in ION software).

The regular NORM/ALT mode billing registers are unaffected while the meter is
in TEST mode; accumulation of this data continues as soon as you exit TEST mode.
All test registers are reset to zero when you exit TEST mode.

For detailed information on TEST mode, see “Switching to TEST Mode” on
page 176.

2\ NOTE

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode
from ALT mode.
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Configuring the Meter with the Front Panel

With the meter’s front panel, you can navigate through different menus to perform
basic setup on your meter.

Accessing the Setup Menus

To access the Setup menu, press and hold the front panel's Alt/Enter button while
the meter is displaying power system data. Within the Setup menu is a list of sub-
menus that contain the meter’s configurable settings. Setup menu items are
described in “Front Panel Features” on page 22.

Press the Up or Down arrow buttons to navigate through the menu. Highlight a
menu item and press the Alt/Enter button. When you select an item from the Setup
menu, you will be presented with another menu of the settings in the meter. You
may need to navigate several layers of menus to access the setting you want to
change.

The following diagram shows how the buttons are used to navigate the menus:

"1 2401114
12 295131
8800 SETUP
RETURN
DEMAND SETUP
COM1 SETUP
COM2 SETUP
COM3 SETUP
COM4 SETUP
NETWORK SETUP

6‘ BASIC SETUP

AT/

ENTER RETURN

VOLTS MODE

PTPRIMARY

The settings contained in the main Setup menu are:
Basic Setup: changes basic settings in the power measurement system
configuration.
Demand Setup: Rolling Block/Sliding Window Demand settings.
COM1 Setup: optical port setup.
COM2 Setup: optional RS-485 port setup.
COM3 Setup: optional RS-232/RS-485 multiplexed port setup.
COM4 Setup: settings for the optional modem.
Network Setup: settings for the optional Ethernet port.

Format Setup:  customizes the style and values appearing on the display
screens.

Display Setup:  customizes display appearance, update time, and demand
lockout time.

Security: allows you to modify your password, disable the
password, disable meter configuration with a web
browser, and acknowledge alarms.

Another setup menu, the ALT Config menu, is accessed by pressing a sealed
button. See “ALT Config Menu” on page 37 for more information.
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CONFIRM CHANGE
YES
NO

Setup Menus

8800 SETUP
RETURN
BASIC SETUP s
Y RETURN
il \/0LTS MODE
PT PRIMARY

Returning to Previous Setup Screens

Use the Up or Down arrow buttons to scroll through the menu items. When the
setting you want to change is highlighted, press the Alt/Enter button.

To return to a previous screen, highlight the RETURN menu item and then press
the Alt/Enter button.

Configuring Parameters Using the Navigation Buttons

Use the Up or Down arrow buttons to change the value (if numeric) or the setting
(if enumerated) of the highlighted parameter.

To change the position of the cursor, press and hold the Up or Down arrow
buttons for about one second. The Up arrow button moves the cursor one position
to the left, and the Down arrow button moves the cursor one position to the right.
Once you have the value you want, press the Alt/Enter button to select it.

2\ NOTE

When setting Ethernet values (IP address, default gateway, etc.), press the Up arrow button to insert

additional digit spaces. Press the Down arrow to remove digit spaces (see “Network Setup Menu” on
page 34 for more information).

OUT OF RANGE screen

When editing numeric data the numbers below MIN and MAX indicate valid entry
bounds. If you enter a value outside valid bounds, you will be presented with an
OUT OF RANGE screen. You can then either return to the register you were
editing or choose to exit.

Confirming Configuration Changes

The CONFIRM screen appears whenever you attempt to change the meter’s
settings through the front panel. This allows you to abort an unwanted
configuration change. The front panel also informs you when an entry is out of
range. In either case, you must press the Alt/Enter button to return to the previous
setup screen.

The following sections describe the various Front Panel setup menus.

Basic Setup Menu

To view the Basic Setup menu via the meter’s front panel, press and hold the Alt/
Enter button. Press the Up or Down arrow buttons to highlight Basic Setup then
press the Alt/Enter button.

The Basic Setup menu lets you set volts mode, potential transformer (PT) and
current transformer (CT) ratios and various other settings (such as 14 and voltage
and current polarities) so that you can ensure that your meter is adequately set for
your application.
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8600 SETUP

BASIC SETUP

DEMAND SETUP
COM1 SETUP

. AT/
. ENTER

DEMAND SETUP
RETURN

SWD SUBINTERVAL

SWD # SUBINTERVLS

8800 SETUP COM1 SETUP
DEMAND SETUP
o™\ RETURN
COM2 SETUP =17,/ PROTOCOL
. BAUD RATE

Many of the settings will be configured when the meter is initially put into service
(the device will not operate properly until Volts mode and PT and CT ratios are
set), but some settings may need to be changed to refine the device’s operation.

See the Basic Setup chapter for more information on the Basic Setup menu.

Demand Setup Menu

To view the Demand Setup menu via the meter’s front panel, press and hold the
Alt/Enter button. Press the Up or Down arrow buttons to highlight Demand Setup
then press the Alt/Enter button.

The Demand Setup menu accesses the global settings for all of the revenue related
Rolling Block (Sliding Window) Demand functionality in the ION8800 meter. The
settings provided in the Demand Setup menu control the timing of these demand
calculations.

See the Demand chapter for more information on the Demand Setup menu.

COM Ports Setup Menu

To make changes to communications settings via the meter’s front panel, hold
down the Alt/Enter button for three seconds to enter the Setup menu, then press
the Down arrow button to select the COM Setup you want. Depending upon the
communications options ordered with your meter, the parameter settings
available are as follows:

Menvu ltem Description

COM1 Setup Settings for the optical communications port.

COM?2 Setup Settings for the dedicated RS-485 port.

COM3 Setup Settings for the selectable RS-232 or RS-485 communications port.
COM4 Setup Settings for the modem.

Network Setup Settings for the Ethernet communications port.

Serial COM Settings

There are three main parameters that you must set or verify if your meter is
connected to a serial network (including modem communications): Unit ID, Baud
Rate, and Protocol.

2\ NOTE

Other parameters, such as TRANSMIT DELAY, are used in advanced configuration or fine-tuning your

system. Settings for the parameters mentioned above are commonly required to get your meter
communicating.
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8800 SETUP

COM3 SETUP
NETWORK SETUP

FORMAT SETUP

NETWORK SETUP
& > RETURN
I —P-N\" P ADDRESS

8800 SETUP

NETWORK SETUP

FORMAT SETUP
DISPLAY SETUP

MASK

FORMAT SETUP
& RETURN
: [ PHASE LABELS

| PF SYMBOL

Network Setup Menu

There are two main parameters that you must set or verify if your meter is
connected to an Ethernet network: IP address and Subnet mask address.

2 NOTE

There are other parameters, such as GATEWAY ADDRESS and SMTP ADDRESS, that are used in advanced
configuration or in fine tuning your system. The parameters discussed here are the most common

parameters required fo get your meter communicating.

Configuring Network Settings Through the Front Panel

Typically, your Network Administrator will provide you with the appropriate IP
Address for the meter. The Subnet Mask and Gateway settings are only required
if you have communications between multiple Ethernet networks and if
subnetting is implemented.

/\ CAUTION

Configuring the IP Address, Subnet Mask, and Gateway registers incorrectly can cause network

disruptions. See your network administrator for more information.

Use the navigation buttons to edit the values of the network settings so that they
match your system addresses. As you configure the network addresses, the front
panel automatically discards unnecessary leading zeroes from each three-digit
grouping. The hidden leading zeroes appear (and disappear again) as you move
the position of cursor across the network address.

89.123.40.[156

In the example above, the highlighted zero is discarded as soon as you change the
position of the cursor.

For more information, see the Communications chapter.

Format Setup Menu

Format Setup contains the following values that set labeling and formatting
preferences.
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Menu Setting Description Range (Values) Default
Phase Labels Specifies how phases are labelled ABC, RST, XYZ, RYB, 123 123
PF Symbol LD (leading)/LG (lagging) LD/LG, +/-, CAP/IND LD/LG
Digit Group Specifies symbols used to delimit thousands | 4 544 5 1,000.0 or 1000,0 1000,0
and decimal place holder
Date Format Specifies how dates are displayed mm/DD/YYYY’ DD/MMAYYY, YYYY/ MM/DD/YYYY
S /DD
g Show DST Determines if DST is shown or not Yes or No Yes
4 - -
Volts Decimal Number of decimal places displayed for 1 to 123 456 789 XXX 1.XX
voltages
Current Decimall Number of decimal places displayed for 1 o 123 456 789 XXX 1,XXX
currents
Power Decimal Number of decimal places displayed for 110 123 456 789 XXX 130K
power measurements

8800 SETUP

FORMAT SETUP
DISPLAY SETUP

SECURITY

CONTRAST

Display Setup Menu

For more information, see the Displays chapter.

You can configure the following display preferences within Display Setup.

when in Delta mode

Menu Setting Description Range (Values) Default
Update Rate Sets when the display updates (in seconds) 1t06 1
Contrast Higher numbers are sharper 0to9 varies
Specifies the time it takes the backlight to turn 300 seconds
Backlight TO (Timeout) | off (zero value causes the display to stay lit 0 to 7 200 seconds (two hours) (five minutes)
indefinitely) © vies
DMD Lock TO Controls the minimum allowable time between | O (disabled) to 5 184 000 216 000
consecutive demand resets (in seconds) (60 days) (25 days)
E Defines how long the meter remains in TEST 1800
2. | TEST Mode TO mode before switching back to NORM mode | 60 to 21 600 .
B0 . (30 minutes)
(=) (in seconds)
For display screens that are set to display
Display Scale scaled parameters, this determines the scale 1 to 999 999 1000
applied to displayed parameters
. Specifies whether parameters are divided or . .. -
Scaling Mode multiplied by the scale before being displayed Multiply or Divide Divide
Delta Vectors Specifies how vector diagrams are displayed System or Instrument System

8800 SETUP

Security Menu

DISPLAY SETUP
SECURITY SECURITY
RETURN < RETURN

MODIFY PASSWD
DISABLE SECURITY

The settings in the front panel Security menu item allow you to:

¢ modify the existing meter password or reset it to the factory default
¢ disable the password security check

¢ enable web browser configuration on the meter

¢ acknowledge alarms

You require the valid password to enter the Security Settings menu. The default
password is 0 (zero).
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For more information, see the Security chapter.

2\ NOTE

The password enables users to change the configuration of the meter. It is recommended that you change
your password from the default when you put the meter into service

If you have not yet entered your password, the meter’s front panel requires that
you enter it before you can view the Security Setup menu. Use the Navigation
buttons to enter numerical data. If you enter an incorrect password, the front panel
will display an “invalid password” message and you will have to try again.

Modify Password Sub-Menu

Use this sub-menu to change the password or to reset the password to the factory
default (0).

From the meter’s front panel select SECURITY, then MODIFY PASSWORD. Two choices
appear: MODIFY PASSWORD or FACTORY DEFAULT. Use the Up button to select
MODIFY PASSWORD, or the Down button to select FACTORY DEFAULT.

Disable Security Sub-Menu

Use this sub-menu to enable and disable password security on the ION8800.
Disabling the password allows changes to all the meter’s settings through the front
panel without a security check.

/\ CautioN

Non-secure access to critical settings in the meter, such as PT and CT ratios, is not advisable. It is highly
recommended that any ION8800 meters in the field have the password security check enabled.

When you re-enable password security, the password is reset to the factory default
of 0 (zero). You should re-enter a custom password at this point.

Disabling the Password Security Check is necessary to write to the meter when it
is a Modbus Slave device. See “The Meter as Modbus Slave” on page 91 for details
about configuring your meter for third-party systems.

Web Config

Use this setting to enable/disable web browser configuration of the meter. See
“Enabling and Disabling Web Config Access” on page 54 for more information.

Ack Alarms

Selecting this acknowledges alarms; it is not a configuration setting.
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ALT Config Menu

This advanced menu is accessible by pressing the ALT Config button, located
under the meter cover.

configuration is prevented, as are meter resets

Sefting Description Range (Values) Default
IR Config Allqws meter configuration via the front Disabled or Enabled Enabled
optical port
Meter Lock! When meter is locked, most meter Locked or Unlocked Locked?

Clear Alarms

Sends a pulse to clear alarms when pushed

1 After a meter is unlocked, it automatically relocks if you do not perform any configuration for 30
minutes. This function is not available on non-hardware lockable meters.

2 Default = ‘Locked’ on meters ordered with Hardware Lock option.
Default = ‘Unlocked’ on all other meters (sefting is non-functioning).
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Templates and Firmware

Your meter comes installed with a pre-configured default template. This template
contains various frameworks which provide all the power measuring and
analyzing functionality of the meter. Templates and frameworks can be used
immediately without any user configuration (“right out of the box”). They can also
be customized, reconfigured, and pasted from one meter to another.

For more information on templates, frameworks and ION modules, see the
ION Reference.

Your meter’s operating system is known as firmware. When newer firmware is
available for your meter, simply upgrade to the latest version for all the added
features and functionality.

2\ NOTE

Firmwares and templates for the various meter types (ION8800A, ION8800B and ION8800C) are not
interchangeable. When upgrading firmware or re-installing templates, make sure that you choose the
correct files for your meter type.

In This Chapter

¢ FactoryInformation ............. ...t 40
Factory Module Settings ............. ... ... ... ... i 40
Howto TAG YourMeter ........ ... ... ... ... 40

# Restoring the Factory Configuration .. ............ ..., ... 4]

Using the Front Panel ............... ... ... ... .. il 41
UsingION Setup ... 41
Using Designer .......... ... ... i 42

¢ UpgradingYourMeter ............ccoiiiiiiiiiiiinnieeenn.... 43
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Factory Information

The Factory module displays firmware version, serial number and other device
information in read-only setup registers (read-only registers can be viewed but not

changed).

Factory Module Settings

The device information provided is as follows:

Setup Register

Description

Device Type

A device type identifier (e.g. “8800" for the ION8800)

Compliance

A statement of whether the device is ION compliant or not

Options Shows model number of meter

Revision The meter’s firmware version

Serial Num The meter’s serial number

ION Version The ION version supported by the device

Template The name of the template (framework) installed on the device at the factory

Device Namespace

This configurable string is used as the namespace aftribute in the
GeneratedBy and Device elements of XML attachments.

Device Name

This configurable string is used as the name attribute in the GeneratedBy
and Device elements of XML attachments.

Nom Freq

The expected frequency of the power system being monitored

The Factory module also contains numerous read-only setup registers that hold
the calibration constants used at the factory.

How to TAG Your Meter

Three configurable setup registers are provided for you to enter your company
name and other text information you want stored in the meter:

Owner - This is a text register for storing user information (e.g. company name); it
can be up to 255 characters in length.

Tag 1 - This is a text register for storing user information (e.g. device location); it
can be up to 15 characters in length.

Tag 2 - This is a text register for storing user information (e.g. device number or
identifier); it can be up to 15 characters in length.

Use ION Setup to configure these registers.

© 2007 Schneider Electric. All rights reserved.




ION8800 User Guide Chapter 3 - Templates and Firmware

Restoring the Factory Configuration

If you have made changes to the default functionality and want to return to the
factory configuration, you can re-initialize the factory configuration in the meter
using ION software. The basic setup of the device can be retained, so the meter
does not need to be taken out of service for a long period of time.

2\ NOTE

If you restore the factory configuration, all custom features you have created are lost.

Using the Front Panel

You cannot restore the factory configuration from the meter’s front panel.

Using ION Setup

1. Download your device’s latest template from the website. Save the .DCF file in
the .../ION Setup/TEMPLATE folder for easy access.

2. Connect to your meter in ION Setup, using Basic Mode.
3. Navigate to Setup Assistant > Template.
4. Click the Send to Meter tab and click Send.

Setup Assistant E
= Template Saveto PC  Sendto Meter | Firrnware Upgradel Register Editl
= Baszic Setup
E= Security Sends a previously stored meter configuration file [.DCF) into an 10N
(2] Communications e

== Demand

(27 Inputs/Outputs

21 Logging FACT DeviceType 2300

(Z1 Reverue FACT Revision BO002_8800
— Power Quaiiy l 8500_FAC

== Displays FACT Default Template  B800_INH_v1.1.
== ‘erification

== Feports

N |

< Back | Mest » | Exit | Help |

5. Select the .DCEF file from the TEMPLATE folder and click OK.
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6. The Template Paste Options screen appears. Select the check boxes for the
settings you want to retain (not overwrite) and click OK.

Template Paste Options E

— Mewver o

Comm Settings

Security Settings

Log kil Modules
Modbusz kazter Settings

— Alzo, retain the following

Mameplate Settings
[ Energy Readings
[I7C Settings

ak. I Cancel | Help |

Rapid Meter Programming pastes the template onto your meter. A dialog box
confirms the paste was successful.

Using Designer
1. Display the meter’s main Configuration screen in Designer.
2. Select Edit > Select All then press Delete.

The confirmation dialog box appears explaining that some modules will not be
deleted (core modules cannot be deleted — scroll down in the dialog to see
which standard modules will be deleted).

3. Click OK on the confirmation dialog box.

After a brief wait the modules are deleted and the main meter Configuration
screen is blank except for the Frameworks folder in the Advanced Setup area.
(The Frameworks folder contains the folder of Core modules which cannot be
deleted.)

4. Select Edit > Select All to select the Frameworks folder. This selects all
subfolders and modules within the folder.

5. Select Edit > Paste from Framework, then select the appropriate .fwn file from
the folder ...\ION Enterprise\ config\fmwk\nd\. Click OK.

The Factory module’s Default Template register tells you the filename for the
default factory framework. (For details about framework files, contact Technical
Support or visit www.pwrm.com/support.)

6. Click Open. The Paste Summary window appears.

7. Click on the first module, scroll down to the last module, hold the Shift key and
click on the last module. This selects all of the modules.

8. While holding the Shift key, click on the check box to the left of the module name
so you see a lock icon with a green check mark.
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Persistent modules can be overwritten in Designer. When pasting a default framework onto a meter, use
lock-paste on the Persistent modules, not free-paste. A list of Persistent modules is available from
Technical Support.

9. Select “Maintain external inputs” and click OK on the confirmation dialog box.

A message appears indicating that Designer is pasting modules. All modules are
selected when the paste is complete. Click anywhere in the background of the
node diagram to deselect all of the modules.

10. Click the Power Meter shortcut in the Basic Configuration area to select it. Once
selected, click Reset in the Designer toolbar or select Edit > Reset. This reverts
the Power Meter to the settings it had before you deleted any modules (retaining
the basic setup you previously had).

11. Select File > Send & Save. The factory configuration is now restored and any
custom functionality you created is removed.

2\ NOTE

The time required to complete steps 3, 5, and 11 may vary depending on your connection and the meter

configuration.

See the Designer section in the ION Enterprise online help for more information.

Upgrading Your Meter

See the Upgrading ION Device Firmware technical note for details.
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Basic Setup

This chapter explains how to perform basic meter setup using the front panel or
ION software.

In This Chapter
@ Infroduction ...t 46
Configuring BasicSetup ........... ... i i 46
Using the FrontPanel ........... ... .. ... ... ... .. i i i i, 46
Using ION Setup ... 47
Using Designer ................ . i 47
Power Meter Module Settings .................... .. ... .. .. ... 48
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Introduction

Basic configuration of the meter is provided by the Power Meter module. The
Power Meter module is the main connection between the power system
measurements and all other ION modules in the device. This module reports the
values for all voltage, current and power measurements. The Power Meter
module’s setup registers describe details of the power system being monitored.
Many of the Power Meter module’s setup registers are configured when the meter
is initially put into service, although the device cannot operate properly until the
Volts Mode and PT and CT ratios are set. Some registers may need to be changed

to refine the device’s operation.

See the ION Reference for more details on the Power Meter module.

Configuring Basic Setup

Use the front panel or ION software to perform basic meter setup.

Using the Front Panel

The Basic Setup menu item provides access to the following power system settings.

Menu Sefting Description Range (Values) Default
4W-WYE
, . . DELTA
Volts Mode -S;ET_TI;OW? system'’s configuration — WYE, IW-WYE AW-WYE
, elc SINGLE
DEMO
PT Primary The Poien’n'ol Transformer’s primary winding 1 10 999 999 999 120,00
voltage rating
PT Secondary The Potenhgl Transformer’s secondary winding 110 999 999 999 120,00
voltage rating

CT Primary The Currem Transformer’s primary winding 1 10 999 999 999 5

o current rating

2 ] -

3 CT Secondary The Currer.ﬁ Transformer’s secondary winding 1 10 999 999 999 5

o current rating

g 14 Primary Primary rating for the 14 current transformer 1,0 - 999 999,00 5

- 14 Secondary Secondary rating for the 14 current transformer | 1,0 - 999 999,00 5
U1 Polarity The polarity of the Potential Transformer on U1 | Normal or Inverted Normal
U2 Polarity The polarity of the Potential Transformer on U2 | Normal or Inverted Normal
U3 Polarity The polarity of the Potential Transformer on U3 | Normal or Inverted Normal
11 Polarity The polarity of the Current Transformer on 11 Normal or Inverted Normal
12 Polarity The polarity of the Current Transformer on [2 | Normal or Inverted Normal
13 Polarity The polarity of the Current Transformer on I3 | Normal or Inverted Normal
14 Polarity The polarity of the Current Transformer on 14 | Normal or Inverted Normal
Phase Rotation Power system'’s phase rotation 123,132 123
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Using ION Setup

The Basic Setup Assistant helps you configure the Power Meter module:

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to Basic Setup and click on PT/CT Ratios.

Setup Assistant E

PT/CT Ratios | Nameplate Infol Holloverl

Willows pou to program PT and CT ratios.

P1 Yolts Mode 4w wYE
P1 PT Prim 120
Pt1PT Sec 120

P1 CT Prim 5
P1CT Sec 5
PH114CT Piim &
PH114CT Sec &

Scale Rev Param OM

E dit |

< Back | Mest » | Exit

Help

3. Configure each register as required by selecting the parameter and clicking Edit.

Using Designer

Open your meter in Designer and navigate to the Core Modules. Right-click on the
Power Meter module to edit.

© 2007 Schneider Electric. All rights reserved.
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Power Meter Module Settings

The Power Meter module contains the following setup registers:

:Z;Fs)ter Function Default
Volts Mode ! | The power system’s configuration — WYE, DELTA, Single, etc AW-WYE
PT Prim ! The Potential Transformer’s primary winding rating for U1, U2, U3, and U4 120

PT Sec ! The Potential Transformer’s secondary winding rating for U1, U2, U3, and U4 120

CT Prim ! The Current Transformer’s primary winding rating for 11, 12 and I3 5

CT Sec ! The Current Transformer’s secondary winding rating for 11, 12 and 13 5

14 CT Prim ! The Current Transformer’s primary winding rating for 14 5

14 CT Sec ! The Current Transformer’s secondary winding rating for 14 5

U1 Polarity The polarity of the Potential Transformer on U1 Normal
U2 Polarity The polarity of the Potential Transformer on U2 Normal
U3 Polarity The polarity of the Potential Transformer on U3 Normal
11 Polarity The polarity of the Current Transformer on |1 Normal
12 Polarity The polarity of the Current Transformer on 12 Normal
13 Polarity The polarity of the Current Transformer on 13 Normal
14 Polarity The polarity of the Current Transformer on 14 Normal
Phase Order | The expected rotation of the voltage phases (ABC or ACB) ABC
Phase Lbls The phase label format assigned to the outputs (ABC, RST, XYZ, RYB, RWB or 123) 123

! The registers are typically set when the device is commissioned. Changing the values of these registers

while the device is in service is not recommended.

Once basic setup is performed (i.e. the PT/CT and Volts mode settings), typically

there is no need to make further changes to the Power Meter module’s setup

registers.
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Security

All ION8800 meters offer Standard and Advanced meter security. Standard
security is enabled by default from the factory; procedures for changing these
security settings using the front panel and ION software are detailed in this
chapter. Advanced security, which allows up to 16 users, each with unique access
privileges, is discussed as well. This chapter also details some security features
available for revenue meters.

In This Chapter
Meter Security Features . ... ...c ittt i i i 50
Standard Meter Security . .........iiiiiiii i i i e 50
Configuring Standard Security using the Front Panel ...................... 51
Time Synchronization Security Considerations ........................... 54
Configuring Standard Security using ION Setup .......................... 55
Configuring Standard Security in Designer . .............................. 57
Scenarios for Standard Security - Front Panel Security Enabled ............. 57

& Configuring Advanced Meter Security ...........cciviiiieennnnn.. 60
Configuring Advanced Security using ION Setup ......................... 61
Configuring Advanced Security using ION Enterprise ..................... 62
Device Security Access for ION Services ............ ..., 63
Scenarios for Advanced Security - Standard Security Enabled .............. 65

+ Additional Revenue Metering Security ...........cciiiiiiii.n.. 67
Hardware Lock Security Option ............. ... . oo, 67
MeterSeals ..........ooiiiiiiiii 68
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Meter Security Features

Your meter includes the following security features:

Standard meter security

Anytime you make configuration changes to your meter you must enter a
password. See “Standard Meter Security” on page 50.

Advanced meter security

This level of security allows configuration of up to 16 users, each with unique
access rights to the meter. See “Configuring Advanced Meter Security” on page 60.

Revenue meter security

Your revenue meter can be protected by hardware locking and anti-tamper
sealing. See “Additional Revenue Metering Security” on page 67.

Software security

ION software security brings access-level security to the meter. With ION
software, you can configure multiple users with different passwords and specify
access rights. ION software security only applies to users who are accessing the
meter via ION software.

For more information on ION software security, refer to the ION System Security
technical note.

Standard Meter Security

Standard meter security is enabled by default on all ION8800 meters; all
configuration functions in the front panel are password-protected. The default
password is factory-set to 0 (zero).

If you make configuration changes to the meter via the front panel, the meter
prompts you for its password before accepting any configuration changes.
Similarly, if you make any configuration changes via ION software you are
prompted by the meter for its password (in addition to the password used to
access ION software). Once you enter the correct meter password and confirm the
new configuration, the change is set on the meter.

Page 50
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Configuring Standard Security using the Front Panel

Navigate to the Security Setup menu. The following settings are available:

Menu Setting Description Range (Values) Default
Modify Passwd Modifies standard password 010 999 999 999 0
> Disable Security Disables meter security Disabled or Enabled Enabled
§ Web Config Allows configuration through web server Disabled or Enabled Enabled
8 interface
n
Ack Alarms Sends a pulse to acknowledge alarms when i i
pushed

Note that the front panel will prompt you for the meter password before you make
your first configuration change. You will not need to re-enter the password for
each subsequent change. However, if you perform no additional configuration
changes for five minutes, you will need to re-enter the Setup menu and provide the
valid meter password to resume making changes. This is because the meter returns
from setup mode to data display mode after five minutes of inactivity.

The meter password allows access to the meter's configuration through
ION software and the front panel. The default password is 0 (zero).

Entering the Password

The first time you try to make a change to any setting, you will be presented with
the password screen (shown below). After you have entered the correct password,
you will not have to re-enter it for any other changes unless you exit the
configuration session.

ENTER PASSWD

00000000

MIN: MAX:
00000000 99999999

HOLD ARROW KEY TO ADVANCE CURSOR

To enter the password:

1. To change the value of the highlighted digit, use the arrow buttons. The Up
arrow increments the number and the Down arrow decrements it.

2. To change the position of the cursor, hold down an arrow button for about one
second. The Up arrow moves the cursor left one position and the Down arrow
moves the cursor right one position.

3. Once you have the value you want, press the Alt/Enter button.

© 2007 Schneider Electric. All rights reserved.
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Changing the Password

By default, the password is set to 0 (zero) in the factory. The password can be
changed to any number up to eight digits. It is highly recommended that you
change the password from the default value. To change the password:

1. Hold down the Alt/Enter button to access the Setup menu.
2. Scroll through the menu items using the arrow buttons, highlight SECURITY.
3. Press the Alt/Enter button to select SECURITY.

8800 SETUP
DISPLAY SETUP
SECURITY SECURITY
RETURN @‘ RETURN
. B2 MODIFY PASSWD
DISABLE SECURITY

4. You are prompted to enter the current meter password (see “Entering the
Password”, above). Once you enter the password, you are presented with the
“MODIFY PASSWD” screen, as seen below:

MODIFY PASSWD
00000001

MIN: MAX:
00000000 99999999

HOLD ARROW KEY TO ADVANCE CURSOR

5. To change the value of the highlighted digit, use the arrow buttons. The Up
arrow increments the number and the Down arrow decrements it.

6. To change the position of the cursor, hold down an arrow button for about one
second. The Up arrow moves the cursor left one position and the Down arrow
moves the cursor right one position.

7. Once you have the value you want, press the Alt/Enter button. You are
prompted for your current password before the new password is saved.

Enabling & Disabling the Password Security Check

Disabling the password allows changes to all the meter's settings through the front
panel without a security check. This procedure may only be necessary if the
communications interface you are using does not support the meter’s security
protocols.

/\ CautioN

Non-secure access to critical settings in the meter, such as PT and CT ratios, is not advisable. It is highly
recommended that any ION8800 devices in the field have the password security check enabled.
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Disabling the Password Security Check

Follow these steps to disable the password security check:

1. Press the Alt/Enter button to enter the Setup menu. Scroll down the menu with
the arrow button. Press Alt/Enter again when SECURITY is highlighted.

2. Enter the valid meter password at the password prompt. You are then presented
with the Security menu.

3. Scroll down and highlight the DISABLE SECURITY menu item and press the
Alt/Enter button.

8800 SETUP

DISPLAY SETUP

SECURITY SECURITY
RETURN [ €F

: [ RETURN
MODIFY PASSWD

DISABLE SECURITY

4. Select PROCEED then select YES at the following prompt.

DISABLE SECURITY
pes nd ld

RETURN

ENTER

A message appears on screen notifying you of how to re-enable password
security (refer to “Enabling the Password Security Check”, below). Your meter’s
password is now disabled; changes to settings in the meter do not require a valid
password.

5. Press the Alt/Enter button to return to the Setup menu.

Enabling the Password Security Check

When you re-enable the password security, you are required to enter a new
password. To re-enable password security:

1. Press and hold down the Alt/Enter button to enter the Setup menu. Scroll
down the menu and select SECURITY.

2. From the Security menu, select MODIFY PASSWD and press the Alt/Enter
button. The Modify Password Screen appears.

3. The message FAC DEFAULT appears in the middle of the Modify Password
screen. If you want to use the factory default password, press the Alt/Enter
button. If you want to set the password to a different number, use the
instructions in “Changing the Password” on page 52.

4. Once you have entered your new password, press the Alt/Enter button.

5. Select YES to confirm the change and return to the Setup menu.
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The password security check is re-enabled and all changes to the device's
configuration require the new meter password.

Enabling and Disabling Web Config Access

By default, remote configuration of the device via web browser is enabled. Follow

these steps to enable or disable your meter’s web configuration access.

1. Press the Alt/Enter button to enter the Setup menu. Scroll through the menu
with the arrow buttons. Press Alt/Enter again when SECURITY is highlighted.

2. Enter the valid meter password at the password prompt. You are then presented
with the Security menu.

3. Scroll down and highlight the WEB CONFIG menu item and press the Alt/Enter
button.

4. Select “Enabled” or “Disabled” as required.
5. Confirm the change and select RETURN to go back to the Setup Menu.

8800 SETUP

DISPLAY SETUP
SECURITY

RETURN [ &= > SECURITY
EEE— RETURN

WEB CONFIG

Enabled

RETURN

Time Synchronization Security Considerations

Depending on ION software settings, a workstation that connects to an ION8800
device can send a time synchronization signal and synchronize the meter's internal
clock with the workstation's clock. This could cause overlaps in the Demand
intervals, and timestamps in the data logs may not be accurate.

Ensure that the TimeSync Source setup register in the Clock module is set to a secure
communications port. By default, the Time Sync Source setup register in the Clock
module is set to COM1 - the optical port. Time synchronization broadcasts will
only be accepted through the optical port in this configuration. Use the Clock
Setup Assistant in ION Setup to change this setting.
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Setup Assistant E
= Template Timezone | DST Settingsl
= Baszic Setup

E= Security Specifies the DMLY communication port that time updates would be

accepted on. MOTE: Time synchronization signals on other ports

(Z] Communications bl ]

== Clock
== Demand
(27 Pulsing outputs
(Z] Logging Timezone -8 Hours
(Z] Revenue CL1 Time Sync T UTC
P.DWEI Hualty CL1 Clock Source Intemnal
= Displays CL1 DST Offset 1 hour
Werification CL1 LocalTime ‘wied Apr 18, 2007 10:52:49 A
-
ETHERMET 4
COM3 N
COr4 |
ETHERMET
—ETHERMET - 10N _I
ETHERMET - DNP —
IRIG-B %
< Back | Mext » | Exit | Help |

Ensure that time synchronization is disabled on all other ports.

Configuring Standard Security using ION Setup

1. Launch ION Setup with Supervisor authority.
2. Connect to your meter, using Basic Mode.

3. In the Setup Assistant, navigate to Security.

4. Select Security Mode and click Edit.

Setup Assistant E

= Template Security |
= Baszic Setup
== Security Indicates what type of security i operating.

(2] Communications

*Edit | send |

< Back | Mest » | Exit | Help

5. In the Open File dialog, select the Standard.scf file and click Open to edit.
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Open ﬂ!!i
Look jn: IE} Security j - £k B

Advanced
Standard

j : Open I

Filez of type: ISecurity Configuration File [*.SCF] j Cancel

Help /L

File name: Eitaru:lan:l.:s:.::f

6. On the configuration screen, select the check boxes of the security options you
want enabled. Some options may be greyed out (not changeable) due to existing
security settings.

To change the password, enter a new meter password then confirm by entering

it again.

— Step 2 Configuration Option:

Select the zecurity options you wish to employ.

Mew Password: I" Confirm Password: I"

¥ Active Web Server

¥ &llove ‘w'eb Server programming I~ Secure Web Page Yiewing

¥ &llow Modbus programming [+ &llovs Front Panel programming

¥ &llow Broadcasting Time Synchionization

< Back Ii Finizh I Cancel Help

7. Click Finish when you are done.

8.  When prompted, you can save your security settings in a file.

Click Yes to enter a name for your security file and click Save. If you want to
overwrite your default standard security file, select Standard.scf and click Save.

Click No if you do not want to save the changes.
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Configuring Standard Security in Designer

1. Launch Designer with Supervisor access.

2. Select Options > Show Toolbox if the toolbox is not displayed.
3. Select Options > Change Standard Meter Security.
4

Enter the meter password when prompted. You must enter the existing meter
password before you can change security settings (the default is 0 [zero]). Click
OK.

5. Type a new numeric password and confirm by re-typing the Confirm Password
field. If you are sure you want to disable Standard security, select the Disable
Standard Meter Security check box. Click OK to save your changes.

Change Standard Meter Security |

% Enter a new paszword for MewF acility, PPC

Izer name: Drefault

Pazsword: Il

Canfirrn Pazsward: I

[T Dizable Standard Meter Password

ok LCancel

/\ CauTioN

Do not disable security unless it is absolutely necessary. Disabling Standard security leaves your meter

configuration open to tampering (intentional or unintentional) through communications and the front
panel.

Scenarios for Standard Security - Front Panel Security Enabled

1. Access through the front panel display

With the Standard Security enabled and Front Panel Programming set to
“Allowed”, you can read metering data from the display. To configure meter
parameters, you must enter the numeric password.

If Standard Security is disabled and Front Panel Programming is set to “Allowed”,
you can read metering data from the display and configure or make changes
without entering a password.

If Front Panel Programming is set to “Disallowed”, you can read metering data
from the display, but you cannot access any of the configuration screens from the
front panel display.
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2,

5.

Access through software talking ION protocol with ION
Setup and/or ION Enterprise on ANY comm port (serial,
modem, optical, and Ethernet)

If you are communicating through ION protocol (and have Standard Security
enabled) with the appropriate software access, you can read and configure meter
parameters. When you attempt to write or configure any parameter, you must
enter the numeric password.

Access through Modbus on ANY comm port (serial, modem,
optical and Ethernet)
On ION meters, Modbus implementation consists of two parts:
i.  Modbus Data
¢ Includes the Modbus Slave ION modules.

¢ These modules are configurable as to what data is available and where in
the range of Modbus registers this data is placed.

ii. Modbus Setup

¢ Also referred to as the Modbus Map (see the Common Modbus Registers
technical note).

¢ Uses fixed functionality and register mapping.

Accessing the Modbus data section with Standard Security

When accessing the Modbus Data section with Standard Security enabled, you:
¢ Can read from the data section at all times.

¢ Can write to the data section if the Modbus Slave Module is set to “Unsigned
16Bit Input Mode” and the Standard Security is disabled or the password is set
to zero.

¢ Cannot write to the data section if the Standard Security is enabled and the
password is set to a non-zero value.

Accessing the Modbus setup section with Standard Security

When accessing the Modbus Setup Section with Standard Security enabled, you:
¢ Can read from the setup section at all times.

¢ Can write to the setup section if the Standard Security is disabled or the
password is set to zero.

¢ Cannot write to the setup section if the Standard Security is enabled and set to a
non-zero value.

Time syncs are considered to be a Modbus Setup parameter and follow the same
rules above for writing a time sync to the meter. Also, the ION Clock Module must
have its Time Sync Source setup register set to the appropriate communication port.
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The Modbus Slave module and the Clock module setup registers are only
accessible via ION protocol. Their settings are therefore protected by the security
settings on the ION device.

Access through DNP 3.0 on ANY serial, modem or optical
communication port

If you are communicating through DNP 3.0 protocol over any serial, modem or
optical port (and Standard Security is enabled), you can read data from the default
DNP 3.0 Map without having to enter the numeric password.

If the DNP 3.0 Map is changed to expose control and setup parameters, then you
could write to the custom DNP 3.0 Map. The DNP 3.0 Map can only be changed by
using ION Setup or ION Enterprise and then the customer must know the numeric
password. Time syncs can be sent to the meter in this mode.

Access through a standard browser on an Ethernet port via
HTTP protocol

If the Standard Security is enabled and Webserver Configuration Access is
enabled, you are prompted for the password by your web browser before being
allowed to make any configuration changes to the meter. If the Standard Security
is not enabled, you are able to make configuration changes without having to
supply the password.

If Webserver Configuration Access is disabled, you can only read data. The default
Webserver pages contain real-time data only.

8. Access through FACTORY protocol on a Telnet connection via

Ethernet or HyperTerminal on a serial, modem, or optical
port

If the Standard Security is enabled, you must enter the numeric password to log
into the Factory protocol. If Standard Security is disabled, logging in via Factory
protocol does not require a password.

Once logged in, you can change the following:
1. IP Address

2. Subnet Mask

3. Gateway

4. Reset Battery Counters

5. Enable/Disable Standard Security

If you want to change additional configuration settings beyond the above list,
contact Technical Support.
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Configuring Advanced Meter Security

Advanced meter security is available on ION8800 meters. This level of security
allows configuration of up to 16 users, each with unique access rights to the meter.
Access rights consist of the following levels:

¢ Read: view any parameter except the security configuration.

¢ Peak Demand Reset: perform a reset of peak demand values (for example,
sliding window demand for kW, kvar, kVA etc.).

¢ Timesync: set the time on the meter.

¢ Full Meter Configuration: configure any programmable register on the meter
except for registers related to the security setup, registers that result in a demand
reset, or actions that place the meter in TEST mode.

¢ TEST Mode: put the meter into TEST mode.

¢ Advanced Security Configuration: configure Advanced security for the meter;
full meter configuration must also be set to YES.

When configuring users, in most cases you must set Read access to YES. However,
you can set up a user without read access; for example, you can create a user who
can only timesync the meter. In some cases (such as Advanced security
configuration access) you must set multiple access options to YES. When you are
configuring Advanced security, the software rejects unacceptable or unsafe user
configurations.

2\ NOTE

Use only ION Enterprise or ION Setup v1.1 (or later) to configure Advanced security.
You cannot configure Advanced Security using the Front Panel.

Entering an advanced security user name and password

When you attempt to view data or make a change to a meter that has advanced
security enabled, you are prompted for a user name and password.

Advanced Meter Security

% Enter a valid user and pazsword for Electric. Compary

Uszer name: I

Pazsword: I

Qg Lancel |

1. Enter the valid Advanced security user name.

2\ NOTE

User names are fixed as USER1 through to USER16.

2. Enter the appropriate password and click OK.
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Configuring Advanced Security using ION Setup
See the ION Setup User Guide for more details.

1. Launch ION Setup with Supervisor access.
2. Connect to the meter you want to configure with Advanced security.

3. Once connected, double-click the Setup Assistant and select the Security
heading.

4. Select Security Mode and click Edit.
5. In the Open File dialog, select the Advanced.scf file and click Open.

The Advanced Security wizard leads you through the configuration procedure.

6. On the first configuration screen, select the check boxes of the security options
you want enabled. Some options may be greyed out (not changeable) due to
existing security settings. Click Next.

Advanced Dptions [ %]

— Step 2 Configuration Option:

Select the zecurity options you wish to employ.

¥ Front Panel password
Mew Password: Ii Confirm Password: I"

¥ Active Web Server

¥ &llove ‘w'eb Server programming V' Secure Web Page Yiewing

v &llows Modbus programming [+ &llovs Front Panel programming

v &llow Broadcasting Time Synchionization

< Back Ii Mest » I Cancel | Help |

7. Onthe second configuration screen, select the check boxes of the users you want
to configure (1 through 16). Click Password to set a password for each user. Click
OK then click Finish.
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Define individual users/passwords

— Step 4: Advanced Security

[refine each uzers rights by selecting the appropriate check boxes and for
each user, enter in a password.

;I Password |

=-[JUSERDS
B O UsERDS Mew pazsword: I
-] USERD?
H USERDR Confirm new password: I

& CJ USERD3

o QUSERD Ak ] ool | b |
<[ |

< Back | Finizh | Cancel | Help |

8. When prompted, you can save your security settings in a file.

¢ Click Yes to enter a name for your security file then click Save. If you want
to overwrite your default advanced security file, select Advanced.scf and
click Save.

¢ Click No if you do not want to save the changes.

Configuring Advanced Security using ION Enterprise

If you are using Designer software follow the instructions below.

1. Launch Designer software with Supervisor access. Select File > Open and
select the meter you want to configure with Advanced security.

2. If the toolbox is not displayed, select Options > Show Toolbox.

3. If you do not want to allow front panel programming using the Standard
security meter password then double-click on the Display Options module and
change the Front Panel Programming register to disallow.

2\ NOTE

If you allow front panel programming when you set up Advanced security, the meter password (used in

Standard security) is still active through the front panel. You may need to allow front panel programming
if someone installs the meter in the field and needs to make setup modifications. Once the meter is
installed, you can disallow front panel programming so that Advanced security user names and
passwords must be used to view or change meter information.

4. Open the Meter Security Setup grouping window.

For each user you want to configure, drag out a Security module from the
Toolbox, and modify the appropriate access level setup registers.

5. Click Change Password at the bottom left of the module setup screen to
configure a password. The default password is 0 (zero).

Click OK when you have configured the users.
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6. Right-click on the Security Options module.

7. Double-click on any setup register and use the drop-down menu to change the
register setting or label.

You must set the Enable Advanced Security register to Enabled. Refer to the
Security Options module description in the ION Reference for more details.

8. Select File > Send & Save. Advanced security is now enabled on the meter.

Device Security Access for ION Services

Many ION Services need constant access to your network’s ION devices. These
services include the ION Log Inserter, the Virtual Processor and Site Server that
perform the following type of functions:

Service Function

Reads the ION meter Data Recorder or waveform modules and can

ION Log Insert . )
ON Log Inserter automatically rearm recorders that are configured as Stop-When-Full

Can be configured to read from a meter or perform control action

Virtual Processor using Distributed Control.

Site Server Broadcasts time signals to the meter.

When Advanced meter security is enabled, these services may not have sufficient
access rights to perform their operations. You must specify a user with sufficient
access rights for these services.

2\ NOTE

You may want to configure a separate user for accessing services. If you observe trouble with ION
software accessing the meter, it is likely that these services either do not have access rights or the original
user name and password have changed.

Allowing ION Services access to advanced security enabled meters (ION Enterprise)

1. Launch the Management Console and click Devices on the Management
Console’s System Setup Pane.

2. Highlight the ION device (or select multiple devices) with Advanced security
enabled, right-click and select Security. The following window displays.

& Meter Security Settings ll

These settings are uzed by the software to gain access to a
% zecurty-enabled device.

I0N Services Access:

[~ Send Security Timesyncs to this device

Change Pazsword | QK I Cancel
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3. Select the user name you want from the drop down menu. Click Change
Password to change that user’s password. Enter the valid new password, re-
type the password to confirm it and click OK.

4. Select the check box if you want to allow this user to send time synchronization
signals to the meter.

5. Click OK to save your changes.

Allowing ION Services access to Standard security enabled meters (ION Enterprise)

1. Launch the Management Console and click Devices on the Management
Console's System Setup Pane.

2. Highlight the ION device (or select multiple devices) with Standard security
enabled, right-click and select Security.

3. Select Standard Security from the drop down menu.

4. Click Change Password to change the password. Enter the valid new password,
re-type the password to confirm it and click OK.

5. Click OK to save your changes.

Allowing ION Services access to advanced security enabled meters (ION Setup)

1. Launch ION Setup with Supervisor access.
2. Connect to the meter you want to configure with Advanced security.

3. Once connected, double-click the Setup Assistant and select the Security
heading.

4. Select Security Mode and click Edit.
5. In the Open File dialog, select the Advanced.scf file and click Open. Click Next.

6. Select the user name you want from the available list.

Define individual users/passwords

— Step 4: Advanced Security

[refine each uzers rights by selecting the appropriate check boxes and for
each user, enter in a password.

- Password |

E-[#] Test Mode Access
(=[] Full Meter Corfig Access

----- Security Config Access

(- [P USERDZ
- [JUSERD3
B

]--D USERD4 -
S RRT L
<] _>l_I

< Back I Finizh I Cancel | Help |

7. Select the check boxes of the services you want to allow this user to access. Click
Finish.
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Scenarios for Advanced Security - Standard Security Enabled

1.

Access through the front panel display

With both Advanced Security and Standard Security enabled, you can read the
metering data on the display. To configure/write to the meter, enter the numeric
password. Advanced Security does not add additional security when accessing the
meter through the front panel.

Access through software talking ION protocol with
ION Setup and/or ION Enterprise on ANY comm port (serial,
modem, optical and Ethernet)

With Advanced Security enabled and communicating through ION protocol on
any communication port, you must enter a username and password in order to
read or configure/write the meter. Advanced Security blocks access to the device
if you do not know the correct username and password. If you know the username
and password, and the username is assigned the proper access, then you can read
and configure/write (depending on the assigned user-access rights) data within
the meter.

3. Access Through Modbus on ANY comm port (serial, modem,

optical and Ethernet)
On ION meters, Modbus implementation consists of two parts:
i.  Modbus Data

¢ Includes the Modbus Slave ION modules.

¢ These modules are configurable as to what data is available and where in
the range of Modbus registers this data is placed.

ii. Modbus Setup

¢ Also referred to as the Modbus Map (see the Common Modbus Registers
document.

¢ Uses fixed functionality and register mapping.
From an Advanced Security point of view, the Modbus Data and Setup sections
operate somewhat differently.
When accessing the Modbus Data Section with Advanced Security Enabled, you:
¢ Can still read from the data section at all times.

¢ Can write to the data section if the Modbus Slave Module is set to “Unsigned
16Bit Input Mode” and the “Modbus Map Access” is set to “Yes”.

¢ Cannot write to the data section if “Modbus Map Access” is set to “No”.

When accessing the Modbus Setup Section with Advanced Security Enabled, you:

¢ Can read from and write to the data section if “Modbus Map Access” is set to
ll'Yes//.
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¢ Cannot read from or write to the data section if “Modbus Map Access” is set to
//NOII .

You can write a time sync only if “Modbus Map Access” and “Allow Broadcast Time
syncs” are both set to “Yes” and the ION Clock Module's “Time Sync Source” setup
register is set to the appropriate communication port.

Since the Modbus Map Access, the Modbus Slave module, and the Clock module
setup registers are only accessible via ION protocol, their settings are protected by
the security settings on the ION device.

4. Access through DNP 3.0 on ANY serial, modem or optical

port

With Advanced Security enabled and communicating through DNP 3.0 protocol
over any serial, modem or optical port, you can read from the default DNP 3.0
Map. If the DNP 3.0 Map is changed to expose control and setup parameters, then
you can write to the custom DNP 3.0 Map. Any changes to the DNP 3.0 Map or the
Security Options Module can only be changed by using ION Setup or

ION Enterprise and the customer must know the proper Advanced Security
username and password. Time syncs can be sent to the meter in this mode without
having to enter in a username and password.

5. Access through a standard browser on an Ethernet port via

http protocol

If Advanced Security is enabled and the Web Access Read Security setup register
in the Security Options Module is set to YES, you must enter the proper Advanced
Security username and password before gaining read access to the device through
a standard browser. If you have the proper username and password, the next level
of security is the Webserver Configuration Access setting. If the Webserver
Configuration Access disabled, you can only read metering data.

If the Web Access Read Security setup register is set to NO, then you will be able
to read web pages on the device without having to provide an Advanced Security
username and password. However, if you attempt to make configuration changes,
you will be prompted for the Advanced Security username and password.

6. Access Through FACTORY protocol on a Telnet connection via

Ethernet or HyperTerminal on a serial, modem, or optical
port

Advanced Security does not affect the Factory protocol. Therefore, if Standard
Security is enabled, you will have to enter the password to log into the Factory
protocol. If the Standard Security is disabled you can log into the Factory protocol
without supplying a password.

Once logged in, you can change the following:
1. IP Address
2. Subnet Mask
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3. Gateway
4. Reset Battery Counters
5. Enable/Disable Standard Security

If you want to change additional configuration settings beyond the items listed
above, contact Technical Support.

Additional Revenue Metering Security

Security features depend on the meter ordering options.

All ION8800 meters

Standard security includes traditional anti-tamper mechanical sealing points on
the meter case and cover.

ION8800 meters with Revenue Security Option

Standard security plus a hardware-locked security system that prevents
modification of revenue quantities after the meter is sealed.

Hardware Lock Security Option

To make configuration changes to billing parameters on a hardware-locked meter,
you must first unlock the meter. The Meter Lock setting is located in the ALT
Config menu, which is reached by pressing the ALT Config button under the anti-
tamper sealed cover. This button cannot be activated remotely with a Hardware
Lock meter.

Typical values that are protected include:

& KkWh, kvarh, kVAh delivered, received, del-rec, del+rec.

& kW, kvar, kVA Sliding Window demand min and max values.

¢ Digital Outputs controlling the energy pulsing applications.

¢ All Power system settings, including PT and CT ratios.

For a complete list of locked values specific to your meter and its firmware, contact
Technical Support.
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Meter Seals
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The meter incorporates sealing bars and chassis screws with through-holes,
through which traditional lead/wire seals can be inserted. When utilized, these
lead/wire seals effectively prevent unauthorized personnel from gaining access to
meter internals or to buttons under the cover.

These seals are installed as follows:

1. Insert the sealing wire through both the screw hole and sealing bar.
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)

ll
Cjﬁ Lead Sealing Tab

2. Twist the wire and crimp the lead sealing tab on to the wire.

Screw with
Through-hole

Sealing Bar
{
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Chapter
6 Communications

This chapter includes general instructions for connecting and configuring all the
communication ports on your meter.

For specific meter installation steps and specifications, consult your Installation

Guide.

In This Chapter
Communications Overview . ..........cociiiiiiiiiiiiiiinenenn. 72
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Communications Overview

COM1:
Optical port serial connection

COMT provides an IEC 1107 Optical port
(located on the front of the meter) that is

used for serial communications.

supports these protocols: ION, Factory,

Modbus RTU, DLMS and DNP 3.00

Ethernet port

This connection provides optional
10Base-T or 10Base-FL Ethernet
communications.

Communications Module

The meter’s internal modem
communicates to the server

network.

© 4

E—

COM4:
Internal modem

COM4 provides an optional internal modem,
and supports these protocols: ION, Factory,

Modbus RTU, DLMS, GPS, and DNP 3.00

computer over the telephone

The following illustration shows all the possible communications connections to
the meter.

COoM2:
Selectable RS-485 serial connection

COM 2 provides an RS-485 serial port
on either the Essailec connector or the
Communications Module. It supports
ION, GPS, EtherGate, ModemGate,
Modbus RTU, DLMS, DNP 3.00,
Modbus Master, and Factory protocols.

COM3:
Selectable RS-232 or RS-485 serial
connection

COM3 is actually two ports: RS-232 for
direct connections and RS-485 for
serial connections. Both ports support
these  protocols:  ION,  Factory,
EtherGate, GPS, ModemGate, Modbus
RTU, Modbus Master, DLMS, and DNP
3.00.

Note: you cannot use the RS-232 and
RS-485 ports on COM3 simultaneously.
Note: Modbus Master is only available
on ION8800A and B meters.

ION8800 meters have numerous communication possibilities depending on your
ordering options. See the table below for details.

COM Port | Interface Type Meter Only ?::;r::raﬁons Module
1 Optical Standard Standard
,EeREee od o
3 Selectable RS-232 or RS-485 N/A Optional
4 Internal modem N/A Optional
Ethernet Selectable Ethernet (10Base-T or —FL) N/A Optional
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Communications Connections

The following section provides reference for connecting to the meter’s various
communication ports. For the most current communication specifications, see
your meter’s Installation Guide.

Communications connections are made to the Essailec connector and the

Communication Module, both found on the rear of the meter. Optical connections
are made to the port on the front of the meter. See below for details.

2\ NoTe

Meters ordered with I/O options B and C do not have RS-485 connections on the Essailec connector.

Essailec Connectors

A Option D and E Options

D @ D \ ) D D D

Shield —p/:0¢ eo|ls® o0o|se eolse @0 Shield —p/s® e@o|se eo|lse @0
RS-485+ —pjice e@1|c@ O1|ce e1|lce @ .... RS-485 + —pjs@® e@1(ce e@1|ce @) ....
RS-485- —p{7e e:2/70 02|70 e:270 e oo RS-485- —pl7e 2|70 e@2(70 @° ” R
4 3 2 1 4 3 2 1
80 Osls e oi|se@ eilse ®: .... 80 Os3fse es(se ®: ....

o0 @400 [ AN ] ® 490 ® 4 9@ [ N [ RN o4

® @ D \) Y D @
Communications Module
RITT ST-type RJ45 Captured wire DB9 connector
connector connectors connector connectors (male)

IR, |

Front of Meter

Standard RS-232

Use an IEC 1107
magnetic optical
probe

62.5/125 um
multimode fiber

FCC part 68
compliant
telephone cord

cable with DB9
female connector

| |

W
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Optical Port Connections (COM1)

The front optical port is designed to accept IEC 1107 magnetic couplers. It can be
used to communicate real-time measurements to a portable PC or for basic meter
configuration.

ION8800 Meter

Magnetic  coupler
attached to front
optical port

Laptop Computer

To enable communications from the optical port, configure the Comm 1
Communications module. The Protocol, the Baud Rate and Unit ID setup registers
must properly match your system. When creating an ION site, ensure that RtsCts
is disabled (set to No) in the COM1 serial site.

Refer to the Management Console section in the online ION Enterprise Help for
more details about adding serial sites.

2\ NOTE

To allow meter configuration via the optical port, you must ensure IR Configuration is set to Enabled. See
“ALT Config Menu” on page 37 for more information.

RS-485 Connections (COM2 and COM3)

RS-485 connections are made to the Essailec connector and the optional
Communications Module, both found on the rear of the meter.

2\ NOTE

COM2 is a selectable channel, which allows RS-485 communications via the Essailec connector OR the

Communications Module. You cannot use both ports at the same time.

Up to 32 devices can be connected on a single RS-485 bus. Use a good quality,
shielded twisted pair cable for each RS-485 bus. The overall length of the RS-485
cable connecting all devices cannot exceed 1219 m (4000 ft.). The RS-485 bus can be
configured in straight-line or loop topologies:
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Straight-Line Topology

RS-232 to
RS-485
Converter

Termination

@ Resistor

RS-232 to
RS-485
Converter

Termination
Block

General Bus Wiring Considerations

Devices connected on the bus, including the meter, converter(s) and other
instrumentation, must be wired as follows:

¢ Connect the shield of each segment of the cable to ground at one end only.
¢ Isolate cables as much as possible from sources of electrical noise.

¢ Use an intermediate terminal strip to connect each device to the bus. This allows
for easy removal of a device for servicing if necessary.

& Install a ¥4 Watt termination resistor (RT) between the (+) and (-) terminals of the
device at each end point of a straight-line bus. The resistor should match the
nominal impedance of the RS-485 cable (typically 120 ohms — consult the
manufacturer’s documentation for the cable’s impedance value).

RS-485 Connection Methods to Avoid

Any device connection that causes a branch in the main RS-485 bus should be
avoided. This includes star and tee (T) methods. These wiring methods cause signal
reflections that may result in interference. At any connection point on the RS-485
bus, no more than two cables should be connected. This includes connection points
on instruments, converters, and terminal strips. Following this guideline ensures
that both star and tee connections are avoided.
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Avoid 3-way “Star”
connection point

Avoid 3-way “T"
connection point

RS-232 Connections (COM3)

An RS-232 connection is made to the male DB9 connector (COM3) on the optional
Communications Module, at the back of the meter. The meter acts as a DTE device
in all RS-232 connections. Use a null modem cable for connecting a meter to a
workstation or use a standard straight-through RS-232 cable for connecting to an
external modem. In either case, one end of the cable must be equipped with DB9
female connector for mating with the meter. The maximum cable length is 15.2 m
(50 feet).

2\ NOTE

For RS-232 communications, COM3 hardware mode must be set to ‘RS-232’.

Computer Connections

DB9 female
52 connector to
™ (50 feet) COM3

Page 76 © 2007 Schneider Electric. All rights reserved.



ION8800 User Guide

Chapter 6 - Communications

Meter Connections

RS-232 to RS-485
Converter

DB9 female
connector to

COM3

DB9 female
connector to

COM3

RS-235 /
-

Telephone network connection /‘7\’/ E{]'

. 5.
between workstation modem a 2m (50 feet)
and remote modem x

Ethernet Connections

There are two Ethernet port ordering options available: a 10 Base-T port with an
RJ45 modular connector or a 10 Base-FL port with two ST-type connectors. Both
types of connectors plug into the Communications Module on the back of the
meter. The meter supports a maximum of four simultaneous Ethernet connections.
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The optional Ethernet port:
# is capable of data rates up to 10 Mbps
¢ supports TCP/IP, ION, Telnet, DNP 3.0 and Modbus/TCP protocols

2\ NOTE

Ethernet connection should be made to either the Fiber port or RI45 port, not both, or communications

conflicts may result.

The EtherGate feature provides communications both to an Ethernet connected
device and through that device to a connected serial network (See “The EtherGate
Protocol” on page 83). Only one EtherGate connection is allowed per meter port at
any given time.

Internal Modem Connections (COM 4)

7'13: [

=g

The meter’s optional internal modem is manufactured for use in most countries —
refer to the Notices at the start of this document for more details.

Modem connections are made to the Communication Module on the back of the
meter, via an RJ11 connector.

To enable communications through the meter’s internal modem, you must
configure the Comm 4 Communications module. The Baud Rate, Unit ID, and
Protocol setup registers must properly match your system, and the initialization
string for the internal modem must be set up using the ModemInit register. See
“Modem Communications Setup” on page 84 for more information.
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Configuring Meter Communications

Communication settings are typically configured when the meter is initially put
into service. A single Communications module controls each communications port
on the meter. The modules’ setup registers define the parameters used for each
port; these parameters vary according to the type of communications channel
selected (i.e. R5-232, RS-485, Modem, Optical, Ethernet).

The Communication modules control the following channels:

Module Name Seftings

Comm 1 Optical port on COM1

Comm 2 Selectable RS-485 port on COM2

Comm 3 Selectable RS-232 or RS-485 port on COM3
Comm 4 Internal modem on COM4

Ethernet Selectable 10Base-T or 10Base-FL Ethernet port

Use the meter’s front panel or ION Setup to initially configure the meter’s
communications. Once communication is established, Vista or Designer can also
be used to make changes.

2\ NOTE

Altering some settings of a communications channel that is in use can cause a loss of communications
with the meter.

Refer to the Communications module description in the ION Reference for
complete details about all the setup registers in the Communications module.

Communications Protocols

By default, all communication ports are configured to use the ION protocol. Using
other protocols requires configuration of the Protfocol setup register for the
Communications module that controls the port you want to use. Not all protocols
are available on all ports or on all meter types.

Protocols Available - ION8800
ION

Modbus RTU
Modbus Master
DNP 3.0

DLMS

GPS

EtherGate

® 6 6 6 6 o o
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& ModemGate

¢ Factory (reserved for use by Technical Support)

¢ IRIG-B

Serial Communications Setup

Serial communications are available on COM1, COM2, COM3, and COM4. To
enable communications through the meter’s serial ports, configure the applicable
Communications module. The Protocol, Tran Delay, Baud Rate and Unit ID setup
registers must properly match your system and can be set through the meter’s

front panel or ION software.

Using the Front Panel

The current configuration of the meter’s communication ports are found in the
various COM Setup menu items. Ethernet settings are located under Network

Setup.
Menu Setting Description Range (Values) Default
Protocol Specifies which protocol is active ION, Modbus RTU, DNP, DLMS, Factory | ION
Specifies COM port baud rate during serial
Baud Rate communications 1200 to 19 200 9 600
E Transmit Dela Specifies the meter’s transmit delay setting (in 0to 1.0 0.010
8 4 seconds) ' /
. Identifies the meter during serial From serial
Unit ID communications 1109999 number?
Serial Port Parity and stop bits for the port 8N1,8N2,8E1,8E2,801,802 8N1
ION, Modbus RTU, Modbus Mcsier3,
o . . . DNP, DLMS, EtherGate, ModemGate
Protocol Specif hich protocol t 4 ’ ! * | ION
rofoce pecities which profocol1s active GPS: Truetime/Datum, GPS: Arbiter,
GPS: Arbiter/Vorne, Factory
Specifies COM port baud rate during serial
1
g Baud Rate communications 300 to 57 600 9 600
8 Transmit Delay Specifies the meter’s transmit delay setting (in 010 1,0 0,010
seconds)
. Identifies the meter during serial From serial
Unit ID communications 1109999 number?
Serial Port Parity and stop bits for the port 8N1,8N2,8E1,8E2,801,802 8N1
Port Location Specifies physical connection point for COM2 | Essailec or Comm Module Essailec
Protocol Specifies which protocol is active Same as COM2 ION
Specifies COM port baud rate during serial
1
Baud Rate communicafions 300 to 115200 9 600
. Specifies the meter’s transmit delay setting (in
- Transmit Delay seconds) 0to 1,0 0,010
= Identifies the meter durin ial From serial
. g seria
8 Unit ID communications 1109999 number?
Serial Port Parity and stop bits for the port 8N1,8N2,8E1,8E2,801,802 8N1
RS-232 or RS-485 Specifies RS-232 or RS-485 RS-232, RS-485 RS-232
Specifies if hardware flow control is used RTS with delay
RTS/CTS Handshake during RS-232 communication RTS/CTS RTS + delay
Page 80 © 2007 Schneider Electric. All rights reserved.



ION8800 User Guide

Chapter 6 - Communications

Menu Sefting Description Range (Values) Default
ION, Modbus RTU, DNP. DLMS,
Protocol Specifies which protocol is active GPS: Truetime/Datum, GPS: Arbiter, ION
GPS: Arbiter/Vorne, Factory
Specifies COM port baud rate during serial
< 1
g Baud Rate communications 30010 115 200 9 600
(w) Transmit Delay Specifies the meter’s transmit delay setting (in 010 1,0 0,010
seconds)
Unit ID Idenfiﬁes.fhe. meter during serial 1109 999 From se;icl
communications number

1 300 baud rate is only intended for paging applications.

2 The factory set Unit ID is based on the serial number of the meter, using the last four numbers before
the dash. For example, if the serial number is PA-0009B263-01, the Unit ID is set in the factory to 9263.
After a factory reset, the unit ID number will default to 100.

3 Modbus Master is only available on ION8800A and ION8800B meters.

Using ION Setup

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Communications folder.

3. Click on the Serial Settings folder to configure serial communications.

Setup Assistant E
= Template Cornl |E0m2 I Com3 I Comd I
“= Basic Setup

Security
(2] Communications

Billows pou to modify the Comi [Front Dptical] communication
zettings.

Serial Settings
Metwork Settings

E= i Party Protocols
Clock. Ch1 Protocol 10N

Demand Ch1 Urit 1D 100

Ch1 Baud Rate 9600
Ch1 Rx Timeout 2

Power Cuality

E dit |

< Back | Mest » | Exit | Help |

4. Click on the various tabs to configure the four serial ports (Com1, Com2, Com 3
and Com4). To change a setting, select the parameter and click Edit.

Using Designer

Use Designer to enable serial communications on a meter port by configuring the
associated Communications module.

1. Open your meter in Designer. Navigate to the Communications Setup
framework.

2. Right-click the Communications module for the Com Port you want to configure
and configure the setup registers to match your system.

© 2007 Schneider Electric. All rights reserved. Page 81



Chapter 6 - Communications ION8800 User Guide

Ethernet Communications Setup

To enable communications through the meter’s Ethernet port, configure the
Ethernet Communications module. The IP Address, Subnet Mask, Gateway, and
SMTP Address setup registers must properly match your system and can be set
through the meter’s front panel or ION software.

Using the Front Panel

The current configuration of the meter’s communication ports are found in the
various COM Setup menu items. Ethernet settings are located under Network

Setup.
Menu Sefting Description Range (Values) Default

. 000.000.000.000 to

s_ IP Address Specifies TCP/IP Ethernet address 955 255 255 955 None

p Mask Specifies Subnet Mask 0.0.0.0 to 255.255.255.0 None

-

= - . 000.000.000.000 to

o Gateway Specifies Ethernet gateway (if used) None

% 255.255.255.255

z . . 000.000.000.000 to

SMTP Address Specifies location of SMTP Server 255 255 255 955 None

Use the front panel navigation buttons to edit the values of the network settings so
that they match your system addresses.

As you configure the network addresses, the front panel automatically hides
unnecessary leading zeroes from each three-digit grouping. The hidden leading
zeroes appear (and disappear again) as you move the position of cursor across the

network address.
89.123.40.[056

In the example above, the highlighted zero is hidden as soon as you change the
position of the cursor.

Using ION Setup

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Communications folder.

3. Click on the Network Settings folder to configure Ethernet communications.
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Setup Assistant E

TCPAP | NS | SMTP| NTP |

Thiz specifies the TCP/IP address uzed to communicate to the
reter.

ETHT Subnettask Nore
ETH1 Gateway Mone
ETH1 R« Timeout 2

E dit |

< Back | Mest » | Exit | Help |

4. Click on the various tabs to configure the meter’s TCP/IF, DNS, NTP and SMTP
settings. To change a setting, select the parameter and click Edit.

Using Designer
1. Open your meter in Designer.
2. Navigate to the Communications Setup framework.

3. Right-click the Ethernet Communications module and configure the setup
registers to match your system.

Meter Network Configuration and ION Enterprise

After you have wired your meter to the Ethernet network and performed basic
setup, add the meter to your ION Enterprise network using the Management
Console.

See the Management Console section in the online ION Enterprise Help for details.

The EtherGate Protocol

The EtherGate protocol is a communications tool that lets you communicate to a
meter and through a meter simultaneously. When a meter installed on the
Ethernet network has EtherGate enabled, a master device (such as a workstation
running ION Enterprise software) can communicate to the meter and through the
meter to a serial network of devices wired to the meter’'s COM port. EtherGate is
available on serial ports COM2 and COMB3. The protocol permits the direct transfer
of data from up to 62 devices (31 devices per COM port).
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Specifying the TCP/IP Port
instructs the ION gateway
meter to:

7802—talk through COM2

Each device in the
serial network must
have a unique Unit
ID and operate at

the same baud rate.

7803—talk through COM3

Once you have the chain of serial devices installed, use ION Setup or the meter’s
front panel to change the COM2 or COMS3 Protocol setting to EtherGate. The
transfer of data between protocols is then handled automatically.

Refer to The ION Meter as an Ethernet Gateway technical note for information on
configuring your meter for EtherGate.

Modem Communications Setup

See “Serial Communications Setup” on page 80 for configuring COM4. Additional
modem configuration required is explained in the following section.

ModemlInit Setup Register

The Modemlnit string register defines the initialization string for the internal
modem, with a maximum of 47 characters. Edit the ModemInit register and enter
the initialization string desired. The string is sent to the modem as soon as you
download the COM4 module. Note that the string is also sent to the modem
whenever the meter is powered up, or whenever the baud rate in the Comm 4
Communications module is changed. Any changes to the Modem Init or Baud Rate
setup registers while the modem is online will cause the modem to disconnect
from the phone line.

Modem Initialization Strings

Refer to the Modem AT Commands technical note for a complete list of AT
commands for your modem.

Adjusting the Modem Initialization String for CTR-21 Compliant modems

The table below shows the strings to add to the end of your modem configuration
string setup register for each of three possible problems.
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Workstation with
ION Enterprise
and modem

Problem Add to Modem Initialization String
Does not answer «

(modem does not detect ring tone) NC70

Does not dial In order of preference:

(modem does not detect dial tone) *NC70, *NC70X0, *NC8 (ltaly only)
Does not detect busy signal *NC70

If your local modem (not the internal modem) is not already set up, configure it
with the Remote Modem Configuration Utility according to the instructions in the
online help. After the meter is installed and the internal modem is connected to the
telephone network, the Com4 module can be configured using the meter’s front
panel or ION software. To learn how to connect the internal modem to the
telephone network, consult your meter’s Installation Guide.

Adding a Meter and a Modem Site to your ION Enterprise Network

In the Management Console, add the meter with the internal modem and a modem
site to your ION Enterprise network.

Consult the online ION Enterprise Help for details on commissioning an ION
network, managing modem connections, setting up periodic dial-out, and
configuring remote site event notification.

The ModemGate Protocol

The ModemGate feature creates a communications connection between the
telephone network and an RS-485 serial network of devices. When you specify the
protocol for a meter's COM port as MODEMGATE, all data received by the meter’s
internal modem is automatically transferred to the serial network. ModemGate is
available on either COM2 and COM3, but you cannot use the protocol on both
ports simultaneously.

Meter with an internal
modem on COM4.
The serial network is
connected to COM2.

Each device on the RS-485 loop,
including the gateway meter’s internal
modem, must have a unique Unit ID.
All serial devices must operate at the
same baud rate as the gateway meter.
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ModemGate connections do not connect a workstation with ION Enterprise (or
other master device) to the gateway meter’'s COM2 or COM3 port, but rather the
gateway meter’s internal modem port (COM4).

Refer to The ION Meter as a ModemGate technical note for information on
configuring your meter for ModemGate.

Internet Connectivity

Ethernet-equipped ION8800 meters provide Internet connectivity so you can receive
meter emails, view real-time data, and configure your system through a web
browser from anywhere in the world. Your meter provides the following internet
connectivity options:

¢ WebMeter feature -- this onboard web server allows you to view real-time data
and configure the meter through a web browser.

¢ MeterM@il feature -- receive data logs and email alerts from the meter.
¢ WebReach -- view Vista system information using a web browser.

¢ Microsoft Terminal Services for ION Enterprise -- an ION Enterprise system that
is located on a Terminal Server allows multiple users to view or configure an
ION Enterprise system through a web browser.

WebMeter Feature

WebMeter-enabled meters have an on-board web server. Built-in web pages
display certain energy and basic power quality information and also support basic
meter configuration tasks. A meter with the WebMeter feature can be connected to
your corporate Ethernet network like any other network device, and you can
access it with a standard web browser like Internet Explorer.

Refer to the WebMeter Internal Web Server Feature technical note to learn how to:

¢ view your WebMeter data on the Internet

¢ configure your WebMeter-enabled meter

¢ set up your network for the WebMeter feature

¢ enable/disable web browser configuration of the meter

MeterM @il Feature

The MeterM@il feature allows your meter to send data logs as email attachments
to a workstation, pager, cell phone, or PDA. In addition to the log export function,
your meter can send email alerts.

Refer to the MeterM@il Internal Email Client Feature technical note to learn how to:

& view MeterM@il data
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WebReach

¢ set up your network for the MeterMil feature
¢ configure your meter to use the MeterM@il feature

+ set up the meter for your SMTP Server
+ set up the MeterMeil feature to send alerts
+ set up the MeterMeil feature to send data logs

The online version of Vista (WebReach) allows you to remotely view ION
Enterprise information through a web browser. WebReach requires a simple URL
and no client machine configuration so you have the flexibility to view your data
from a web browser anywhere in the world. With WebReach, you can view real-
time data and select views of historical/waveform data. Currently, no
configuration or control functions are available through WebReach.

Refer to the online ION Enterprise Help for more details on WebReach.

Telnet and HyperTerminal

You can access certain Ethernet settings and statistics through a telnet application
such as Microsoft Telnet. Similarly, you can use Windows HyperTerminal to access
certain meter module settings. Use the following guidelines to determine which
application you should use to access your meter:

¢ If your meter is connected to an Ethernet network, use a telnet application such
as Microsoft Telnet.

¢ If your meter is connected serially or through a modem to your workstation, use
a terminal application such as Windows HyperTerminal.

You can access certain Power Meter module and Factory module settings from
both a Telnet session and HyperTerminal session. Additionally, a Telnet session
lets you view Ethernet statistics and access certain Ethernet communications
module settings.

Refer to the Telnet and HyperTerminal Access technical note for the appropriate
application’s menu options and connection instructions.
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Communications LEDs

The following table explains what the flashing LED lights on the back of the
Communications Module signify.

LED Color Function

Ethernet ACTIVITY Green' Flashes as signals are transmitted and received for both Ethernet 10 Base-T and 10 Base-FL ports
Ethernet LINK Green! On as long as there is an active connection to either the 10 Base-T or 10 Base-FL ports

Internal Modem DCD | Green Carrier Detect — Indicates the presence of a carrier signal (active connection to the modem)
Internal Modem RI Green Flashes when the modem detects rings (Ring Indicator)

COM4 TRANSMIT Red! Flashes as signals are transmitted from the COM4 internal modem

COM4 RECEIVE Red! Flashes as signals are received on COM4 internal modem

COM2 TRANSMIT Red Flashes as signals are transmitted from the COM2 RS-485 loop

COM?2 RECEIVE Red Flashes as signals are received on COM2 RS-485 loop

COM3 TRANSMIT Red Flashes as signals are transmitted from the COM3 RS-232 connection or the COM3 RS-485 loop
COMS3 RECEIVE Red Flashes as signals are received on COM3 RS-232 connection or the COM3 RS-485 loop

! LED colors may differ from the standard red and green.
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Third-party Protocols

This chapter explains how Modbus and DNP 3.0 protocols are implemented on the
meter.

For instructions on using the meter with DLMS, IRIG-B and MV-90 protocols, see
the following documents:

o DLMS/COSEM and ION Technology protocol document
o IRIG-B GPS Time Synchronization technical note
& MV90 and ION Technology technical note

In This Chapter

® OVerview . ...t i i i i i i i it i 90
Communications Protocol Configuration ................................ 90

& The Meteras Modbus Slave ...t 91
Using the Modbus RTU Protocol ................ ... 91
Modbus Slave Modules . ......... ... ... . 92
Using the Modbus/TCP Protocol ............ccoi i, 107

o The Meter as Modbus Master ..............covvviiiiiiininnn.. 108
The Factory Modbus Master Configuration ............................. 108

& ConfiguringModbus . ....... ...ttt 109

¢ Usingthe DNP3.0Protocol .........covviiiiinninnennnnnnnn. m
Configuring DNP 3.0 . ... i 112
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Overview

All ION8800 meters support DNP 3.0, Modbus RTU and Modbus/TCP protocols;
only ION8800A and ION8800B meters support Modbus Mastering.

While your meter is factory configured to send data (acting as Modbus Slave), it is
not ready to receive data as a Modbus Master until you set up the necessary
framework. The meter is also pre-configured to send DNP 3.0 data to a DNP
Master.

2\ NOTE

Changing the default factory third-party protocol frameworks (or creating new frameworks to enable
receive functionality) is an advanced procedure. Refer to the DNP modules and Modbus modules
descriptions in the /ON Reference, as well as the technical notes Multiport DNP 3.0 and ION Technology
and Modbus and ION Technology before proceeding.

Most Modbus and DNP modules on the meter are factory pre-set and only require
basic configuration, such as communications setup.

2\ NOTE

Changing these modules from their factory configuration is an advanced setup procedure that requires
an understanding of the protocol, as well as an understanding of the meter’s internal operation. For more
information on your meter and these protocols see the Common Modbus Registers technical note and
the JON8800 DNP 3.0 Device Profile.

Communications Protocol Configuration

In order to use the factory Modbus or DNP configuration, you must first assign the
communications channel you want to use. By default, all communications ports
are configured to use the ION protocol. Choose the 3rd-party protocol you want
from the list of available protocols in the Communications module’s Protocol
setup register. See the Communications chapter for instructions.

Modbus RTU is available on each of the meter’s communications ports, and
multiple ports can communicate using Modbus simultaneously. Up to three ports
can use the DNP 3.00 protocol at any one time.
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The Meter as Modbus Slave

Using the Modbus

All ION8800 meters can act as a Modbus Slave, using both the Modbus RTU and
Modbus/TCP protocols.

RTU Protocol

IONB8800 meters acting as Modbus Slave devices can make any real-time data
available through the Modicon Modbus RTU protocol. Modbus Master devices
connected to the meter can access (read) this data or write data to the meter’s ION
registers, making device configuration changes and initiating control actions.

The Factory Modbus Slave Configuration

The meter makes data available to Modbus Master devices using pre-configured

Modbus Slave modules. These modules are linked to other modules in the meter

that provide the energy, power and demand data. Once a communications channel
is configured to use Modbus RTU protocol, the data is available to Modbus Master
devices.

2\ NOTE

Connect to TCP Service Port 7701 for Modbus RTU communications over Ethernet. The default Modbus
Unit ID of the meter over Ethernet is 100 but it can be changed to any value.

Set the COM port
to the Modbus
RTU protocol

Communications Port

Power Meter Vin a Modbus Slave 40011
Module Module
Measured data is Modbus Slave module
JON Meter linked 1? The Modbus outputs data in Modbus
module’s input format

Since the data available through the Modbus Slave modules is in a specific format,
knowledge of the Modbus protocol and an understanding of the settings used in
the meter are required to interpret the data provided.

Changing the Modbus Configuration

If the factory Modbus configuration does not suit your needs, the existing Modbus
Slave modules can be relinked to other parameters that you want to access through
Modbus.
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If your Modbus Master device requires data in a format different than that
provided by the factory Modbus configuration, you can edit the setup registers in
the Modbus Slave modules. These setup registers specify the Modbus format,
scaling and base address settings. Refer to the ION Reference for complete details
on the Modbus Slave module.

Modbus Slave Modules

Your meter is pre-configured with five modules. (ION8800 meters with the
EN50160 ordering option have 11 additional modules). The settings for your
Modbus Slave modules are as follows:

Amp/Freq/Unbal

Format: unsigned 16 bit InZero: 0
Base Address: 40150 InFull: 6,000
Scaling: Yes OutZero: 0
Scaling x10 QutFull: 60,000
Input Modbus Registers Parameter
Source #1 40150 I
Source #2 40151 12
Source #3 40152 13
Source #4 40153 14
Source #5 40154 15
Source #6 40155 | avg
Source #7 40156 | avg mn
Source #8 40157 | avg mx
Source #9 40158 | avg mean
Source #10 40159 Freq
Source #11 40160 Freq mn
Source #12 40161 Freq mx
Source #13 40162 Freq mean
Source #14 40163 U unbal
Source #15 40164 | unbal
Source #16 40165 Phase Rev
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Volts
Format: unsigned 32 bit InZero: 0
Base Address: 40166 InFull: 1,000,000
Scaling: No OutZero: 0
Scaling x10 OutFull: 10,000,000
Input Modbus Registers Parameter
Source #1 40166 to 40167 Uln 1
Source #2 40168 to 40169 Uln 2
Source #3 40170 t0 40171 Uln 3
Source #4 40172 t0 40173 Uln avg
Source #5 40174 t0 40175 Uln avg mx
Source #6 40176 to 40177
Source #7 40178 to 40179 ul12
Source #8 40180 to 40181 ull 23
Source #9 40182 to 40183 ull 31
Source #10 40184 to 40185 Ull avg
Source #11 40186 to 40187 Ull avg mx
Source #12 40188 to 40189 Ull avg mean
Source #13 40190 to 40191
Source #14 40192 to 40193
Source #15 40194 to 40195
Source #16 40196 to 40197
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kW/kvar/kVA

Format: signed 32 bit InZero: -1,000,000,000
Base Address: 40198 InFull: 1,000,000,000
Scaling: No OutZero:  -1,000,000
Scaling x0.001 OutFull: 1,000,000

Input Modbus Registers Parameter

Source #1 40198 to 40199 kW 1

Source #2 40200 to 40201 kW 2

Source #3 40202 to 40203 kW 3

Source #4 40204 to 40205 kW tot

Source #5 40206 to 40207 kW tot max

Source #6 40208 to 40209 kvar 1

Source #7 40210 to 40211 kvar 2

Source #8 40212 to 40213 kvar 3

Source #9 40214 to 40215 kvar tot

Source #10 40216 to 40217 kvar tot max

Source #11 40218 to 40219 kVA 1

Source #12 40220 to 40221 kVA 2

Source #13 40222 to 40223 kVA 3

Source #14 40224 to 40225 kVA tot

Source #15 40226 to 40227 kVA tot max

Source #16 40228 to 40229
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kWh/kvarh

Format: signed 32 bit InZero: -1,000,000,000
Base Address: 40230 InFull: 1,000,000,000
Scaling: No OutZero:  -1,000,000
Scaling x0.001 OutFull: 1,000,000

Input Modbus Registers Parameter

Source #1 40230 to 40231 kWh del

Source #2 40232 to 40233 kWh rec

Source #3 40234 to 40235 kvarh del

Source #4 40236 to 40237 kvarh rec

Source #5 40238 to 40239 kVAh del+rec

Source #6 40240 to 40241

Source #7 40242 to 40243

Source #8 40244 to 40245

Source #9 40246 to 40247

Source #10 40248 to 40249

Source #11 40250 to 40251

Source #12 40252 to 40253

Source #13 40254 to 40255

Source #14 40256 to 40257

Source #15 40258 to 40259

Source #16 40260 to 40261
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PF/THD/Kfactor

Format: signed 16 bit InZero: -100

Base Address: 40262 InFull: 100

Scaling: No OutZero:  -10,000

Scaling x100 OutFull: 10,000
Input Modbus Registers Parameter
Source #1 40262 PF sign 1
Source #2 40263 PF sign 2
Source #3 40264 PF sign 3
Source #4 40265 PF sign tot
Source #5 40266 U1 THD mx
Source #6 40267 U2 THD mx
Source #7 40268 U3 THD mx
Source #8 40269 1T THD mx
Source #9 40270 12 THD mx
Source #10 40271 I3 THD mx
Source #11 40272 I1 K Factor
Source #12 40273 12 K Factor
Source #13 40274 I3 K Factor
Source #14 40275 I1 Crest Factor
Source #15 40276 12 Crest Factor
Source #16 40277 I3 Crest Factor
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EN50160 Module 1

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41000

Scaling: No
Input Modbus Registers Parameter
Source #1 41000 PO U1-Flicker N
Source #2 41001 PO U1-Flicker N1
Source #3 41002 PO U2-Flicker N
Source #4 41003 PO U2-Flicker N1
Source #5 41004 PO U3-Flicker N
Source #6 41005 PO U3-Flicker N1
Source #7 41006 PO Freq N
Source #8 41007 PO Freq N1
Source #9 41008 PO Freq N2
Source #10 41009 PO U1-Mag N
Source #11 41010 PO U1-Mag N1
Source #12 41011 PO U2-Mag N
Source #13 41012 PO U2-Mag N1
Source #14 41013 PO U3-Mag N
Source #15 41014 PO U3-Mag N1
Source#16 41015 PO Vunbal N

PO = Observation Period
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EN50160 Module 2

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41016

Scaling: No
Input Modbus Registers Parameter
Source #1 41016 PO Uunbal N1
Source #2 41017 PO U1-MSignal N
Source #3 41018 PO U1-MSignal N1
Source #4 41019 PO U2-MSignal N
Source #5 41020 PO U2-MSignal N1
Source #6 41021 PO U3-MSignal N
Source #7 41022 PO U3-MSignal N1
Source #8 41023 PO UT-Harmonic N
Source #9 41024 PO U1-Harmonic N1
Source #10 41025 PO UT-Harmonic N2
Source #11 41026 PO U2-Harmonic N
Source #12 41027 PO U2-Harmonic N1
Source #13 41028 PO U2-Harmonic N2
Source #14 41029 PO U3-Harmonic N
Source #15 41030 PO U3-Harmonic N1
Source#16 41031 PO U3-Harmonic N2

PO = Observation Period, M = Mains
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EN50160 Module 3

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41032

Scaling: No

Input Modbus Registers Parameter
Source #1 41032 PO U1-Inthrm N
Source #2 41033 PO U1-Inthrm N1
Source #3 41034 PO U2-Inthrm N
Source #4 41035 PO U2-Inthrm N1
Source #5 41036 PO U3-Inthrm N
Source #6 41037 PO U3-Inthrm N1
Source #7 41038 PO U1-Dip NT1
Source #8 41039 PO U1-Dip N12
Source #9 41040 PO U1-Dip N13
Source #10 41041 PO U1-Dip N14
Source #11 41042 PO U1-Dip N21
Source #12 41043 PO U1-Dip N22
Source #13 41044 PO U1-Dip N23
Source #14 41045 PO U1-Dip N24
Source #15 41046 PO U1-Dip N31
Source#16 41047 PO U1-Dip N32

PO = Observation Period, Inthrm = Interharmonics
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EN50160 Module 4

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41048

Scaling: No

Input Modbus Registers Parameter

Source #1 41048 PO U1-Dip N33
Source #2 41049 PO U1-Dip N34
Source #3 41050 PO U1-Dip N41
Source #4 41051 PO U1-Dip N42
Source #5 41052 PO U1-Dip N43
Source #6 41053 PO U1-Dip N44
Source #7 41054 PO U1-Dip N51
Source #8 41055 PO U1-Dip N52
Source #9 41056 PO U1-Dip N53
Source #10 41057 PO U1-Dip N54
Source #11 41058 PO U1-Dip Né1
Source #12 41059 PO U1-Dip N62
Source #13 41060 PO U1-Dip N63
Source #14 41061 PO U1-Dip Né64
Source #15 41062 PO U2-Dip N11
Source#16 41063 PO U2-Dip N12

PO = Observation Period
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EN50160 Module 5

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41064

Scaling: No

Input Modbus Registers Parameter

Source #1 41064 PO U2-Dip N13
Source #2 41065 PO U2-Dip N14
Source #3 41066 PO U2-Dip N21
Source #4 41067 PO U2-Dip N22
Source #5 41068 PO U2-Dip N23
Source #6 41069 PO U2-Dip N24
Source #7 41070 PO U2-Dip N31
Source #8 41071 PO U2-Dip N32
Source #9 41072 PO U2-Dip N33
Source #10 41073 PO U2-Dip N34
Source #11 41074 PO U2-Dip N41
Source #12 41075 PO U2-Dip N42
Source #13 41076 PO U2-Dip N43
Source #14 41077 PO U2-Dip N44
Source #15 41078 PO U2-Dip N51
Source#16 41079 PO U2-Dip N52

PO = Observation Period
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EN50160 Module 6

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41080

Scaling: No

Input Modbus Registers Parameter

Source #1 41080 PO U2-Dip N53
Source #2 41081 PO U2-Dip N54
Source #3 41082 PO U2-Dip Né61
Source #4 41083 PO U2-Dip N62
Source #5 41084 PO U2-Dip N63
Source #6 41085 PO U2-Dip N64
Source #7 41086 PO U3-Dip N11
Source #8 41087 PO U3-Dip N12
Source #9 41088 PO U3-Dip N13
Source #10 41089 PO U3-Dip N14
Source #11 41090 PO U3-Dip N21
Source #12 41091 PO U3-Dip N22
Source #13 41092 PO U3-Dip N23
Source #14 41093 PO U3-Dip N24
Source #15 41094 PO U3-Dip N31
Source#16 41095 PO U3-Dip N32

PO = Observation Period
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EN50160 Module 7

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41096

Scaling: No

Input Modbus Registers Parameter

Source #1 41096 PO U3-Dip N33
Source #2 41097 PO U3-Dip N34
Source #3 41098 PO U3-Dip N41
Source #4 41099 PO U3-Dip N42
Source #5 41100 PO U3-Dip N43
Source #6 41101 PO U3-Dip N44
Source #7 41102 PO U3-Dip N51
Source #8 41103 PO U3-Dip N52
Source #9 41104 PO U3-Dip N53
Source #10 41105 PO U3-Dip N54
Source #11 41106 PO U3-Dip Né1
Source #12 41107 PO U3-Dip N62
Source #13 41108 PO U3-Dip N63
Source #14 41109 PO U3-Dip Né64
Source #15 41110 PO Ul-Intrpt N1
Source#16 41111 PO U1-Intrpt N2

PO = Observation Period, Intrpt = Interruptions
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EN50160 Module 8

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41112

Scaling: No

Input Modbus Registers Parameter

Source #1 41112 PO Ul-Intrpt N3
Source #2 41113 PO U2-Intrpt N1
Source #3 41114 PO U2-Intrpt N2
Source #4 41115 PO U2-Intrpt N3
Source #5 41116 PO U3-Intrpt N1
Source #6 41117 PO U3-Intrpt N2
Source #7 41118 PO U3-Intrpt N3
Source #8 41119 PO U1-Ovlt N11
Source #9 41120 PO U1-Ovlt N12
Source #10 41121 PO U1-Ovlt N13
Source #11 41122 PO U1-Ovlt N14
Source #12 41123 PO U1-Ovlt N15
Source #13 41124 PO U1-Ovlt N21
Source #14 41125 PO U1-Ovlt N22
Source #15 41126 PO U1-Ovlt N23
Source#16 41127 PO U1-Ovlt N24

PO = Observation Period, Ovlt = Over Voltage, Intrpt = Interruption
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EN50160 Module 9

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41128

Scaling: No

Input Modbus Registers Parameter

Source #1 41128 PO U1-Ovlt N25
Source #2 41129 PO U1-Ovlt N31
Source #3 41130 PO U1-Ovlt N32
Source #4 41131 PO U1-Ovlt N33
Source #5 41132 PO U1-Ovlt N34
Source #6 41133 PO U1-Ovlt N35
Source #7 41134 PO U2-Ovlt N11
Source #8 41135 PO U2-Ovlt N12
Source #9 41136 PO U2-Ovlt N13
Source #10 41137 PO U2-Ovlt N14
Source #11 41138 PO U2-Ovlt N15
Source #12 41139 PO U2-Ovlt N21
Source #13 41140 PO U2-Ovlt N22
Source #14 41141 PO U2-Ovlt N23
Source #15 41142 PO U2-Ovlt N24
Source#16 41143 PO U2-Ovlt N25

PO = Observation Period, Ovlt = Over Voltage
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EN50160 Module 10

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41144

Scaling: No

Input Modbus Registers Parameter

Source #1 41144 PO U2-Ovlt N31
Source #2 41145 PO U2-Ovlt N32
Source #3 41146 PO U2-Ovlt N33
Source #4 41147 PO U2-Ovlt N34
Source #5 41148 PO U2-Ovlt N35
Source #6 41149 PO U3-Ovlt N11
Source #7 41150 PO U3-Ovlt N12
Source #8 41151 PO U3-Ovlt N13
Source #9 41152 PO U3-Ovlt N14
Source #10 41153 PO U3-Ovlt N15
Source #11 41154 PO U3-Ovlt N21
Source #12 41155 PO U3-Ovlt N22
Source #13 41156 PO U3-Ovlt N23
Source #14 41157 PO U3-Ovlt N24
Source #15 41158 PO U3-Ovlt N25
Source#16 41159 PO U3-Ovlt N31

PO = Observation Period, Ovlt = Over Voltage

EN50160 Module 11

This module applies to meters with the EN50160 ordering option only.

Format: Unsigned 16 bit
Base Address: 41160

Scaling: No
Input Modbus Registers Parameter
Source #1 41160 PO U3-Ovlt N32
Source #2 41161 PO U3-Ovlt N33
Source #3 41162 PO U3-Ovlt N34
Source #4 41163 PO U3-Ovlt N35

PO = Observation Period, Ovlt = Over Voltage
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Importing Data using Modbus RTU

It is possible to bring data into the meter using Modbus. Various ION registers can
be written by Modbus Master devices by correlating the Modbus register number
with the address of the ION register you want to write. When a Modbus register is
written with a value, the corresponding ION register will be written, provided the
Modbus RTU protocol is active on the communications channel that connects the
Modbus Master to the meter.

You can use the Modbus RTU protocol to write values into ION external numeric,
pulse and Boolean registers, allowing you to enable, disable and reset meter
functions. You can also use the Modbus protocol to change setup register values in
various ION modules to configure the meter’s operation. To bring data into the
meter with Modbus RTU, you must disable the meter’s password security.

Using the Modbus/TCP Protocol

Modbus/TCP is the newest open Modbus protocol variant (formerly called
MBAP). It defines the packet structure and connection port (port 502) for the
industry standard TCP/IP protocol. The structure of Modbus/TCP is very similar
to the Modbus RTU packet except that it has an extra six-byte header and does not
use the cyclic redundancy check (CRC). Modbus/TCP retains the Modbus RTU
limit of 256 bytes to a packet.

Modbus TCP Communications

You can communicate to the meter using Modbus TCP (formerly called MBAP).
Your meter must have the optional Ethernet port. Connect to socket 502.

Connect to socket 502

|

‘I

2\ NOTE

You cannot make an EtherGate connection to the Modbus TCP network.
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The Meter as Modbus Master

IONS8800A and IONS8800B meters can act as a Modbus Master using the Modbus
RTU and Modbus/TCP protocols. However, only serial connections are supported
between the ION8800 meter and the Modbus Slave devices.

The ION meter acting as Modbus Master can write data to (export) and read data
from (import) Modbus Slave devices, using various ION modules. The data can be
processed by the meter and sent out using other communications methods (email,
ION software, etc.). The meter can also send control commands or data directly to
other devices on a Modbus network.

The Factory Modbus Master Configuration

There is no pre-configured framework for Modbus mastering on your meter. Your
meter’s template contains the following modules but they must first be added,
enabled and configured in a framework before full functionality is possible.

ION Modules for Modbus Mastering

Several ION modules work together to create Modbus mastering functionality on
the meter. Your meter will have some or all of these modules, depending on the
model and firmware version. See the ION Reference for more information on these
and other ION modules:

¢ Modbus Master Device Module: provides read functionality when used in
conjunction with the Modbus Master Map module. This imported data can be
used by other ION modules.

¢ Modbus Master Map Module: provides a common place to hold setup
information for decoding a Modbus response. This information can be used by
multiple Modbus Master Device modules.

¢ Modbus Master Options Module: maps any serial connection from the
Modbus Import and Modbus Export modules to any serial communications
port.

¢ Modbus Export Module: provides write functionality.
¢ Modbus Import Module: provides read functionality. This data can then be
used by other ION modules.

See the Modbus and ION Technology technical note for more information on
configuring Modbus mastering.
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Configuring Modbus

Using the Front Panel

You cannot configure Modbus through the meter’s front panel. You can only
assign the Modbus protocol to communication ports. See the Communications
chapter for details.

Using ION Setup

The Modbus Setup Assistant helps you configure both Modbus Master and Slave
functionality for your meter.

1.

2
3.
4

Open ION Setup and connect to your meter, using Basic Mode.

In the Setup Assistant, navigate to Communications > 3rd Party Protocols.

Select the Modbus Slave tab to edit the Modbus Slave modules.

Select the map name (in this example, the default map) and click Edit.

Setup Assistant E

Madbus Slave | Madbus Master | DNP 2.0

Wllows pou to customize the Modbus map used by other 3rd party
device to communicate to the meter.

# of registers | Start | End

40011 41163

< Back | Mest » | Exit | Help |

5. The default Modbus map editor appears, allowing you to edit, add, delete or set
the name of Modbus Slave module registers.

Default Modbus Map

]

Parameter Address | Regs | Format Scaling |~ Edit I
Uln2 aomz 1 UINT1E 10 Add
Uln 3 0mz 1 UINT1E 10 —I
Uln avg 4004 1 UINT1E 10 Delete
unz 40ms 1 UINT1E 10 —I
un 23 40ME 1 UINT1E 10 Set Name
U3 40m7 1 UINT1E 10 —I
Ul avg 40ma 1 UINT1E 10
11 40ma 1 UINT1E 10
12 40020 1 UINT1E 10
13 40021 1 UINT1E 10
| avg 40022 1 UINT1E 10
U unbal 40023 1 UINT1E 10
| unbal 40024 1 UINT1E 10 LI Save bs |

ak. I Cancel FErint | Help |
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6. Select the Modbus Master tab.
7. Click Add to add a Modbus Slave device.

Setup Assistant E
= Template Madbus Slave Madbus Master | DNP 2.0
= Baszic Setup
= Security Willows pou to program 3rd party device Modbus mapping information
(2 Communications for the meter ta retrieve when configured as a Modbus maszter.

Serial Settings
Metwork Settings
== 3rd Party Protocols

Slave device | Statuz | Last Update

Delete |

< Back | Mest » | Exit | Help |

8. The Modbus Device screen appears. Enter the Slave device’s name and a label
suffix, and select a device type (in this example, an ION6200).

Mame: ISubmeter_‘I
Label suffis: J5M1

Device Type: lm Hew
Connected wia: IW
Slave ID: W

’TI Cancel | Help |

Connections

9. Click Connections to edit the serial connection used by the Modbus Master to
connect to this Slave device. Note that the ION8800 meter currently does not
support downstream TCP connections for Modbus mastering.

Modbus Master Connections [ %]
Serial 1 | Serial 2| Serial 2| Serial 4

Aszzigned Port:

Modbus Pratocal: RTU

F ak. I Cancel | Help |

Select a communications port from the Assigned Port drop-down list and click
OK.
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Using the DNP

10. Click OK to add the Slave device. The device now appears in the list. Continue
adding devices and click Exit when you are finished.

See the Modbus and ION Technology technical note for more information.

3.0 Protocol

The Distributed Network Protocol Version 3.0 (DNP 3.0) is an open protocol used
in the electric utility industry for communications and interoperability among
substation computers, Remote Terminal Units (RTUs), Intelligent Electronic
Devices (IEDs, e.g. meters), and Master Stations.

The ION8800 meter can be integrated into a DNP network as a DNP Slave, using
the DNP Slave Import, DNP Slave Export and DNP Slave Options modules. For
more information on the various DNP modules, see the ION Reference.

Your meter supports a maximum of three concurrent connections (or “sessions”
using the DNP 3.0 protocol; one for each serial port, up to three using Ethernet, or
a combination of both. Available combinations will depend on the meter's
communications options. A session consists of all incoming and outgoing DNP
Master/Slave traffic on one of the meter's communications ports.

Consult the DNP User’s Group at http://www.dnp.org/ to learn more about the
protocol.

The Factory DNP 3.0 Configuration

Your meter is pre-configured with a DNP framework that allows for basic DNP
Slave functionality. DNP Slave Export modules are used to send data to the DNP
Master while DNP Slave Options modules provide per-session settings such as
communications options. Although some minor setup of the framework is
necessary before it becomes enabled (assigning the DNP protocol to the
communications ports etc.), most module settings should not require alteration.

For information on your meter’s default DNP map and factory configuration, see
the ION8800 DNP 3.0 Device Profile.

Importing Data using DNP 3.0

Data can be imported into the meter from a DNP control relay or analog output
device. DNP Slave Import modules are used to take a DNP Analog output or
Binary output object and map them into ION registers.

2\ NOTE

DNP Slave Import modules are not part of the factory DNP framework and must be added manually.
Refer to the DNP Slave Import module description in the /ON Reference for details.
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Configuring DNP 3.0

If the factory DNP configuration does not suit your needs, you can relink the
existing DNP Slave Export modules to access a different set of parameters through
DNP. Alternately, you can add additional DNP Slave Export modules and link the
desired ION parameters to them.

If your DNP network requires data in a format different than that provided by the
factory DNP configuration, you can edit the setup registers in the DNP Slave
Export modules and the DNP Slave Options modules. Do not make any changes
to the DNP Slave Options modules’ setup registers unless you understand the
effects each change will cause. Refer to the ION Reference for complete details on
DNP Slave Export and DNP Slave Options module function.

For detailed information on configuring your meter to use DNP, see the Multiport
DNP 3.0 and ION Technology technical note.

Using the Front Panel

You cannot configure DNP through the meter’s front panel. You can only assign
the DNP 3.0 protocol to communication ports. See the Communications chapter.

Using ION Setup

The DNP 3.0 Setup Assistant helps you configure the DNP Slave Export and DNP
Slave Options modules.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to Communications > 3rd Party Protocols and
select the DNP 3.0 tab.

3. Select the DNP feature you want to configure (Parameter Map in this example)
and click Edit.

Setup Assistant E

E= Template Modbus Slave I Modbus Master  DHP 3.0 |
Basic Setup
Securty Wllowes you to customize the DMP 3.0 map used by other 3rd party
device to communicate to the meter.

= Metwork Settings
== 3rd Party Protocols

Configuration of Operational Ports

Parameter map MOME

E dit :j

< Back | Mest » | Exit | Help |

4. The Setup Assistant guides you through DNP configuration. See the ION Setup
Online Help for more information.
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This chapter covers the meter’s clock and time synchronization.

In This Chapter
¢ Meter Clock Configuration ................ccoiiiiiiiiiennnnn. 114
Configuring the Meter Clock ............. ... ... . i it 114
Using the FrontPanel ........... ... ... .. ... ... . o o . 114
Using ION Setup ... 114
Using Designer ................ .. i 115
Clock Module Settings .......... ... ... ... ... . 115
& Time Synchronization ..............ciiiiiiiiiiiiiiiiiiie, 115
@ MetferBattery . .......oiiiiiiiiiiiiiiiiiiii ittt 116
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Meter Clock Configuration

The Clock module controls the meter’s internal clock, which provides timestamps
for data logged by the device. The clock needs to be configured properly to ensure
that logged data has accurate timestamp information. The Clock module also
receives the time synchronization signals sent to it by the workstation running
ION software, updating the device’s clock when required.

The Clock module’s Clock Source setup register defines how the meter’s internal
clock auto-corrects drift from its internally calculated time. A separate time source
(such as a GPS receiver or a DNP Master) can be used to synchronize the clock

through a communications channel. By default, the clock is set to synchronize from
the line frequency.

See the ION Reference for more information on the Clock module.

Configuring the Meter Clock

Use ION software to change the meter’s clock settings.

Using the Front Panel

You cannot configure the time via the meter’s front panel.

Using ION Setup

The Clock Setup Assistant helps you configure the Clock module.
1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, select the Clock screen on the left-hand pane.

Setup Assistant E
= Template Timezone | DST Settingsl
“= Basic Setup

Security Wllowes you to program the meter clock settings.
(2] Communications

Demand
(27 Inputs/Outputs
(21 Loaging Timezone Pacific: (GMT-03:00]
(Z] Revenue CL1 Time Sync Type TC

Pawer Quality CL1 Time Sync Source ETHERMET

— CL1 Clack Source Internal
== Displays CL1 DST Offset 1 hour
Werification CL1 LocalTime Thu bar 09, 2006 3:35:37 P
Reports
Edt | Timegne |
< Back | Mest » | Exit | Help |

3. Select the Timezone tab to configure your meter’s clock settings. Select a
parameter and click Edit to change.
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4. Select the DST Settings tab to configure your meter’s daylight savings periods
for up to 20 years. Select a parameter and click Edit to change.

Using Designer

Open your meter in Designer and navigate to the Meter Clock Setup framework.
Right-click on the Clock module to edit.

Clock Module Settings

The setup registers in the Clock module specify timezone and Daylight Savings
Time (DST) parameters and time synchronization functions.

Setup Register Function Default
TZ Offset Sets the timezone the device is in, relative to Greenwich Mean Time. 0
B§$ g:g: ;0 The date and time when DST begins for 20 separate years.
See below
BEI E:j 20 The date and time when DST ends for 20 separate years.
DST Offset The amount of time the clock is changed when DST begins or ends. 3, 600 seconds
Time Sync Source Specifies the communications port that receives time sync signals. COM1
Time Sync Type Specifies the type of time sync signal (Local or Universal time). uTC
Clock Source ZZ?ET:soirﬁ‘:;?rflgl’scliyr;zI;ynchronizotion signal source (line frequency, communications Internl

O ™

When modifying setup registers of the Clock module in Designer, use the Format option to convert
between UNIX and conventional time. Refer to the description of the Clock module in the online
/ON Reference for more details.

Typically, the DST Start and DST End registers do not have to be reconfigured for
users in North America. The factory defaults are the DST start and end dates for 20
years, in UNIX time (the number of seconds since 00:00:00 UTC on Jan. 1, 1970).

Time Synchronization

Time synchronization lets you synchronize your meter’s internal clock with all of
the other meters, devices, and software in a network. Once synchronized, all data
logs have timestamps that are relative to a uniform time base. This allows you to
achieve precise sequence-of-events and power quality analyses. Use ION software
to broadcast time signals across the network or utilize an external source (such as
an NTP server or DNP Master) to synchronize your meter’s clock.

Refer to the Time Synchronization & Timekeeping technical note for more
information on implementing time synchronization.
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Meter Battery

Refer to the DLMS/COSEM and ION Technology protocol document for information
on time synchronization with DLMS.

For meters with the IRIG-B ordering option, refer the IRIG-B GPS Time
Synchronization technical note that came with your meter.

The battery in the ION8800 meter keeps the real-time clock running when supply
power is lost. Replace the battery if the meter has been stored for an extended
period of time without power (longer than two years). If the meter will be without
power for an extended length of time, disconnect the battery cable so that the
battery maintains its 10-year shelf life.

Refer to your meter’s Installation Guide for more information on replacing the meter
battery.

Event Screen/Event Log confirmation (Unpowered Meter)

On an unpowered meter, the battery powers the internal clock. Removing the old
battery effectively stops the meter’s clock until the battery is replaced. Once
replaced, the clock restarts at its last known power-down time. The ION8800 logs
this as an event, which can be viewed from the Event Log on the meter’s front
panel (see “ALT mode default display screens” on page 170 for more information
on navigating to the Event Screen). The Event Log appears as the following screen:

DATE TIME EVENT CODE

12/08/2005 10:23:45 Internal Error ~ PWRMAN: 600
12/08/2005 10:42:03 Information 450

9:36:54  12/09/2005 Q1 ALT B 13m

2\ NOTE

Error codes are written at the time of power up, as indicated by their ION event timestamp

The meter records the following event codes after battery replacement on an
unpowered meter:

Error Code

Explanation Recommended Action

450

Seen only in combination

with @ '600’ event. Refer to 600, below.

600

Connect to the meter with ION software and synchronize the meter’s
internal clock.

See “Configuring the Meter Clock” on page 114 for more information.
Double-check battery installation (if required).

Loss of up to 10 minutes of
billing data and time late
by as much as 10 minutes

For details on resetting the meter’s internal clock, see “Configuring the Meter
Clock” on page 114.
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Demand

This chapter explains how to configure and view demand values on your meter.

In This Chapter
@ Infroduction ....... ..ol 118
& ConfiguringDemand .......... ... it 118
Using the Front Panel ................ .. ... ... .. oot 118
UsingION Setup ............ 118
Using Designer .......... ... ... i 119
Sliding Window Demand Module Settings .............................. 119
¢ Demand Forgiveness .............ciiiiiiiiiiiiiiiiiiiianan 120
Additional Information ............... ... oo oo oo 122
Configuring Demand Forgiveness ..................... .. ... ... 123
Using the FrontPanel ........... ... ... .. ... ... .. i .. 123
Using ION Setup ... 123
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Introduction

Demand is a measure of average power consumption over a fixed time interval.
Peak (or maximum) demand is the highest demand level recorded over the billing
period. Sliding Window Demand modules are configured to calculate the average
current demand and kW, kvar and kVA demand. The setup registers in the
demand modules define time intervals for demand calculations, setting the
sensitivity of the module’s operation.

See the ION Reference for more information about these modules.

Configuring Demand

Use the front panel or ION software to change your meter’s demand settings.

Using the Front Panel

1. Press and hold the Alt/Enter button for a few seconds to access the Setup
Menu.

2. Scroll using the Up or Down arrow buttons to select Demand Setup. Press the
Alt/Enter button to access the Demand Setup menu.

Menu Setting Description Range (Values) | Default
T SWD Subinterval Intervals used to compute your Sliding Window Demand values | 1 to 5 940 600
g SWD # Subintervals | The number of SWD periods in use 11015 3
3 SWD Pred Resp The speed of the predicted demand output 0,00 to 99,00 70

3. Scroll to the desired parameters using the Up or Down arrow buttons. Press the
Alt/Enter button to access each parameter.

Use the Up or Down buttons to edit the value of each parameter.

2\ NOTE

You may be prompted for the meter’s password the first time you attempt to change any values.

4. Select YES to confirm the change.

Using ION Setup

The Demand Setup Assistant helps you configure Sliding Window Demand. This
screen also contains two registers used for configuring Sliding Window Demand
while the meter is in TEST mode.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to the Demand folder.
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Setup Assistant E
= Template Roling Block. | [emand Forgivenessl
= Baszic Setup

E= Security This specifies the number of sub-intervals in use.
(2] Communications

== Demand

(27 Pulsing outputs
(Z] Logging 1

== PT/CT Conection Sub-interval Length 15 mirutes
5 Feven Derndlockat | 25
== Displays Test Sub-interval Length 15 minutes
= Werification

= Reports

E dit |

< Back | Mest » | Exit | Help |

3. Configure Rolling Block demand by selecting a register and clicking Edit.

Using Designer

Open your meter in Designer and navigate to the Demand Setup framework.
Right-click on a Sliding Window Demand module to edit.

For Time-of-Use Demand setup, navigate to the Time-of-Use Framework folder.

Sliding Window Demand Module Settings

Sliding Window Demand is often referred to as Rolling Block Demand. To
compute sliding window demand values, the Sliding Window Demand module
uses the sliding window averaging (or rolling interval) technique which divides
the demand interval into sub-intervals.

The demand is measured electronically based on the average load level over the
most recent set of sub-intervals. This method offers better response time than fixed
interval methods.

Setup Register | Function Default
The time, in seconds, in the sliding window demand .

Sub Intvl . varies
sub-interval.

#Sublntvls The number of sub-intervals in the sliding window. 3

The speed of Predicted Demand calculations; use higher values

Pred Resp for faster prediction (70 to 99 recommended). 70
Update Rate Defines the update rate of the SWinDemand output register Fn::r\?;ISUb-
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Demand Forgiveness

Demand Forgiveness is the time programmed to the meter during which demand
(and therefore peak demand) will not be calculated in the power restoration period
following a total power outage.

During power-up following a complete power outage, customer equipment
consumes a higher than normal amount of power. The Demand Forgiveness
feature lets a utility forgive the customer for peak demand penalties that may arise
from power-up following a power outage (should the outage exceed a user-
specified period of time).

Demand and Peak Demand Module Overview

Power utilities generally bill commercial customers based on their peak usage
levels, called peak demand (in kW), and energy consumption (in kWh). Demand is a
measure of average power consumption over a fixed time interval, typically 15
minutes. Peak (or maximum) demand is the highest demand level recorded over
the billing period. Sliding window/rolling block demand is one method of measuring
demand.

To compute sliding window demand values, the Sliding Window/Rolling Block
Demand module uses the sliding window averaging (or rolling interval) technique
which divides the demand interval into sub-intervals. The demand is measured
electronically based on the average load level over the most recent set of sub-
intervals.

In the following diagram, the Sliding Window/Rolling Block module labeled
“Demand” calculates demand from the power input by measuring and averaging
the power over a set interval. The demand value is then output to a Maximum
module labeled “Peak Demand” that records the highest demand value over time

(peak demand).
Power output Maximum
averaged value
Power DEMAND (Demand) PEAK DEMAND (Peak)
Sliding Window / Maximum module
| — Rolling Block module | — | —

For information on ION modules, refer to the online ION Reference.

Demand and Peak Demand Module Behavior During Demand Forgiveness

A peak demand value is the highest demand value since the last peak demand

reset. The Demand Forgiveness framework sets the Sliding Window/Rolling Block
module inputs to zero during a Demand Forgiveness period. This method allows
demand interval data to accurately reflect a complete interval that includes data:

¢ prior to an outage
¢ during the Demand Forgiveness period (zero values)

¢ after the Demand Forgiveness period
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2\ NOTE

During a Demand Forgiveness period, Demand module inputs are set to zero and do not reflect actual
demand. These values should not be used to calculate energy for billing purposes. Energy values are not
affected and will reflect actual energy consumption during the Demand Forgiveness period.

The settings listed below must be made for Demand Forgiveness functionality.
These settings can be accessed from ION Setup software; see “Using ION Setup”
on page 123.

& Minimum Outage Duration lets you specify the amount of time (in seconds) that
the power must be out before the Demand Forgiveness period begins.

& Demand Forgiveness Duration lets you specify the amount of time (in seconds)
that demand is forgiven (demand inputs are zero).

& Update Rate lets you define the update rate of the SWinDemand output register
and is set to EVERY SECOND by default for revenue-related demand modules.
With this setting, demand value measured is updated once per second.

& Outage Voltage (line-to-line average in unscaled meter units) lets you define a
voltage level that is considered an outage. This is set to 20 volts by default.
Kw

A

/

Power / -\

» Demand Forgiveness begins

A B

——> Demand Forgiveness ends

~" » Time
1:30 1:45 2:00
Demand Demand Demand
Interval #1 Interval #2 Interval #3

Power Outage

(A The specified amount of time that the power must be out before demand
is forgiven

(B) The specified amount of time that demand is delayed during the Demand
Forgiveness period

The preceding diagram shows an example of a meter that is set up for Demand
Forgiveness. The Sliding Window/Rolling Block Demand module is averaging
demand values at 15 minute intervals. During interval #1, the meter has a power
outage that lasts for 18 minutes. The power outage is defined by a system voltage
of 20 volts which has been specified in the Outage Voltage setting. The Minimum
Outage Duration setting is specified as 10 minutes, so this is amount of time that the
power must be out before demand can be forgiven. The Demand Forgiveness
Duration setting is specified as 1800 seconds (30 minutes), so for 30 minutes
following power restoration, demand inputs are zero. The power is restored
during interval #2, where the surge of power consumption during power-up is
included in the Demand Forgiveness period and has a value of zero.
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Additional Information

The following points are important to note:

¢ The following demand input values are zero for kQ, kW, kVA, and kvar during

the Demand Forgiveness period:

& Delivered

+ Received

& Delivered + received

+ Delivered — received

* Q1,02,Q3, Q4

If a new peak is set prior to a power outage, it will persist.

Even though demand is zero during the Demand Forgiveness period, a new
peak could be set if the demand was very high prior to the power outage or after
the Demand Forgiveness period ends.

Demand Forgiveness works for both single-phase and 3-phase powered meters.
Al ION modules in the Demand Forgiveness framework are fully locked.

If a Demand Forgiveness period is initiated and another power outage occurs
that is less than the time specified in the Minimum Outage Duration setting, the
Demand Forgiveness period continues. If a second outage is greater than the
time specified in the Minimum Outage Duration setting, the Demand Forgiveness
period restarts.

Both the power outage downtime and the Demand Forgiveness downtime are
stored within the Demand Forgiveness framework. The Store modules preserve
a timestamp that is viewable in Vista.

The Sliding Window/Rolling Block demand module Update Rate setup register
must be set to EVERY SECOND (default).

If Demand Forgiveness is enabled on a single-phase powered meter and there is
no power from the line, the meter assumes that this is an outage. When power is
applied from the line again, demand is forgiven for the specified time.

If Demand Forgiveness is enabled and the meter is unplugged for servicing or
other reasons, the Demand Forgiveness framework assumes there was an
outage and demand is forgiven for the specified time.

For meters where Demand Forgiveness is enabled at the factory (e.g. RMICAN
Canadian revenue meters), demand will not be measured when the meter is first
put into service. Instead demand is forgiven for the specified time.
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Configuring Demand Forgiveness

Demand Forgiveness is disabled by default. To enable Demand Forgiveness, use
ION Setup software to set the:

*

L 4
L 4
L 4

External Boolean module named “Demand Forgiveness Enable” to ENABLE.
minimum outage duration.
demand forgiveness duration.

outage voltage.

/\ CAUTION

If Demand Forgiveness is enabled, do not use demand values to calculate energy for billing purposes.

Using the Front Panel

You cannot enable or edit Demand Forgiveness settings via the front panel.

Using ION Setup

ION Setup version 1.1 and later supports the Demand Forgiveness feature:

1.
2.
3.

Connect to your meter in ION Setup, in Basic Mode, and open Setup Assistant.
Select the Demand setup screen and click on the Demand Forgiveness tab.
Select Demand Forgiveness Enable.

Click Edit (provide a password if requested) and select ON.

Select Min Outage Duration, and click Edit.

Select either Elapsed Interval Format or Numeric Bounded Format then enter the
amount of time that the power must be out before the Demand Forgiveness
period starts. Click OK.

¢ Elapsed Interval Format: Enter the amount of time in days, hours, minutes
and seconds.

& Numeric Bounded Format: Enter the amount of time in seconds.
Select Demand Forgiveness Duration and click Edit.

Select either Elasped Interval Format or Numeric Bounded Format from then enter
the amount of time that demand is forgiven (demand inputs are zero). Click
OK.

¢ Elapsed Interval Format: Enter the amount of time in days, hours, minutes
and seconds.

& Numeric Bounded Format: Enter the amount of time in seconds.
If required, select Outage Voltage and click Edit.

Type the minimum voltage (line-to-line average in unscaled meter units) that is
considered an outage (this is set to 20 volts by default but you can adjust this.)

© 2007 Schneider Electric. All rights reserved.
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Inputs / Outputs

This chapter provides information on the meter’s various inputs and outputs (1/O).

All T/O connections are made to the meter’s Essailec connector, located on the rear
of the meter. Refer to your Installation Guide for instructions on wiring inputs and
outputs and for the general meter 1/O specifications.

In This Chapter
@ Digital I/0 . ... i i e e e 126
SpecifyingaPortinan IONModule ................ ... . ... .. ... ..., 126
Using the Digital Outputs .. ........ ... ... i 128
Digital Output Modules ............... ... . ... ..l 128
Using the Digital Inputs ........... .. ... ... .. .. 131
Digital Input Modules ................. ... ... ... .. 131
¢ Configuring Inputsand Outputs . . . ... coviitiiiii it 132
Using the FrontPanel .......... ... ... .. ... ... ... ... ... . ... 132
Using ION Setup ... 132
Using Designer ........ ...t 132
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Digital 1/O

IONB8800 meters offer a variety of I/O combinations depending on ordering
options. The following options are available:

Ordering ..
Ovutputs Digital Inputs Com
Code tp g P
& 8 digital F A solid-stat tput
igital Form A solid-state outputs One RS-485 port on
A @ 1 Form C mechanical relay None .
) Essailec connector
# 4 Form C solid-state outputs
# 8 digital Form A solid-state outputs
B # 1 Form C mechanical relay 3 Low voltage | None
@ 4 Form C solid-state outputs
# 8 digital Form A solid-state outputs
C 1 Form C mechanical relay 3 High voltage | None
# 4 Form C solid-state outputs
@ 1 Form C mechanical relay o S
D # 4 Form C solid-state outputs 3 Low voltage ne.R -485 port on
Essailec connector
# IRIG-B
@ 1 Form C mechanical relay
E ® 4 Form C solid-state outputs 3 High voltage One. RS-485 port on
© IRIG-B Essailec connector

Two front panel infrared/LED outputs are also standard for all meters.

The digital inputs are ideal for monitoring status or counting pulses from external
dry contacts. Use the Form A outputs for performing end of interval pulsing, load
control and alarm annunciation, and the Form C solid-state outputs for load
switching applications. The infrared/LED outputs are used for energy pulsing
(watt-hours and var-hours).

Digital Input modules control the meter’s digital inputs. The outputs can be
controlled by Digital Output modules, Pulser modules, or Calibration Pulser
modules. All of these modules act as intermediaries between the hardware port
and the other modules in the meter; they define the characteristics of outgoing
signals or tell the meter how to interpret incoming signals.

Refer to the Digital and Analog I/O technical note for more information on digital
inputs and outputs.

Specifying a Port in an ION Module

Configure the Digital Output, Digital Input, Pulser, and Calibration Pulser
modules’ Port setup registers to specify which port handles the outgoing or
incoming signals. To assign a port to one of these modules, simply modify the Port
setup register by picking a port from the enumerated list. This can be done with
both Designer and ION Setup.

Be aware that the enumerated list only displays those ports that are not yet
assigned to another module. For example, the meter’s factory configuration makes
use of Digital Output DO4 (it is already assigned to Calibration Pulser module
“varh rec pulse -D4”).
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If you create a new Digital Output module and go to set its Port setup register, the
port DO4 will not appear in the list of available ports.

To make a port available, you must first locate the module controlling the port and
setits Port setup register to NOT USED (or delete the module entirely). The port now
appears in the enumerated list.

The following table describes the ports that can be configured (in the Digital
Output, Pulser, Digital Input, and Calibration Pulser modules) to handle digital
outgoing or incoming signals.

Output Port Names

Description

Port DO1 Digital (Form C Solid-State) Output port 1
Port D02 Digital (Form C Solid-State) Output port 2
Port DO3 Digital (Form C Solid-State) Output port 3
Port DO4 Digital (Form C Solid-State) Output port 4
Port DO5 Digital (Form A Solid-State) Output port 5
Port D06 Digital (Form A Solid-State) Output port 6
Port DO7 Digital (Form A Solid-State) Output port 7
Port DO8 Digital (Form A Solid-State) Output port 8
Port DO9 Digital (Form A Solid-State) Output port 9
Port DO10 Digital (Form A Solid-State) Output port 10
Port DO11 Digital (Form A Solid-State) Output port 11
Port D012 Digital (Form A Solid-State) Output port 12

kvarh Pulse/LED

pulser port/LED Output

kWh Pulse/LED

pulser port/LED Output

Alarm LED

LED Output

Indicator LED

LED Output

Input Port Names

Description

Port DI1 Digital (Status) Input port 1
Port DI2 Digital Input port 2
Port DI3 Digital Input port 3

© 2007 Schneider Electric. All rights reserved.
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Using the Digital Outputs

Use the meter’s digital outputs for hardware relay control or pulse counting
applications. For example, your meter’s digital outputs can provide on/off control
signals for capacitor banks, generators, and other equipment. The digital output
ports can also send out status signals or Wh pulses, if the receiving device
determines energy usage by counting pulses.

The meter can include a Form C mechanical relay, Form A solid-state digital
outputs and Form C solid-state digital relays. All digital outputs can deliver a
continuous signal or a pulse.

Contact Schneider Electric for complete information regarding relay applications.

/\ CAuUTION

The relay outputs of the meter should never be used for primary protection functions. Be sure that you are
familiar with the warnings at the beginning of this document, as well as those presented in your meter’s

Installation Guide.

These outputs can be controlled by Digital Output modules, Pulser modules, or
Calibration Pulser modules, depending on the application. For relay and contro],
use the Digital Output module. For pulsing applications, the Pulser and
Calibration Pulser modules are generally used.

2\ NOTE

Because mechanical relays have limited lifetimes, mechanical KYZ relays are typically not suitable for

energy pulsing applications. For energy pulsing applications, consider using solid-state outputs in KYZ
mode.

Digital Output Modules

Both the Form A and Form C relays can be controlled with Digital Output
modules, Pulser modules, or Calibration Pulser modules. By default, several
Digital Output modules are already created for this purpose. You can use these
modules, or create and configure other modules to control the output ports.

¢ Calibration Pulser modules allow you to generate high accuracy energy pulses
for calibration testing purposes. They integrate instantaneous power appearing
at their inputs.

¢ Digital Output modules accept Boolean inputs, and output a continuous signal
or pulses.

¢ Pulser modules convert instantaneous pulses to pulses or transitions.

Consult the ION Reference for more information about these ION modules.

Page 128 © 2007 Schneider Electric. All rights reserved.



ION8800 User Guide

Chapter 10 - Inputs / Outputs

Configure the settings of the controlling module to match your requirements. The
settings in these modules are as follows:

ION Module | Setup Registers Available Settings Creation Default Description
NotUsed
Port DO1
Port DO2
Port DO3
Port DO4
Port DO5
Port DO6
Port DO7
Port Port DO8 NotUsed The output hardware channel
Port DO9
Port DO10
.. Port DO11
Digital Output Port DO12
kvarh Pulse/LED
kWh Pulse/LED
Alarm LED
Indicator LED
PulseWidth 0 to 2000000 0 Pulse Width, in seconds
(0 for continuous pulse)
Polarity Inverting or Non-Inverting Non-Inverting Inverted or non-inverted output
Whether or not fo log status changes in
EvLog Mode Log On or Log Off Log Off the Event Log
Port As per Digital Output, above NotUsed The output hardware channel
I PulseWidth 0.020 to 2000000 1 Pulse width, in seconds
Pulser
OutputMode Pulse or KYZ Pulse Full pulse or KYZ (transition pulse)
Polarity Inverting or Non-Inverting Non-Inverting Inverted or non-inverted output
Port As per Digital Output, above Depends (see The output hardware channel
section below)
Pulse Width 0.010 to 1.000 0.05 Pulse Width, in seconds
Calibration Kt 0.01 to 1000000000 1.8% Watts per pulse
Pulser
Int Mode Forward, Reverse, Absolute, or Net Depgnds (see Integration modes that may be selected
section below)
OutputMode Pulse or KYZ Pulse Full pulse or KYZ (transition pulse)

* Value depends on meter’s nominal current option.

Ensure that the module’s Port setup register matches the meter’s output you want
to control. If the port you want to use does not appear in the Port setup register’s
list, it means that port is in use by another module. Edit the Port setup register of
the module using that port and set it to NOT USED — the port will then be available

to other modules.
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Calibration Pulsing Relays

Six digital outputs are factory configured for calibration pulsing and require no
further setup:

Calibration Module Setup Registers Creation Default

Port DO3 FormC
varh del pulse

Int Mode Forward

Port kvarh Pulse/LED
varh Pulse LED

Int Mode Absolute

Port DO4 FormC
varh rec pulse

Int Mode Reverse

Port DO1 FormC
Wh del pulse

Int Mode Forward

Port kWh Pulse/LED
Wh Pulse LED

Int Mode Absolute

Port DO2 FormC
Wh rec pulse

Int Mode Reverse

The Calibration Pulser module labeled varh rec pulse controls port 4. By default, the
module is linked to the kW del+rec output of the Arithmetic module labeled “del,
rec” in the Demand Framework. This Arithmetic module is linked to the MU
Power Meter module’s MU kW tot output. The port will output a pulse for every 1
Wh accumulated (in NORMAL or TEST mode); this is the same pulsing rate as the
middle LED on the front panel of the meter. See “Calibration Pulser Module
Settings” on page 136 for more information.

Alarm LED

Use the red (top) LED on the front panel of the meter for custom alarming
applications. It can be linked to a framework to provide event notification. Possible
applications include sag/swell alarming, setpoint annunciation, and tariff
notification. Like all outputs on the meter, this port can be controlled by a Digital
Output, Pulser, or Calibration Pulser module.

Indicator LED

Use the green (middle) LED on the front panel of the meter for custom alarming
applications. It can be linked to a framework to provide event notification. Possible
applications include sag/swell alarming, setpoint annunciation, and tariff
notification. Like all outputs on the meter, this port can be controlled by a Digital
Output, Pulser, or Calibration Pulser module.
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Using the Digital Inputs

Use the meter’s digital inputs for status monitoring or pulse counting applications.
Status monitoring can help you prevent equipment damage, improve
maintenance, or track security breaches. Some common status monitoring
applications are monitoring the closed/open positions of breakers, on/off status of
generators, armed/unarmed conditions in a building alarm system, and over/
under pressures of transformers.

Digital Input modules control the function of each status input, telling the meter
how to interpret incoming signals. Digital Input modules can be linked with other
modules for counting status changes.

Digital Input Modules

The meter provides three default Digital Input modules (labeled DI1 to DI3) for the
status inputs. Configure the settings of the controlling module to match your
requirements.

The settings in the Digital Input modules are as follows:

Setup Register Available Settings Creation Default Description
Input Mode Pulse, KYZ or A/C Pulse Complete pulse, KYZ transition pulse, or A/C input mode
EvLog Mode Log Off or Log On Log Off Whether or not to log status changes in the Event Log
Polarity Non-Inverting or Inverting Non-Inverting Non-inverted (or level) pulse
Debounce 0 to 65.525 0.000 Mechanical contact bounce, in seconds
NotUsed
Port Eg: B:; NotUsed The input hardware channel controlled
Port DI3

© 2007 Schneider Electric. All rights reserved.
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Configuring Inputs and Outputs

Use ION software to configure the meter’s I/O framework.

Using the Front Panel

You cannot configure I/O using the Front Panel.

Using ION Setup

The Inputs/Outputs Setup Assistant helps you configure the Calibration Pulser
modules. See the Energy Pulsing chapter for information on configuring the
Calibration Pulser modules in ION Setup.

You can configure all I/O related modules using Advanced Mode.
1. Connect to your meter, using Advanced Mode.

2. Navigate to the module you want to configure.

Using Designer

Open your meter in Designer and navigate to the Advanced Setup framework.
Click on the appropriate grouping object (Digital Inputs or Digital Outputs) and
right-click the module you want to edit.
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This chapter provides instructions for configuring energy pulsing on your meter.

In This Chapter
@ Infroduction ....... ..ol 134
o Configuring Energy Pulsing .. .......... ... ittt 134
Using the Front Panel ................ .. ... ... .. oot 134
UsingION Setup ............ 134
Using Designer .......... ... ... i 135
Pulser Module Settings ........... ... i 135
Calibration Pulser Module Settings ......................... ... ... ..., 136
Energy Pulsing with Infrared Portsand LEDs ........................... 137
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Introduction

Your meter uses Calibration Pulser modules and Pulser modules for energy
pulsing.

The Pulser module serves as an intermediary between other modules’ pulse
output registers (accepting them as pulse inputs) and a hardware output channel
on the device. These modules are capable of sending pulses or pulse transitions to
any hardware output channel.

The Calibration Pulser module is a highly accurate energy pulser used for
verifying calibration on meters employed in billing applications. This module type
serves as an intermediary between the power (kW, kvar or kVA) outputs of the
Power Meter module and a device’s hardware output channel.

See the ION Reference for more information on these modules.

Configuring Energy Pulsing

Use ION software to change your meter’s energy pulsing settings.

Using the Front Panel

You cannot configure Energy Pulsing using the front panel.

Using ION Setup

The Energy Pulsing Setup Assistant helps you configure the Calibration Pulser
modules.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to Pulsing Options > Energy Pulsing.

Setup Assistant E

= Template kiw/h Del | kb Hecl kwarh DeII kwarh Hecl
“= Basic Setup
Security Bllowes you to program kiwh Delivered pulsing via digital outputs.

CAP3 KL 1

CAP3 Pulse Width  0.05

CAP3 Outputbode K2

CAP3 Port Port DO [Formi)
wih del ovrld Pulzing normally

E dit |

< Back | Mext » Exit Help
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3. Click any of the tabs; each tab corresponds to a Calibration Pulser module.
Configure each module as necessary.

You can configure both the Calibration Pulser and Pulser modules using
Advanced Mode.

1. Connect to your meter, using Advanced Mode.

2. Click the module you want to configure.

Using Designer

Open your meter in Designer and navigate to the Energy Pulsing Setup
framework. Right-click a module to edit.

Pulser Module Settings

The Pulser module contains the following setup registers:

h .

Se P Function Default

Register

PulseWidth This register specifies the width of the output pulses (in 0.05
seconds).

OutputMode This register defines whether the output is a complete pulse or Pulse
a transition pulse (KYZ).

. This register specifies the polarity of a pulse output. It has no .

Polarity effect if OutoutMode is KYZ. Non-Inverting
This register specifies which hardware port the output appears

Port on. Only those hardware channels that are still available NotUsed
appear in this list.

2\ NOTE

For safety reasons, no hardware channel is pre-selected. To make use of these links, you must configure

the Pulser modules’ Port setup registers to the appropriate hardware port that receives the output.
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Calibration Pulser Module Settings

The meter contains four Calibration Pulser modules pre-configured for energy
pulsing;:

¢ Wh Del

& WhRec

& varh Del

& varh Rec

By default, the meter generates a pulse for every 1 Wh accumulated. This is the
same pulsing rate as the front panel LEDs (controlled by Calibration Pulser
modules labeled “varh Pulse LED” and Wh Pulse LED). Modify the pulsing rate

by changing the value of the Kt setup register of the Calibration Pulser module
controlling them (see below).

Other register defaults vary depending on the Calibration Pulser module.

The following setup registers are available in the Calibration Pulser module:

Setup Register | Function

This register specifies the width of the pulses sent to the hardware channel (in
Pulse Width seconds). The Calibration Pulser module maintains a minimum duty cycle of 50%
on the output pulse train.

The numeric bounded register defines how much energy (watt-hours) the module

Kt accumulates before a pulse is sent to the hardware channel.

Int Mode Specifies the modes of integration that may be selected.

OutputMode This register §peC|f|es whether the output is a complete pulse (Pulse) or a change
of state transition (KYZ).

Port This register specifies which hardware port the pulse/KYZ transition appears on.

Only those hardware channels that are still available appear in this list.
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Energy Pulsing with Infrared Ports and LEDs

Two LEDs on the front panel are preconfigured for energy pulsing. Matching
infrared outputs are located below each LED and pulse at the same rate.

The LED's pulse rate can be adjusted by modifying the Kt setup register in the
Calibration Pulser module. The value entered defines how much energy the
module accumulates before a pulse is sent to the hardware channel. The front
panel Wh and varh LEDs are factory set to the same pulse rate (1 Watt-hour).

LED varh pulse LED Wh pulse
indicator indicator

0._0\/0_0
(- o
Infrared varh Infrared Wh
pulser pulser

Wh - LED and varh - LED

The Wh-LED is controlled by a Calibration Pulser module that has its Source input
linked to the kW del+rec output of the Arithmetic module labeled “kW del, rec”.

Similarly, the varh — LED is controlled by a Calibration Pulser module that has its
Source input linked to the kvar del+rec output of the Arithmetic module labeled
“kovar del, rec”.

Customizing Energy Pulsing

Changing the value for the Kt setup register of the controlling Calibration Pulser
module lets you modify the pulsing rate of either channel. If you want to configure
the LED port for a different pulsing application, you must re-link the Source input
to the output register of a different instantaneous power quantity in one of the
Arithmetic modules. Ensure that the quantity you choose originates from the MU
(meter units) Power Meter module.
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Logging

Your meter includes data logging and event recording capabilities. Data and event
logs recorded by the meter are prioritized and stored onboard. This data is then
retrieved periodically by the ION Enterprise Log Inserter or another third party
application.

If you use ION Enterprise software, all retrieved data from your system is stored
in an ODBC-compliant database. The information in the database can be viewed
and analyzed using ION Enterprise software applications such as Vista (for
viewing) or Reporter (for organizing and presenting data).

For more information on Vista and Reporter, see the online ION Enterprise Help.

In This Chapter

@ Datalogging ......covviiiiiiiiiiiiiiiii ittt 140
Configuring Data Logging ................ ... i i 140
Default Logging Configuration -- ION8800A Meter ...................... 144
Viewing DataLogs ............. . . i 146
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Data Logging

Your meter ships with a comprehensive data-logging configuration that differs
depending on your meter type. The data recording frameworks contain Data
Recorder modules, Waveform Recorder modules (ION8800A meters only) and
Periodic Timer modules.

Data Recorder and Waveform Recorder modules are responsible for logging the
power system data, while Periodic Timer modules control the recording frequency
of the recorder modules to which they are linked.

To learn more about these modules, consult the ION Reference.

/\ CAuTION

Changing logging settings will reset logged values. Ensure that all important data has been recorded
before you make changes.

See “Default Logging Configuration -- ION8800A Meter” for more information
about the pre-configured Data Recorder modules for feature set A.

Configuring Data Logging

Use ION software to change your meter’s logging settings.

Using the Front Panel

You cannot configure Logging using the front panel.

Using ION Setup

Use the Setup Assistant to configure Memory and Revenue logging settings. Use
Advanced mode to configure the Energy Demand Log.

Memory

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Logging folder.

3. Select the Memory screen to re-allocate meter memory.
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Setup Assistant E

Status |

(27 Pulsing outputs

Willows pou to control the duration of the specified log.

| Allocated| Druration | Hecords| -

(23 Logging o
== Memory Fevenue Log
E Fevenue Log Event Log
(Z1 Reverue ‘wavetarms

= Power Quality EgyDimd Log

= Reports Hist low Log

Harm high Log ) FOdaps 640 —

\iog Memorny: 1
Edit |

244% 96 0days 3120
0.75% [RE) 3000
1A 20

95,0 day:

= Dlsp!ays. Harm mean Log X 3B 0day: 840
5 Verfication Hist high Log Fldaps 3360

FEldays 330 7|

0240Kb  InUse: 52.2% Available: 47.8%

< Back

| Mext » | Exit | Help |

4. Select the Log you want to configure and click Edit. You can change both the Log

Duration (days) and the Log Size (records). Notice how changing these

parameters affects the meter memory allocated to that log.

Revenue Log

Open ION Setup and connect to your meter, using Basic Mode.

In the Setup Assistant, navigate to the Logging folder.

Select the Revenue Log screen to configure Data Recorder #1 (the Revenue Log).

Setup Assistant E

Channels | Interval/D epth I

Willows pou to program the revenue log channels.
Pulzing outputs
(Z] Logging kiwdh del int
E= Memony 3 . '| n:IEeIirt
= ource 3 rec inl
- [iEmnelay Source 4 kvarh rec int
(] Revenue Source 5
== Power Quality Source B
= Displays Source 7
= Werification gsﬂ:g: g
= Reports Source 10:
Source 11
Fource 12: LI
Edt | unink |
< Back | Mext » | Exit | Help

4. Click the Channels tab to edit, link and unlink revenue parameters.

5. Click the Interval/Depth tab to edit the interval and duration of the revenue log.
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EnergyDemand Log

1. Open ION Setup and connect to your meter in Advanced mode.

2. Navigate to Data Rec Modules folder and double-click on the EgyDmd Log

Screen.
Group 1 - ION8800 : EgyDmd Log [ %]

Inpuits | Setup Hegistersl Clutput Hegistersl

Parameters: Source 1:
Source 2
Source 3
Source 4:
Source &
Source B
Source 7
Source B
Source 3
Source 10:
Source 11
Source 12:
Source 13
Source 14:
Source 15:
Source 16:
Enable:

kiwih rec

kiwih del-rec
kevarh del
kevarh rec
kyvarh delrec
kiah delrec
ki 2d delrec
kevar zd delrec
kWA sd delrec
FF zign mean

EquDmd Log Enbl

[

|«|  Insert.. |

Delete |
Edi... |

Send

Cancel |

Help |

3. Configure the Inputs, Setup Registers and Output Registers as required.

Changing the parameters that are logged

The meter’s factory configuration logs a comprehensive set of energy, power and
harmonics parameters. You cannot change which parameters are logged by

configuring a setup register. If you are comfortable editing module links, you can
change the logged parameters by linking the output registers you want logged to

the inputs of an Data Recorder module.

2\ NOTE

Adding or deleting a log’s parameters is an advanced procedure, as it requires changes to the links
between modules; use Designer (refer to the Designer section of the online /ON Enferprise Help) or ION

Setup.

Changing waveform recording (if supported)

The Waveform Recorder modules do not require changes to their default settings.
If you want to change the format of the recorded waveforms, refer to the
Waveform Recorder module description in the ION Reference.
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Default logging capacity -- ION8800A meter

The table below summarizes the default recording depths and recording intervals
of the various Data recorders and Waveform recorders in the ION8800A meter.

2\ NOTE

Default logging depth is set differently for 5 MEG on-board memory (“one-month”) and 10 MEG (“three-
month”) option meters. See the table below.

Da:uknti;::der Log Name Pepth Interval

5 MEG 10 MEG
1 Revenue Log 3360 (35 days) | 9120 (95 days) | 900 seconds (15 minutes)
9 Loss Log 3360 (35 days) | 3360 (35 days) | 900 seconds (15 minutes)
3,4,5 Historic Logs (3 data recorders) 3360 (35 days) | 3360 (35 days) | 900 seconds (15 minutes)
7,8 Harmonics Logs (2 data recorders) 840 (35 days) 840 (35 days) 3600 seconds (1 hour)
N/A Waveform recording (6 data recorders) 30 50 Triggered on demand
10 Report Generator Log (EgyDmd Log) 3360 (35 days) | 9120 (95 days) | 900 seconds (15 minutes)
2 Dip/Swell Log 100 3000 Triggered on demand
6 Transient Log 100 3000 Triggered on demand
N/A Event Log (Event Log Controller module) 100 500 Triggered on demand
e FEI\II\ISSOO] 16600Lc())rgdse|('i2n2gdocF:T?or:C:nr§'()arS) Varies! Vories! Daily, weekdy, 10 minufes, ...

! See the Power Quality: ION Meters and EN50160 technical note for more details.

Changing the log depths

Change the value in the Data Recorder’s Depth setup register to increase the
number of records stored in the recorder. The RecordMode setup register controls
how the Data Recorder will overwrite old records; refer to the Data Recorder
module description in the ION Reference before changing this setup register.

Changing the frequency of logging

The five Periodic Timer modules that control the frequency of different data
recording are as follows:

¢ “Revenue Log Trg” controls the frequency of the logging of revenue values
¢ “Loss Log Trg” controls the frequency of Loss Compensation Data logging

¢ “EgyDmd Log Trg” controls the frequency of logging for the Energy and
Demand Log (this log is used for generating reports using Reporter)

¢ “Hist Log Trg” controls the frequency of Historic Data logging

¢ “Harm Log Trg” controls the frequency of Harmonics logging
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/\ CautioN

Programming your meter to write any data recorder at continuous intervals lower than 20 seconds (heavy

logging configuration) may cause loss of data in the event of a power failure. Use of an uninterruptible
power supply (UPS) is recommended for such heavy logging configurations if data needs to be available
after a power cycle.

Change the value in the Period setup register to change the frequency of data
logging (Period values are specified in seconds).

Default Logging Configuration -- ION8800A Meter

The following sections describe each Data Recorder and the parameters it logs.

Revenue Log

The Revenue Log is configured for use with UTS MV-90 billing software. The
default values logged by the Revenue Log are as follows:

Parameter Description

kWh del int Interval kWh delivered
kWh rec int Interval kWh received
kvarh del int Interval kvarh delivered
kvarh rec int Interval kvarh received

Hist Mean Log

Ull 12 mean | avg mean
Ull 23 mean | 4 mean
Ull 31 mean kW tot mean

Ull avg mean

kvar tot mean

U unbal mean

kVA tot mean

11 mean PF lag mean
12 mean PF lead mean
I3 mean Freq mean

Historic Data Logging

Three data recorders are used to record standard power system quantities, such as
phase current, phase voltage and power factor. These recorders are labeled Hist
Mean Log, Hist High Log, and Hist Low Log. By default, they log the following ION
output register values:

Hist High Log Hist Low Log

Ull 12 high | avg high Ull 12 low | avg low
Ull 23 high | 4 high Ull 23 low | 4 low

Ull 31 high kW tot high Ull 31 low kW tot low
Ull avg high kvar tot high Ull avg low kvar tot low
U unbal high kVA tot high U unbal low kVA tot low
11 high PF lag high 11 low PF lag low
12 high PF lead high 12 low PF lead low
13 high Freq high 13 low Freq low
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Loss Log

The Loss Log recorder is configured to record loss values. By default, it logs the
following ION parameters:

Parameter Description

MU 1T 2h int Phase 1 interval current squared hours
MU 12~ 2h int Phase 2 interval current squared hours
MU 137 2h int Phase 3 interval current squared hours

MU UIl 12 2h int

Phase 1 interval voltage Line-to-Line squared hours

MU Ull 23 2h int

Phase 2 interval voltage Line-to-Line squared hours

MU Ull 31" 2h int

Phase 3 interval voltage Line-to-Line squared hours

Harmonics Logging

Two recorders provide various harmonics logs, including K-factor and Total
Harmonics Distortion (THD). These recorders are labeled Harm Mean Log and
Harm High Log. By default, they log the following ION output register values:

ION Enterprise Reporting

Harm Mean Log Harm High Log

U1 THD mean 1T K Fac mean U1 THD high 11 K Fac high
U2 THD mean 12 K Fac mean U2 THD high 12 K Fac high
U3 THD mean 13 K Fac mean U3 THD high 13 K Fac high
IT THD mean 11 THD high

12 THD mean 12 THD high

I3 THD mean I3 THD high

One recorder is configured to provide power system data for the Reporter
software. This recorder is labeled Egy Dmd Log. If any input links to this module
are changed, Reporter is able to create reports from the device’s logs. If you use
Reporter, do not change the parameters that are logged in the Eqy Dmd Log.

Dip/Swell and Transient Logging

The meter logs the following ION output register values:

Dip/Swell Log

DistDur DistU2Engy DistU1Engy DistU3Engy
DistU1Min DistU3Min DistU2Min DistNominal
DistU1Max DistU3Max DistU2Max SwellLim
DistUTAvg DistU3Avg DistU2Avg Saglim
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Transient Log

TranU1Dur TranNominal TranU2Max PT Sec
TranU1Max Threshold TranU3Dur CT Prim
TranU2Dur PT Prim TranU3Max CT Sec

EN50160 Compliance Logging (EN50160 ordering option only)

By default, 22 Data Recorders are used for logging EN50160 compliance

parameters.

Data Recorder

EN50160 Component Logged

Data Recorder

EN50160 Component Logged

EN50160 Frq/Mg

Power Frequency and Supply Magnitude

EN50160 Uunbal

Voltage Unbalance

EN50160 Flicker

Flicker

EN50160 Hrm Vit

EN50160 VIt Dp1

EN50160 Vit Dp2

EN50160 VIt Dp3

EN50160 VIt Dp4

EN50160 VIt Dp5

Supply Voltage Dips

EN50160 Ihm Vit

Harmonics (up to 40th)

EN50160 MSignal

Mains Signalling Voltage

EN50160 Prm-f/V

EN50160 Prm-Flk

EN50160 Prm-VDp

EN50160 Intrp

Short/Long Interruptions

EN50160 Prm-VIr

EN50160 Ovrvlt1

EN50160 Ovrvlt2

EN50160 Ovrvlt3

Temporary Overvoltages

EN50160 Prm-OV

EN50160 PrmHrm1

EN50160 PrmHrm2

Parameter data

These data recorders are disabled by
default (see below).

The meter logs EN50160 counter data for present and previous observation
periods. EN50160 events are also logged. EN50160 parameter data logging (from
seven “Prm” data recorders) is disabled by default. The EN50160 Parameter
Logging enable is accessible in the default Power Quality Vista diagram.

For more information about EN50160 data logging, refer to the Power Quality: ION
Meters and EN50160 technical note.

Viewing Data Logs

See the Report chapter for more information. You can also view Data Logs using

ION Setup.

1. Open your meter in ION Setup, using Basic Mode.

2. Navigate to View > Data Screens > Data Recorders. The following logs are
available for viewing:

¢ Average Harmonics

¢ Energy & Demand
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Event Logging

Historic Average, Historic Highs, Historic Lows
Maximum Harmonics

Revenue Log

Sags & Swells

Transformer Losses

* 6 6 6 o o

Transients (if supported)

Events produced by a meter’s various ION modules are prioritized and grouped
to facilitate custom logging. Each event is assigned a priority group number based
on its type and severity.

ION Event Priority Groups

Some event groups are preset with a Priority Number as shown in the table below.
You can also define your own priority number for some modules. Priority
numbers from 128-191 appear in the global event log viewer in ION Enterprise
software. Priority numbers from 192-255 are logged, initiate a beep and cause the
window to flash. You can customize these responses to display messages or
perform netsend messages, for example.

Event Group Description Priority Number

Reset Module reset or re-synchronized 5

Module setup changes (setup register
Setup Change changes, label changes, input handle 10
changes)

Inputs of certain modules change value (ie,

Input Register Change input to And/Or module changes) 15

I/O State Change I/O state changes (ie, relay closes) 20

Information Module Produces important user 25
information

Warning Module produces a warning 30

EN50160 Event

(EN50160 ordering option only) An EN50160 Counter (N7 or Ny) increases | 50

Failure A failure has occurred 255

Setpoint condition goes Active or Inactive
Setpoint (ie, Sag/Swell module detects a
disturbance)

programmable
via module setup

The Event Log Controller module allows you to set a priority cutoff for event
logging. Any events with a priority number greater than the cutoff value are
logged and events with lower priorities are discarded. Refer to the individual
module descriptions and the Event Log Controller module description in the
ION Reference for more details.
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External ION Events

Some events are not produced by a specific module. These events are generated
internally by the meter. Their associated priority levels are shown in the table
below.

Event Group | Description Priority Number

Factory initialize performed

Firmware or memory upgrade performed

Meter power-up or power-down

Warning Internal modem not responding or modem recovered 30

Battery low

Telnet or serial terminal locked out

Security disabled or enabled

Failure Communications fail to allocate required memory 255

Displaying Events

View Events in the following locations:

Application Menu / Screen Navigation

Front Panel Event Log ALT Display Mode > Events Screen

ION Setup Event Display Mode > Data Recorders folder > Event
Vista Meter Events System & Logs tab > Meter Events object
WebMeter N/A N/A
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Logging and Recording Capacity

The meter provides both data and event logs. The amount of memory required to
store these logs depends on the number of parameters being logged and the
frequency with which these parameters are logged.

The following equation can help determine the amount of memory required to
store data and event logs:

each record consumes (in Bytes) = [(number of parameters * 5) + §]

The meter can also perform waveform recording. It can simultaneously capture
events on all channels to a maximum of 96 cycles each.

To calculate the waveform memory usage use the following formula:

waveform memory usage (in Bytes) = [2*(number of samples per cycle) + 10]*
(number of cycles in waveform) + 30

2\ NOTE

Round up to the next kilobyte after each of the above calculations.
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This chapter provides instructions for configuring PT/CT correction, transformer
line loss compensation (TLC), and time of use (TOU).

In This Chapter

@ PT/CTCOMmection .. vvotit ettt ittt ettt eeeeeneeenneennns 152
Configuring PT/CT Correction ................ciiiiiiiiiiiie... 152

# Transformer Line Loss Compensation (TLC) ............ccovvvvennn.. 154
Configuring TLC ... .. 154

@ TimeofUse ...ttt 157
Configuring Timeof Use .......... .. ... i, 157
Time Of Use Module Settings .............. ... ..o, 158
Creating a New Time Of Use Schedule .............................. ... 159
Displaying Timeof Use ........... .. ... . i 159

© 2007 Schneider Electric. All rights reserved.

Page 151



Chapter 13 - Revenue ION8800 User Guide

PT/CT Correction

The primary application for PT/CT correction is to apply correction factors for ratio
errors and phase angle errors to instrument transformers. Instrument transformer
correction reduces or eliminates the need to replace transformers in installations
where high-accuracy is required.

Configuring PT/CT Correction
PT/CT Correction (the Instr Xformer module in the meter’s firmware) can be

configured in the ION8800 via ION software.

Using the Front Panel

You cannot configure PT/CT Correction using the front panel.

Using ION Setup

In the following ION Setup example, the PT/CT Correction Setup Assistant allows
you to configure the Instr Xformer modules on the ION meters.

1. Open ION Setup and connect to your meter, in Basic Mode.
2. Open the Revenue folder in the Setup Assistant and click PT/CT Correction.
3. Select the Active Correction and click Edit.

Setup Assistant E

= Template ITC Cormection |

= Baszic Setup
E= Security This specifies the type of active instrument transformer corection
prezently in uze.

(2] Communications

== Demand
(27 Inputs/Outputs
(Z] Logging A rection  Mone
(C] Revenue

= PTACT Comection
Transformer Loss

= Time of Use
F Edit I Analyze |

Power Cuality
< Back | Mest » | Exit | Help |

Al

Dizplays
= Werification
= Reports

The Transformer Correction wizard guides you through configuration.

4. Select the Voltage Inputs check box to turn on voltage (PT) correction and the
Current Inputs check box to turn on current (CT) correction.
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Transformer Correction Setup E

— Specify amount of provided information

Enter the number of test points that ratio cormection factors and phaze angle
errors will be specified for each input. Also enter the nominal secondary
voltage/current rating for each type of instrument transformer.

v Waltage Inputs

vife vz wafe Mominal [120 =
va [

ENN N Nominal |5 |
(7O R A Norinal |5 |

< Back I Mest » I Cancel | Help

todify each test point by entering the point az a percentage of nominal with its
comesponding ratio correction factor and phase eror [in minutes).

Test Point [%] | Ratio Corection Phase Emor Edit |

Enter the number of test points for each (four maximum) and the nominal
voltage/current. Click Next to proceed.

¥1 Correction E

10% 1.000 a
Test Paint [3%]:
R atio Carrectior: W
Fhase Eror [minutes]: IU—
7% Cancel | Help |
< Back | Mest » | Cancel | Help

On the Correction screen, select a U1 Test Point and click Edit. Enter the Test
Point Info into the dialog box and click OK. Click Next.

Repeat previous step for each voltage and current phase. Click Next to finish.

The Instrument Transformer Correction module is a core module; there is an ITC
module for each current input (I1, 12, I3, I4, I5) and for each voltage input to the
meter (U1, U2, U3, U4). Note that the correction affects only the 1-second values in
the Power Meter module. No high-speed, harmonics, or waveform values are
affected by the correction. For more information, see the ITC (Instr Xformer)
module description in the online ION Reference.
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Transformer Line Loss Compensation (TLC)

Configuring TLC

Transformer Loss Compensation is used when a meter’s actual location is different
from the electrical location where change of ownership occurs; for example, where
meters are connected on the low-voltage side of power transformers when the
ownership change occurs on the high-side of the transformer. This physical
separation between meter and actual billing point results in measurable losses.
Compensating for this loss - Loss Compensation - is the means of correcting this
meter reading. Losses may be added to or subtracted from the meter registration.

Meters are usually installed on the low-voltage side of a transformer because it is
more cost-effective. There are also cases where change of ownership may occur
halfway along a transmission line where it is impractical to install a meter. In this
case, power metering must again be compensated.

/\ CAuTION

Due to the variation in installations, advanced knowledge of power systems and connection methods is
required before transformer loss compensation can be properly implemented. Data parameters should
only be programmed by qualified personnel that have appropriate training and experience with

Transformer Loss Compensation calculations.

See the Transformer / Line Loss Calculations technical note for more information.

Use ION software to change your meter’s TLC settings.

Using the Front Panel

You cannot configure Transformer Line Loss Compensation using the front panel.

Using ION Setup

The Revenue Setup Assistant helps you configure TLC. The Transformer Loss
screen allows you to enable/disable TLC, choose which method you prefer (1 or 2)
and configure TLC settings.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to Revenue > Transformer Loss.
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3. First, enable TLC by selecting Loss Comp Enble and clicking the Edit button.

Setup Assistant E

= Template
= Baszic Setup
== Security

(2] Communications

(27 Inputs/Outputs
(C1 Loaging
(Z] Revenue

== Time of Use
= Power Quality
Dizplays
= Werification
= Reports

FT/CT Cormection
Transformer Loss

Methad Selection | Test Sheetl #Loss Eonstantsl

Thiz specifies if meter readings are loss compensated or nat.

.omp Enble Comp Disabled
Comp Mthod Slct - Method 1

\ E dit |

< Back | Mest » | Exit | Help |

4. Select Comp Enabled from the drop-down list and click OK.

5. Next choose the TLC method you want to use by selecting Comp Mthod Slct and
clicking the Edit button.

Select Method 1 to use the Test Sheet method and Method 2 to use the %Loss
Constants method.

6. Finally, click the tab of the TLC method you chose in the previous step and
configure the settings for that method.

Using Vista

1. Open your meter in Vista.

2. Select the System & Logs tab.
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3. Click Loss Compensation. The following window appears:

Click here to enable Loss

Choose either the Test
Compensation calculations

Sheet or %Loss Constants
compensation method

Loss Compensation

{click radio buttons to ch

Loss Compen

on Mode Loss Compensation Method
™ Lass CpApensation  Disabled 2 & Method 1 ("Test Sheet" method)

0ss Compensation  Enabled Q —) ¢ Method 2 ("%Loss Constants” method)

ote:

If Loss Compensation is enabled, all billing parametars
are compensated,

{click boxes, enter value and then press the Enter key)

Supply Sida Lina  Load Sida Lina

4z

Indicate if meter location is supply side
or load side

Indicate if meter location is transformer
side or not

’ p Instrument Transfarmer Meter Information
Mot Transformer Transformer ratios (prim/sec)
Side Side Rated Meter Voltage:
Instrument Transformer information PT ratio: 142 Class Meter
PT ratios Primary VIl rated; o | CT ratios # Stator Elements
CT ratio:
Transformer Losses
kWA rated: lIl Paeoar TremsTmmer Raiio Copper Loss Compensation Iron Loss Compensation
LiWFe (no-load): lIl i lIl (% Enabled (% Enabled
LwCu ffull-laad): [ o ] [ o ] " Disabled " Disabled
Supply Side Line Loss ine Loss
LT L wowFe: [ o ]
Line Length: o Line Lengeh o — [ | %lyFe [ o |
Resistance/Unit Length: 1] Resistance/Un ! 1] . lIl .
Reactance/Unit Length: 1] Reactance/Unit L
These are the true instrument transformer
ratios. Normally they coincide with the
Power Meter module’s setup.
4. Configure your values as required.
See the Transformer / Line Loss Calculations technical note for more details on this
feature.
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Time of Use

The Time of Use module may only be important if you are using the meter in a
billing application (i.e. you are a power provider), as the module contains the
meter’s seasonal rate schedules. Typically, power consumers do not require Time

Of Use configuration.

See the ION Reference for more information on the Time of Use module.

Configuring Time of Use

Use ION software to change your meter’s Time of Use settings.

Using the Front Panel

You cannot configure Time of Use using the front panel.

Using ION Setup

The Time of Use Setup Assistant helps you configure the Time of Use module.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. Inthe Setup Assistant, navigate to Revenue > Time of Use.

Setup Assistant E

= Template Time of Use |

= Baszic Setup
E= Security Wllowes you to program the meter time of use information.

(2] Communications

== Demand
(27 Inputs/Outputs
(C1 Loaging
(Z] Revenue
E= PT/CT Comection

Transformer Loss
== Time of Use

= Power Quality

= Displays

= Werification

= Reports

\Edit | send |

< Back | Mest » | Exit | Help |

3. Select a Time of Use program from the list (in this example, Sample TOU) and

click Edit.

4. Follow the Time of Use Wizard to configure your program. Click Send to save

the TOU program on your meter.

Using Designer

Open your meter in Designer and navigate to the Time-of-Use Setup Framework.

Right-click the Time of Use module to edit.
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Time Of Use Module Settings

The Time of Use module’s setup registers define your seasons’ start and end dates,
the day types where your rates may differ, and the rate schedules for each season’s
day types. The module compares the meter’s internal clock with the season, day,
and time of day settings in these registers, and changes its output registers to
reflect the current state of these settings.

Seasonal Settings

The Time of Use module supports up to four separate seasons. Each season’s start
and end dates are set into the appropriate Season setup register.

2\ NOTE

Ensure that there is no date overlapping when defining seasons and that every day of the year is covered

by your seasons. If there are gaps between seasons, the module returns an error and will not function.

If your rates do not change between seasons, you do not need to configure the
Season setup registers — Season 1 is the default, and all Season 1 rates are in effect
all year.

If you have different seasons, enter their start and end dates into the appropriate
setup registers. If your season is active on the same dates every year, you only need
to enter a single range of dates in the appropriate Season setup register. If the active
dates are different each year (for example, Season 3 becomes active every first
Monday in August), the start dates must be individually specified for each year.

The Time of Use module is partially configured at the factory. Check the setup
registers to ensure that the settings match your Time of Use schedules.

Setup Register

Function

Season 1- 4

These setup registers define the dates for each active season. When a season is active, the Time of Use module will use the
applicable rate schedules.

Season 1 - 4
Weekday Rates

These setup registers specify seasonal weekday rates.

Season 1 - 4
Weekend Rates

These setup registers specify seasonal weekend rates.

Season 1 - 4
Alt 1 Rates

These setup registers specify a season's daily rates during the days specified in the Alt 1 Days setup register.

Season 1 - 4
Alt 2 Rates

These setup registers specify a season's daily rates during the days specified in the Alt 2 Days setup register.

Season 1 - 4
Holiday Rates

These setup registers specify a season's daily rates during the days specified in the Holidays setup register.

Weekdays

This register defines the days of the week for all seasons. The rates in the Season (1, 2, 3, or 4) Weekday Rates setup
registers are used on these days.

Weekends

This register defines the weekend days for all seasons. The rates in the Season (1, 2, 3, or 4) Weekend Rates setup registers
are used on these days.
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Setup Register | Function

This register defines a set of alternative dates for all seasons. These dates generally have different rates from weekdays,

registers are used on these days.

Alt 1 Days weekends, or holidays.
Alt 2 Days This register is similar in function to Alt 1T Days, but contains a different set of dates.
Holidays This register defines the holidays for all seasons. The rates defined in the Season (1, 2, 3, or 4) Holiday Rates setup

Self Read Days

This setup register defines the dates and times that the Self Read output register will pulse. If no time is entered in this
register, the Self Read output register will pulse on the date specified at 12:00 AM.

Creating a New Time Of Use Schedule

You can create a new TOU schedule using the TOU Program Manager in Designer.
The TOU Program Manager is a self-documented, graphical wizard. Select TOU
Program Manager from the Options menu to open the program.

& Time OFf Use Program Manager

Create, copy or delete your TOU Programs using the file management features below,

Welcome to the Time OF Use Program Manager

or click the Edit button to modify an existing Program.

1= B3

TOU Programs

I r— File Management

Mew Program

zave the change.

Usze these buttons

i Make a Mew TOU Program i

to create, copy,
or delete a TOU
prograr.

Copy Selected TOL Program |

Delete Selected TOU Frogram |

—Edit a TOU Program

Select a program from the list on the left, then click the
Edit button below to launch the TOU Pragram E ditor.

Edit [Launch Program Editor]

r— Renaming TOU Program:

“fou can rename a TOU Program by selecting it, then clicking itz name a second time. The
program's name appears in a thin black box - type in & new name, then press the Enter key to

Cloze |

Displaying Time of Use

View Time of Use values in the following locations:

Application Menu Navigation
Active TOU Rate, Active TOU
Front Panel Season and TOU Energy by ALT displays
Rate screens
ION Setup N/A N/A
Vista Time of Use Screen Revenue tab > Time of use object
WebMeter N/A N/A
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Power Quality

This chapter explains how to configure your meter’s power quality functionality.

In This Chapter
@ Infroduction ....... ..ol 162
& ConfiguringPower Quality .............ccoiiiiiiiiiiiiiin... 162
Using the Front Panel ................ .. ... ... .. oot 162
UsingION Setup ............ 162
Using Designer .......... ... ... i 163
Sag/Swell Module Settings ...ttt 163
Transient Module Settings (ION8800A only) .................. ... ... ... 164
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Introduction

The power quality capabilities of your meter depend on the feature set ordered:

%:':’ Sag/Swell | EN50160/IEC 61000-4-30 \T/x\‘::f::;?:pmre
C X

B X X

A X X X

Power quality configuration is provided by a number of modules, including the
Sag/Swell module, the Transient module, and the Mains Signalling Evaluation
modules. Your meter may not have all these modules.

See the ION Reference for more information on these modules.

Configuring Power Quality

Use ION software to change your meter’s power quality settings.

Using the Front Panel

You cannot configure Power Quality from the front panel.

Using ION Setup

The Power Quality Setup Assistant helps you configure the various power quality

modules.

1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to the Power Quality folder.

= Template Sag/Swell | Transient |
= Basic Setup .
= Secuity |Tlis is the nominal voltage used for sag/swell and transient

"= Displays
E= Verification
= Repoits

detection.

Swell limit %

Sag limit %
Sag/Swell depth
‘wWaveforn depth
‘waveform format

Edit |

106
g8
50
128x14
Post Event Cycles 7

9120

<Back |

Hext »

Exit
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3. Select the Sag/Swell tab to set sag and swell limits, configure sag/swell
waveform recorder settings and, most importantly, record your system’s
nominal voltage.

4. Select the Transient tab to configure various settings such as voltage deviation
threshold and transient waveform recorder depth and frequency.

2\ NOTE

The meter features dual waveform capture: Sags are recorded at 32 samples x 54 cycles. Transients
waveform capture at 256 samples x 7 cycles.

Using Designer

Open your meter in Designer and navigate to the Power Quality Setup framework.
Right-click a module to edit.

Sag/Swell Module Settings

The Sag/Swell module monitors voltage waveforms for sags and swells (i.e. ITI
[CBEMA] Type 2 and Type 3 disturbances). It then reports each disturbance’s
magnitude and duration. The Sag/Swell module can also detect sub-disturbances
during a Sag/Swell event. Settings are as follows:

Setup Register | Function Default
. This is the magnitude above which a voltage deviation is considered
Swell Lim . 106
a swell (percentage of the nominal voltage).
Sag Lim This is the magnitude below which a voltage deviation is considered 88

a sag (percentage of the nominal voltage).

This is the amount a voltage signal must change during a
Change Crit disturbance to be considered a new sub-disturbance (percentage of | 10
the nominal voltage).

This is the nominal power system voltage (used for all Power Quality

Nom Volts functions).

The priority assigned to Sag/Swell and Transient module events

(0 to 255, 255 is highest). 200

EvPriority

! The primary power system voltage is sometimes different than the PT Primary setup register value (i.e.
when the PT Primary is used to indicate winding ratio rather than primary voltage).

Besides NomVolts, the only setup registers that you may need to change in the Sag/
Swell module are Swell Lim and Sag Lim. Most applications are served by the
default values entered into these registers. The Change Crit and EvPriority setup
registers do not need to be changed for normal operation.

2\ NOTE

If the Sag/Swell module’s Nom Volts setup register is set to zero, all Sag/Swell module functions are
disabled. Nom Voltsis typically set when the meter is put into service. If Nom Volts has not been set, enter
a value for your system’s nominal voltage (i.e. 120, 277, or 347). The value you enter will also be used

by the Transient module.
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Transient Module Settings (ION8800A only)

The Transient module monitors voltage waveforms for transient activity (i.e. ITI
[CBEMA] Type 1 disturbances). The Threshold setup register defines what voltage
disturbance magnitude should be considered as transient activity. Threshold is
interpreted as a percentage of the nominal system voltage, plus 100. For example,
if you want transients recorded when voltage deviates from nominal by 20%, enter
120 into the Threshold setup register.

Setup Register | Function Default
Threshold This is 1_he magnitude at which a voltage deviation is considered 125
a transient.
. The priority assigned to Sag/Swell and Transient module events
EvPriority (0 fo 255, 255 is highest). 200
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This chapter explains the available front panel displays. It also includes
procedures for customizing displays using ION software.

In This Chapter

@ Infroduction ....... ..ol 166

# Configuring Front Panel Displays . . ..............coiiiiiiienn... 166
Using the Front Panel ................. ... . ... .. oot 166
UsingION Setup ... 166
Using Designer .......... ... ... i 167

o Default Front Panel Display Screens .. .............coviiiiena... 170
NORM mode display screens ..............coooiiiiiiiiiiii. .. 170
ALT mode default display screens ................. ... ... ... ..... 170
TEST mode default display screens ................. ... .. ... ... 173
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Introduction

The ION8800 ships with preconfigured display screens designed to suit the data

needs of most users. Different types of screens are available depending upon the

meter’s current mode of operation (see “Modes of Operation” on page 29 for more
information).

Front panel displays can also be customized on your meter to show virtually any
measurement or calculation. For example, you could do one or all of the following:
¢ change displayed parameters, such as from Ull to Uln or Ull12 to Uln1

¢ adjust character size to be different on each screen

¢ change data display settings such as backlight timeout, automatic display
scrolling, parameter update rate and display mode

Use ION software to customize your front panel display screens.

Configuring Front Panel Displays

Using the Front Panel

Display settings are located in the Display Setup menu. See “Display Setup Menu”
on page 35 for more information.

Using ION Setup

1. Open ION Setup and connect to your meter, in Basic Mode.

2. In the Setup Assistant, navigate to Displays > Front Panel. Select Displays and
click Edit.

ION Setup will upload your meter’s display information to the Display Editor.
This may take a few moments.

Setup Assistant E
= Template Front Panel |
= Baszic Setup

= Security Alloves you to program the available front panel displays.

[Z] Communications

= Clock Dizplay Editor I
== Demand
(2 Inputs/Outputs _ ove Up
s i —'l
[C] Revenue . Elock Paak Mave Down
Power Cuality Pk Dmd Rset Cnt
= Displays O-Metering Hew |
= Verification Disk Simulator
= Reports All Segments
Delete |
Bename |
Edit
INormaI Mode j

< Back

Alternate Mode
Test Mode

|
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3. Edit, rename, delete or rearrange displays as desired.

4. Ifyou choose to edit or create a new display, the Display Editor wizard contains
three steps for creating or editing display screens.

Dizplay setup E
—Step 1: Select Screen Type
Screen Type: ITwo Paramneter j
—Step 2 Select P

Farameters: Edit |
kKiwih rec
Unlink |

—Step 3 Select Digit Display Propertie:

Resolution: I 12345678504

L L

Last Digit: I Truncate

Found
Send I Cancel | Help |

¢ Choose the screen type.
¢ Select the parameters available for your chosen screen type.

¢ Select your display qualities, including digit resolution and truncated or
rounded last digits.

5. Click Send to save the changes in the meter.

Using Designer

/\ CauTioN

Before you reconfigure or delete a framework, you should make a copy. This ensures that you can restore
the framework without having to reinitialize the factory configuration.

To remove a data display screen:

1. Launch Designer and navigate to the Display Setup framework.
2. Select the Display module responsible for the screen.

3. Press Delete. This also deletes all links to that particular Display module. Click
OK to save your changes.

If the display screen you are deleting is part of the automatic scrolling cycle, you
should reconfigure the links from the Scroll module’s Trigger outputs to the
remaining Display modules so that the following considerations hold true:

¢ The first Display module in the scrolling cycle is linked to the Trigger 1 output of
the Scroll module.

¢ The last Display module in the scrolling cycle (module ) is linked to the
Trigger n output of the Scroll module. For example, if your scrolling cycle
consists of 5 screens, then Trigger 5 should be linked to the fifth module in the
cycle.
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¢ The Wraparound setup register of the Scroll module designates the last trigger
output (Trigger nn). Expanding on the previous example, since Trigger 5 is the last
trigger, the Scroll module’s Wraparound setup register would have a value of 5.

To add a new display screen

1. Create a Display module.

2. Define the modules characteristics (display format) by adjusting its setup
registers.

3. Link any required data to the Source inputs of the Display module.

If you want your new screen to appear in the automatic scrolling cycle, then you
must link the Show input of the Display module to a Trigger output of a Scroll
module.

To create a Disk Simulator screen

1. Create a new Display module and set the type as Disk Simulator.

2. Connect the new Display module’s first input to the Calibration Pulser module’s
Disk Position output that you want to monitor for its pulsing interval.

3. Toinclude the newly added screen to the ALT screen list, connect the Display
module’s Show1 and Show?2 inputs to the Scroll module’s last available Trigger
outputs in ALT SCROLL UP and ALT SCROLL DOWN (respectively).

You can determine the last available Trigger by right-clicking on the output to
discover the Triggers’ owners.

4. Increase the Scroll module’s Wraparound setup register by 1 to include the new
screen.

5. Configure the remaining display settings according to your needs.

Although the Disk Simulator display is intended to show the disk behavior of
mechanical watt-hour meters, this feature can be used to monitor any accumulated
meter quantity over the time. To do this, connect the Display module’s first input
to the meter quantity and connect the second input to the maximum value that you
expect the displayed quantity to be bounded by (this could be any ION output
register or an External Numeric module register). In this case, (i.e. the Display
module is not connected to a Calibration Pulser module) the Disk Simulator
revolves from left to right.

2\ NOTE

The inputs to the Disk Simulator display are always positive. If the value exceeds the maximum scale value

assigned in the second input, then nothing is displayed except labels and the disk rectangle.
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To configure leading zeros

The leading zeros and decimal point in a numeric display can be configured with
the Display module setup register Screen Resolution. For example, the number
276.3443 can be configured in one of the following ways, depending on the
selection you make in the Screen Resolution setup register:

Value Screen Resolution
276.3443 1.x = 276.3

1234.xx = 0276.34

123456. = 000276.

If the Screen Resolution setup register is set to DEFAULT, the Display module will
use the resolutions defined in the Display Options module.

Last digit mode

The Display module setup register Last Digit Mode lets you specify whether to
truncate or round a value’s last digit. Numbers round up at 5 or greater, and round
down from 1 to 4. A truncated value disposes of any digits after the number of
decimal places that you have specified in the Screen Resolution setup register.

Screen Resolution = 1.xxx

Value = 276.35192
Rounded = 276.352
Truncated = 276.351

To configure parameter titles

The parameter value on a display screen is the value of an output connected to the
Display module Source input register. By default, the displayed parameter’s title is
the name of the output connected to the Source input. The Display module Source
Title setup register lets you change the default to a title that better describes your
system. For example, if “KWh Net” is linked to the first Source input, you could
change its display name by setting Source 1 Title to “KWh Net West.” A maximum
of 25 characters is permitted.

See “Changing TEST Mode Timeout” on page 179 for information on configuring
TEST mode display timeouts.
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Default Front Panel Display Screens

Each mode of operation (NORM, ALT and TEST) has its own display screens,
providing various power system data and meter properties screens.

NORM mode display screens

The factory-configured ION8800 meter scrolls through nine displays detailed
below. If the settings in the Scroll module have not been altered, each screen is
displayed for five seconds if no front panel buttons are pressed.

Display scrolling is suspended when a front panel button is pressed, and you can
manually scroll through the display screens using the Up or Down arrow buttons.
If required, see “Front Panel Features” on page 22 for more instructions on using
the front panel buttons.

kWh: This screen displays kWh delivered and received values.
kvarh: This screen displays kvarh delivered and received values.

kVAh: This screen displays kVAh delivered and received values.

* & o o

Peak Demand Delivered: This screen displays the maximum delivered kW
value and a timestamp of when the peak occurred. This value is a Sliding
Window (Rolling Block) demand calculation.

¢ Peak Demand Received: This screen displays the maximum received kW value
and a timestamp of when the peak occurred. This value is a Sliding Window
(Rolling Block) demand calculation.

¢ Peak Demand Reset Count: This screen displays a count of the number of
Demand Resets executed as well as a timestamp of the latest Peak Demand
Reset.

¢ Q Metering: This screen displays approximated varh measurements, one phase
(60 degrees) behind the normal watthour connection (90° - 330° and 150° - 270°).

¢ kWh Disk Simulator: This display simulates the behavior of a mechanical watt-
hour meter indicating power received or delivered by the direction of the pulse.

¢ All Segments: This is a screen test where a black screen showing all segments
(all pixels on) indicates that the display is functioning properly.

ALT mode default display screens

The meter scrolls through the following ALT mode displays. If the settings in the
Scroll module have not been altered, each screen is displayed for five seconds if no
front panel buttons are pressed (until five minutes have elapsed).

Viewing ALT display modes
1. Press the Alt/Enter button once to toggle between the NORM and ALT display
modes.

2. Pressthe Up or Down arrow buttons to scroll back or forth through the displays.

If no buttons are pressed the meter reverts back to NORM mode after five minutes.
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2\ NOTE

These screens vary depending on the firmware version on the meter and custom display configuration.

& Name Plate 1: The Name Plate 1 screen contains this information:

o Owner + Firmware revision of the
+ TAGI from Factory meter
module + Battery life indicator
+ TAG2 from Factory + Meter serial number
module

TAGI and TAG2 typically identify the meter’s user and installed location. The
Owner and TAG registers are configurable with ION software. See “How to
TAG Your Meter” on page 40.

¢ Name Plate 2: This screen displays the following information for the current
Sliding Window (Rolling Block) demand settings:

Length of the demand period multiplied
CONFIG by the number of demand periods
UPDATE Length of the demand period
SYNC Clock synchronization source
MAX (kW) Maximum kW Demand]

1 The MAX (kW) value is a maximum allowable demand level based on installed transformer
configurations and nominal voltages and currents.

¢ Event Log: The Event Log screen displays up to four of the most recent, highest
priority events (priority 255 only). The date, a timestamp, an event description,
and an event code are provided for each event displayed.

If more than four high priority events have been recorded, then the Event Log
screen will indicate additional logs exist. See “Data Logging” on page 140 for
more information.

¢ Vector Diagram: This screen shows phasors and numeric values for each phase
current and phase voltage measurement.

¢ Instantaneous Voltage: This screen shows average voltage, line-to-neutral and/
or line-to-line voltage (depending on the meter’s service type).

¢ Instantaneous Current: This screen shows the phase current and average
current values.

¢ Instantaneous Power: This screen shows kW total, kvar total, KVA total and
signed Power Factor total values.

¢ Instantaneous Demand: This screen shows kW delivered and received from the
Sliding Window (Rolling Block) demand calculation.

¢ Availability: This screen shows the availability of power in a “number of nines”
measurement, over a pre-set period of time.

¢ Voltage Harmonics: These screens show histograms of the per phase voltage
harmonic content.
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¢ Current Harmonics: These screens show histograms of the per phase current
harmonic content.

& Instantaneous Demand: This screen shows kW delivered and received.

ALT mode Time of Use (TOU) display screens

Some ALT mode display screens are factory-configured to show Time of Use
(TOU) data. The measurements displayed originate from frameworks of ION
modules that are linked to a TOU module. For details about the TOU module, refer
to the ION Reference.

By default, all demand values result from Sliding Window (Rolling Block)
calculations.

¢ Active TOU Rate: This screen shows which of the valid TOU billing rates is
active.

¢ Active TOU Season: This screen shows which TOU billing season is currently
active.

¢ TOU Energy by Rate: This screen shows kWh delivered values for each TOU
rate.

¢ kW Peak Demand: These screens display the maximum kW delivered value for
each TOU rate. These values result from Sliding Window (Rolling Block)
demand calculations.

¢ Past Billing Energy: This screen displays the kWh delivered values for each
TOU rate in the previous billing period.

2\ NOTE

PB = Past (Previous) Billing period. A billing period is the time between two consecutive meter readings
for billing purposes by a utility.

¢ Past Billing Peak Demand: These screens display the maximum kW delivered
value for each TOU rate in the previous billing period. These values result from
Sliding Window (Rolling Block) demand calculations.

¢ Past Season Energy: This screen displays the kWh delivered for each TOU rate
in the previous billing season. These values result from Sliding Window (Rolling
Block) demand calculations.

2\ NOTE

PS = Past (Previous) Season. Billing Seasons are defined in the TOU module description in the
ION Reference.

¢ Past Season Peak Demand: These screens display the maximum kW delivered
for each TOU rate in the previous billing season.

¢ Past Billing/Season Energy: These screens display the kWh delivered and
received values in the previous billing period and billing season.

¢ Past Bill/ Season Pk Demand: These screens show the maximum kW sd
received values in the previous billing period and billing season. These values
result from a Sliding Window (Rolling Block) demand calculation.

Page 172
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¢ Past Billing/Season Energy: These screens display the kvarh delivered and
received values in the previous billing period and billing season.

¢ Past Bill/Season Pk Demand: These screens display the kvar delivered and
received values in the previous billing period and billing season. These values
result from a Sliding Window (Rolling Block) demand calculation.

¢ Past Billing/Season Energy: These screens display the kVAh delivered and
received values in the previous billing period and billing season.

¢ Past Bill/Season Pk Demand: These screens display the kVA delivered and
received values in the previous billing period and billing season. These values
result from a Sliding Window (Rolling Block) demand calculation.

¢ Frequency: This screen displays frequency information.

TEST mode default display screens

Values shown in the TEST mode display screens represent different accumulators
than those shown in NORM mode (although they perform some of the same basic
measurements). The TEST mode display values are for calibration checking
purposes; they will only accumulate while the meter is in TEST mode.

Viewing TEST mode

There are two ways to switch the meter into TEST mode depending on the type of
meter you have:

¢ Unlocked meter: You can use ION software or press a button on the front panel;
see “Switching to TEST Mode” on page 176.

¢ Hardware-locked meter: You must open the cover on the meter and press the
TEST Mode button.

Once the meter is in TEST mode the front panel cycles through the three TEST
mode display screens summarized below.

& KkWh Test: This screen shows TEST mode kWh delivered and received values.

& kvarh/KVAh Test: This screen shows TEST mode kvarh/KVAh delivered and
received values.

¢ Instantaneous Demand Test: This screen shows TEST mode kW delivered and
received values. Both quantities are produced from a Sliding Window (Rolling
Block) demand calculation. This value is reset if the Demand Reset button is
pressed while the device is in TEST mode.
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This chapter describes your meter’s TEST mode and explains how to switch from
Normal mode to TEST mode.

In This Chapter
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Introduction

TEST mode is typically used for verifying meter calibration and function. The
meter is usually reading data from a test power supply while these functions are
performed.

Several things to note about TEST mode:

¢ All of the billing quantities that are recorded when the meter is in normal mode
will stop accumulating when the meter is switched to TEST mode — the data is
sent to special TEST mode registers instead.

¢ The values accumulated in these test registers are displayed on the front panel
and in ION software.

¢ The regular normal mode billing registers are unaffected while the meter is in
TEST mode; accumulation of this data continues as soon as you exit TEST mode.

¢ All test registers are reset to zero when you exit TEST mode.

2\ NOTE

The meter will always return to NORM mode when you exit TEST mode, even if you entered TEST mode
from ALT mode.

Switching to TEST Mode

Place the meter into TEST mode using the front panel, ION Setup or Vista. The
meter’s front panel informs you when the meter is in TEST mode with a special
display screen.

2, NOTE

You cannot place a hardware-locked meter in TEST mode using ION software. The meter must be placed
in TEST mode by pressing the TEST Mode button.

Using the Front Panel (all meters)

The TEST Mode button on the meter is located under the meter cover. You must
open the cover to access it. For sealed meters, you must first break the cover seal.

Once you have opened the outer cover, press the TEST Mode button.

Using ION Setup (unlocked meter)
1. Open ION Setup and connect to your meter, using Basic Mode.

2. In the Setup Assistant, navigate to the Verification folder.

Page 176
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Setup Assistant E
= Template Werification |W’iring|
= Baszic Setup

E= Security Wlloves you to verify meter readings. NOTE: The Test Mode
parameters Test Sub-Intervalz and Test Sub-Interval Length must be
changed in Mormal Maode under the Demand setup screen;
however, the Loss Mode is only accessible in Test Mode.

(2] Communications

(27 Inputs/Outputs
(Z] Logging |N0rmal Mode

(Z] Revenue

== Power Quality
= Displays

= Werification
= Reports

Dizplay |

< Back | Mest » | Exit | Help |

3. Select TEST Mode from the Verification tab. If meter security is enabled, you are
prompted for password. A dialog box informs you the meter is in TEST mode.

4. Click OK. The TEST Mode screen appears and test values are displayed.

Energy | Rolling Demand I Wolts, Amps and Powerl
~ kKwh kwarh
Delivered 0.000 Delivered 0.000
Feceived 0.000 Received 0.000
~ kish
Delivered 0.000
Feceived 0.000
Test Reset |
LCloze | Save bz | Help |

Click on the tabs to perform various test-related tasks. See the ION Setup online
help for more information.

5. Click Close. A dialog box informs you the meter is back in Normal Mode.

Using ION Setup (hardware-locked meter)

You cannot place a hardware-locked meter in TEST mode using ION software. The
meter must be placed in TEST mode via the front panel. See “Switching to TEST
Mode” on page 176.
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Using Vista (unlocked meter)
1. Open the meter in Vista.

2. Navigate to System & Logs and click the Setup & Control button in the Setup &
Controls section (bottom of screen).

3. Select the TEST Mode radio button. You are prompted for the ION Enterprise
user password. If standard meter security is enabled, you are also prompted for
the meter password.

Setup & Controls Use the back button on the toolbar to get back to the main diagram

click radio buttons to change state

Meter Mode: Peak Dernand Reset &l

= Mormal Mode

& Test Mode
Please wait at least two
(2) minutes for Master
Reset to finish
LED Pulser Mode:

Master Reset

|

= OMin Mormal Mode
¢ OFF in Morrmal Mode
Device Diagnostic Self Test Alarm & Controls
Revenue Measurement Scaling: Status

= Secondary Units ("1:1")
¢ Primary Units ("CT,PT scaling") Acknowledge

Clear

@ @ |o

Use this screen to reset the registers that accumulate real-time data.

4. To view test mode values, navigate to the Revenue tab and click the Test Mode
Values button.

Uze the back button on the toolbar to get back to the main diagram

TEST MODE
Energy
kiwih kwarh kiidsh
del 1} a 1}
rec 1] o o
del+rec 1} 1}
Sliding Window Demand Thermal Demand
| kw W
del Mot Available a del
rec Mot Available 0 rec
del peak Mot Available 1} del peak
rec peak Mot Available 0 rec peak

For more information, see the Vista section of the online ION Enterprise Help.
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Changing TEST

Using Vista (hardware-locked meter)

You cannot place a hardware-locked meter in TEST mode using ION software. The
meter must be placed in TEST mode via the front panel. See “Switching to TEST
Mode” on page 176.

Mode Timeout

If no front panel buttons are pressed, the meter will exit TEST mode after 30
minutes (unless the default TEST mode timeout value has been changed). While in
TEST mode, the value on the bottom right of the status bar indicates the amount of
time before TEST mode times out. The meter always returns to NORM mode when
the TEST mode time-out elapses.

kWh del T The timer indicates
6-63 the 'ItEST mode t
kWhrec T timeout.

000 |

9:36:54  12/09/2005 123 Q1 TEST EXIT:28:17 4

The time-out value resets to 30 minutes each time you press any front panel button.
By default the TEST mode time-out value is 30 minutes.

You can change the value of the TEST mode time-out using ION software or the
front panel.

Using the front panel

Follow these steps if you are using the front panel:

2\ NOTE

On hardware-lockable meters, the meter must be unlocked to change the TEST mode timeout.

1. Enter the Setup menu by holding down the Alt/Enter button.

2. Scroll through the menu items, highlight DISPLAY OPTIONS, and press the Alt/
Enter button.

3. Scroll down and highlight the TEST MODE TO menu item. Press Alt/Enter.

4. The current TEST mode time-out is displayed. Use the Up or Down arrow
buttons to change the value of the highlighted digit. Press the Up or Down
arrow button to move the cursor left or right. When you have entered the new
value of the TEST mode time-out in seconds, press the Alt/Enter button.

5. Select YES to confirm the change and enter the meter password, if required.
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Using ION Setup

Follow these steps if you are using ION Setup:
1. Start ION Setup and connect to the desired meter in Advanced Mode.

2. Locate the Display Options module in the module list and double-click to open
the module.

3. In the Display Options module, click the Setup Registers tab and double-click
the TEST Mode Timeout setup register. The default setting for this setup register
is 1800 seconds (30 minutes).

4. Choose from numeric bounded format or elapsed interval format and set the
TEST mode timeout to the desired time.

5. Click Send to transmit the changes to the meter.

Using Designer

Follow these steps if you are using Designer:

1. Open Designer and connect to the desired meter.

2. Double-click the Display Setup folder on the Designer screen.

3. Right-click on the Display Options module to access the setup registers. Select
the TEST Mode Timeout setup register and click Modify to edit.

4. Set the TEST mode timeout to the desired time. You can choose from a numeric
bounded format or an elapsed interval format.

5. Click OK to send the changes to the meter.

TEST Mode Default Display Screens

Values shown in the TEST mode display screens represent different accumulators
than those shown in NORM mode (although they perform some of the same basic
measurements). The TEST mode display values are for calibration checking
purposes; they will only accumulate while the meter is in TEST mode.

Once the meter is in TEST mode the front panel cycles through three TEST mode
display screens:

& KkWh TEST: This screen shows TEST mode kWh delivered and received values.

& kvarh/KVAh TEST: This screen shows TEST mode kvarh/KVAh delivered and
received values.

¢ Instantaneous Demand TEST: These screens show TEST mode kW delivered
and received values. Both quantities are produced from a Sliding Window
(Rolling Block) demand calculation. This value is reset if the Demand Reset
switch is turned while the device is in TEST mode.
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TEST mode LED energy pulsing

Below the display screen are two pairs of energy pulsing LEDs and infrared
outputs. The LEDs and IR outputs are factory-configured to pulse while the meter
is in TEST mode.

[} [}

; Transformer Connected
varh infrared varh Wh % O
varl Current TX| | A
ouipu’r o O O Voitage X[ Ji[_Jv
Pulsing Contact Outputs E)Ulsmg CI:OEtTd
tputs labe
. [ il
Wh infrared e Pt indicates the default
output pulsing rate

The energy pulsing LEDs provide an ideal interface for calibration checking
instruments. The Pulsing Contact Outputs label (bottom right corner) indicates the
factory-configured pulsing rate. (You can change the energy pulsing frequency
with ION software.)

See “TEST Mode” on page 30 for basic information about TEST mode.
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This chapter provides instructions for performing various meter resets.

In This Chapter
¢ PerformingaReset .........coiuiiiiiiiiinnnnrnnrnannannnn 184
Using the FrontPanel ........... ... ... ... ... ... ... ... ....... 184
Performing a Master Reset from the frontpanel ...................... 184
Parameters affected by aMaster Reset ........................... ... 184
Performing a Demand Reset from the front panel .................... 185
Parameters affected by a Demand Reset . ............................ 185
Using ION Setup ... e 186
Using Vista ... 186
Master Resets and Hardware-locked Meters ............................. 187
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Performing a Reset

Resets allow you to clear various accumulated parameters stored by the meter.

2\ NOTE

Be sure to record any important data before performing a meter reset.

Using the Front Panel

The following resets can be performed via the front panel:
¢ Master Reset:

« deletes most accumulated values and all derived revenue measurements
from the meter.

& Demand Reset:

+ resets the peak demand values logged in the meter.

Performing a Master Reset from the front panel

The Master Reset button is recessed to avoid accidental activation. You must open
the meter’s cover before you can perform a Master Reset:

1. Remove the cover seal (if applicable).

2. Open the meter cover.

3. Using a pencil or similar instrument, press the Master Reset button.

4

At the confirmation screen, select YES to confirm the reset.

/\ CauTioN

After initiating a Master Reset, wait until the “Master Reset Completed” message appears on the front

panel (or about two minutes, depending on your firmware). This allows the meter to completely reset
parameters. This is especially important if you are powering down the meter after a Master Reset.

Parameters affected by a Master Reset

The Master Reset button resets many of the device's measurements and logs. The
following parameters are reset to zero:

¢ Energy and Demand

¢ Peak Demand

¢ Loss Calculation

¢ Power Quality disturbance counters
4

Time of Use
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The following are cleared:
¢ EventLog

& All Data Recorders

& All Waveform Recorders

Performing a Demand Reset from the front panel

The Demand Reset button is recessed to avoid accidental activation. You must
open the meter’s cover before you can perform a Demand Reset:

1. Remove the cover seal (if applicable).

2. Open the meter cover.

3. Using a pencil or similar instrument, press the Demand Reset button.
4

At the confirmation screen, select YES to confirm the reset.

Parameters affected by a Demand Reset

The mode that the meter is in (for example, NORM mode or TEST mode) defines
the values that will be reset. The following parameters are reset to zero:

& Revenue Peak Demand

& TOU Peak Demand

¢ TOU Previous Billing Peak Demand
& Test Peak Demand

If PkDemandMnMaxReset is enabled, all long term Min\Max values will also be
reset. Note that this setting is disabled by default.

Demand Lockout Timeout

The setup register labeled Demand Lockout Timeout (Display Options module) sets
the minimum time allowed between consecutive demand resets; the meter ignores
any attempts to reset the demand outside the bounds of the register.

The default value for the Demand Lockout timeout is 25 days. For more
information on the Demand Lockout Timeout setup register, refer to “Display

Setup Menu” on page 35.

For more details on the Display Options module, see the ION Reference.
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Using ION Setup

Using Vista

2\ NOTE

You can only perform a Master Reset via software on unlocked meters.

1. Open ION Setup and connect to your meter, using Basic Mode.
2. In the Setup Assistant, navigate to the Verification folder.
3. On the Verification tab, select Normal Mode and click Display.

Setup Assistant E

= Template Werification |W’iring|
= Baszic Setup

E= Security Wlloves you to verify meter readings. NOTE: The Test Mode
parameters Test Sub-Intervalz and Test Sub-Interval Length must be
changed in Mormal Maode under the Demand setup screen;
however, the Loss Mode is only accessible in Test Mode.

(2] Communications

(21 Pulsing outputs
(21 Logaing Mormal Mode
== PT/CT Canrection Test Mode

== Dizplayz
= Werification
= Reports

\ Display |

< Back | Mest » | Exit | Help |

4. Click the various tabs to access the following reset buttons:
¢ Energy - Master Reset
¢ Rolling Demand - Peak Reset and Master Reset
& Volts, Amps and Power - Master Reset
¢ Power Quality - # of 9s Reset and Master Reset

Open your meter in Vista. You can perform several resets from within Vista:

Performing a Peak Demand Reset or Master Reset

2\ NOTE

You can only perform a Master Reset via software on unlocked meters.

1. Select the System & Logs tab and click the Setup & Control object.
2. Click the appropriate reset button to perform the reset.

Page 186

© 2007 Schneider Electric. All rights reserved.



ION8800 User Guide Chapter 17 - Resets

Performing a Min/Max Reset

1. Select the Volts & Amps tab and click the Long-term Min/Max Measurements
object.

2. Select the Min/Max Reset button to perform the reset.

Performing a Sag/Swell, Availability or Harmonics Min/Max Reset
1. Select the Power Quality tab and click the Setup and Control object.

2. Select the appropriate reset button to perform the reset.

Master Resets and Hardware-locked Meters

A master reset on a hardware-locked meter can only be performed from the front
panel. The meter must also be unlocked first.

TEST Mode
In TEST mode, the following screen is displayed:

MASTER RESET

UNAVAILABLE IN
TEST MODE

19:36:54 12/09/2005 Q1 TEST EXIT: 29:55
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Alerting

ION alerts can send an email or contact a modem, fax, pager, or software in the
event of a user-specified condition. These conditions can be changes in relays or

power quality problems including surges, sags, swells and outages.

This chapter explains how to configure your meter network for alerting.

In This Chapter
@ Alerfing ...ttt i i e e e it 190
Alerting ION Software via the Alarm Server ............................ 190
Remote Site Event Notification ................................. ... 191
Alerting via an AlphanumericPager ........................ ... ... ... 192
Alerting viaa NumericPager ............ ... ... . ... o il 192
Alerting viaEmail .......... ... o 193
Alert Module Settings ........... ... . i 194
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Alerting

The meter’s Alert module sends an alert whenever its Trigger input is pulsed. You
can connect this input to any module that produces a pulse output. You can use
modules that monitor alarm conditions such as changes in relay status and power
quality problems. For example, you can connect the Trigger input to the output of
a Setpoint module, thereby allowing the Alert module to send an alert when the
setpoint condition is reached.

The Alert module delivers these types of alerts:

Numeric Pager

Alphanumeric Pager

PEGASYS (for alerts to PEGASYS software)

ION Alert (for alerts to ION Enterprise software)

ASCII

® 6 6 6 o o

Email
Selection between modes is made with the Alert module Alert Type setup register.

The Alert module requires access to either a modem (a dedicated modem or a
modem handling a loop of meters) or Ethernet (for the Alert module email
capabilities).

Your meter has no pre-configured Alert framework. For detailed information
about alerting, including how to build a framework to send alerts, refer to the Alert
module description in the ION Reference.

Alerting ION Software via the Alarm Server

2\ NOTE

For detailed information about sending alerts to ION Enterprise software via the Alarm Server, refer to

the ION Enterprise online help.

The Alarm Server can run on any ION software Primary or Secondary server. The
server computer should have a dedicated phone line and modem. Modems at
remote sites are programmed to dial the server's phone number when a priority
event occurs. The Alarm Server monitors the phone line and waits for the remote
sites to annunciate events. The most common use of the Alarm Server is to handle
Remote Site Event Notification.
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Remote Site Event Notification

Server or LAN o
Dedicated @ Remote Site informs the

Alarm Server that a priorit
Alarm Server.exe Alarm Server - P 4
message exists

;&2 |
sla.— o [
I

| |
| |
| |
EL i I —— I
Qo e Paw S/ |
Connection : %0 ;.’
Manager
bg | =4

Server
computer

/1

Communication
0 Services contact the
Any Dialout modem site and
Modem retrieve priority

The Alarm Server uses a series of command line arguments to specify the actions
it takes when a priority event is reported. These commands must be entered on the
computer that is running the Alarm Server utility. Typically the Alarm Server is
configured to launch the Connection Manager, which dials up the remote site and
retrieves the logs from the devices. The Alarm Server can also be configured to
launch other applications. A series of parameter switches are added to the
command line to pass information about the event to the application that is
launched.

Configuring the Alarm Server

The Alarm Server should have a dedicated phone line, modem, and COM port to
avoid conflicts with other ION software components.

The modem used by the Alarm Server is not configured with the Management
Console; only dialout modems are configured in the Management Console. The
Alarm Server's executable, alarmsrv.exe, is typically located in ...\ION
Enterprise\SYSTEM\bin. You can run the Alarm Server in a console window or
you can define a shortcut icon that includes all of the command line arguments
required.

Alarm Server Command Line Arguments

Refer to the ION Meter Alerts technical note for a list of command lines that the
Alarm Server supports.
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Alerting via an Alphanumeric Pager
2\ Note

For detailed information about building a framework for alerting via an alphanumeric pager, refer to the

Alert module description in the online /ON Reference.

If an alphanumeric pager is specified as the destination address in the Alert
module, then an alphanumeric paging service receives a message from the ION
meter.

Once the modem at the paging service is contacted, the ION meter transmits the
following information:

¢ Pager identification number

¢ Local time (year, month, date, hours, minutes, seconds)

& Remote site identification

& Priority of the alarm

¢ Alert message, with text strings and realtime measured values

To include a module’s Source input in the message, reference the message string by
using the form %Vn, where n is the Source input number. In the following Message

register setting, the kWtot value is %V1. The string includes Source input 1 which
would be the kWtot register from the Power Meter module.

The destination register contains your modem access number for the paging
service provider and is what is dialed out first. The Pager Num register is the pager
access number that is provided by your paging company.

Alerting via a Numeric Pager

2\ NOTE

For detailed information about building a framework for alerting via a numeric pager, refer to the Alert
module description in the online /ON Reference.

If a numeric pager is specified as the destination address in the Alert module, then
a numeric paging service receives a message from the ION meter. Due to the
inherent limitations in numeric paging, the ION meter can only send a string of
digits to the paging service. The Alert module then waits a specified time,
determined by the number of commas inserted after the phone number in the Pager
Num setup register. Finally, the Alert module dials the message digital string.

There are two important factors to consider when setting up the Alert module for
numeric paging. First, be sure to specify a string of digits that is meaningful to you,
such as a coded message. Second, be aware that there is no way to ensure that a
message has been successfully transmitted; there may be a busy signal or an
answering machine may take the call. The number of commas you add to your dial
string is an estimate of how long the modem at the remote site waits before it
transmits numbers.
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Alerting via Email

2\ NOTE

For detailed information about setting up your network and building a framework for meter email
(MeterM@il) alerts, refer to the MeterM@il Internal Email Client Feature technical note.

If email is specified as the destination address in the Alert module then an email
message is sent to any address you specify. You can only set one email address per
Alert module. If you want to send an alert to more than one email address you
need to create a group — be sure your email server is configured to send email to
groups via SMTP (Simple Message Transport Protocol).

Follow the steps below to send email alerts from your meter. Note that your meter
must support emailing (with a correctly configured SMTP server):

1. Open your meter in Designer.

1. Create an Alert module.

2. Configure these Alert module setup registers as indicated:

Message — type in the text of the alert to be emailed.

Destination — type in the destination email address.

Type — select Email.

Com Port — select Ethernet.

Location — type in a custom string; this is optional, and appears in the email.

* 6 6 6 o o

Email From — type in an address that you want the email to appear from. This
may be required as some SMTP servers only accept emails from valid
addresses.

3. Create an ION module that will produce a pulse on its Trigger output when the
exceptional event occurs (for example, a Setpoint module pulses its Trigger
output when the setpoint condition is reached).

4. Link the Alert module’s Trigger input to the Trigger output of the module created
in step 3.

5. Click Send & Save. When the Trigger input is pulsed, the Alert module
establishes communications with the SMTP mail server and emails the alert
message.

© 2007 Schneider Electric. All rights reserved.
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Alert Module Settings

Alert modules are not pre-configured and must be created and setup for your
meter’s alarming functionality to work correctly. See the table for details.

Setup Register Description
Message This text will appear on the pager or in the email.
Priority Allows you to set an alert's priority, from O (lowest priority) to 255 (highest priority)

Identifies the alert’s destination:
Destination Modem - this is the dialing string
Email - this is the email address

Specifies the type of alert: Email, ASCII, Alphanumeric Pager, Numeric Pager, Pegasys or

Type ION Alert

PagerNum The pager access number.

Com Port Specifies the communications port used to send the alert.
Attempts Sets the number of times that the module attempts to connect.

If the modem is unable to establish communications on the first attempt, this sets the

Retry Time amount of time (in seconds) the module waits before attempting to dial again.

For successfully sent alerts, this specifies a period that all Alert modules wait before

Lockout Ti S )
ockout fime another alert transmission can begin.

Location Identifies the meter that is sending the alert (ION Alerts only).
Modemlnit The initialization string used by the modem while the alert is being sent.
Email From Specifies the email address that appears in the From: field on the email.
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Setpoints

This chapter provides instructions for configuring meter setpoints.

In This Chapter
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Introduction

The Relative Setpoint module provides extensive control, secondary protection,
and analysis capabilities by allowing you to initiate an action in response to a
specific condition. It is particularly useful for performing actions based on
differences between a value (e.g. kW on phase 1) relative to a reference value (e.g.
kW demand for all three phases). Use this module’s outputs for demand control of
equipment or any other applications requiring setpoint activity relative to a
varying value. See the ION Reference for more information on the Relative Setpoint
module.

Configuring Setpoints

Over kW SWDemand

Use ION software to change your meter’s setpoints.

Using the Front Panel

You cannot configure Setpoints using the front panel.

Using ION Setup

1. Connect to your meter in ION Setup, using Advanced Mode.

2. Navigate to the Relative Setpoint module you want to configure.

Using Vista

Open your meter in Vista, and select the Setpoints tab. Click the Setup grouping
object. Use the switches to turn various monitoring on and off (see circled below).
Click the numeric boxes to edit condition settings.

Annunciate if the tatal kiw' Swhemand excesds lII ki Status Jl Demand 1 lew

Enable Over Demand Setpaint

Over Current on phase 1, 2, 3

Annunciate if the current on phase 1 exceeds
Annunciate if the current on phase 2 exceeds

Annunciate if the current on phase 3 exceeds

Over Yoltage unbalance

Annunciate if the Yoltage unbalance excesds

Enable Over IJ unbal Setpoint

‘ Click to change value, then press Enter
1
fal 0|

Status 11
%A Cwver I a,h, a; ﬁl —
&
[ o ]

E1E

[0 e Status Jl U unbal
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Relative Setpoint Module Settings

Several Relative Setpoint modules monitor the following for “over” conditions:
phase current, kW demand, and voltage unbalance. Other modules are used only
for EN50160 operation. See the table for details.

Module Label Description
Relative Setpoint 1 Over KW sd When active, this annunciates when the total kW SWDemand exceeds a specified amount.
Relative Setpoint 2 Over | 1 When active, this annunciates when the current on phase 1 exceeds a specified amount.
Relative Setpoint 3 Over | 2 When active, this annunciates when the current on phase 2 exceeds a specified amount.
Relative Setpoint 4 Over |3 When active, this annunciates when the current on phase 3 exceeds a specified amount.
Relative Setpoint 5 Over U unbal When active, this annunciates if the voltage unbalance exceeds a specified percentage.
Relative Setpoint 6-14 (iv/o_l{ggg ?Z?isr:: Thesennine modules are used for EN501 6.0 operation. For more information, see the Power
period> Quality: ION Meters and EN50160 technical note.

2\ NOTE

There is usually no need to change any of the Relative Setpoint modules’ setup registers for normal
operation of the meter.

See the ION Reference for more information on the Relative Setpoint module.

Fine Tuning Over Condition Monitoring

If you want to fine-tune over condition monitoring, the only setup registers you
should change are SusUntlON and SusUntlOFF.

SusUntlON determines how long the modules wait after an over condition is
detected before reporting it. This gives the monitored value a short period to
correct itself before the event is registered with the module so that very brief over
conditions are ignored. Similarly, SusUnt/OFF is the amount of time a normal
value must be present before the module considers normal operation to be
restored. Both SusUntlON and SusUntlOFF values are entered in seconds (the
default value for both is 30 seconds).
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Power Availability

IONB8800A and ION8800B meters come pre-configured with a power availability
framework that provides reliability measurements using “number of nines”
calculations.

While the Availability Framework is pre-configured, the operation of this
framework requires the correct configuration of the Sag (Dip)/Swell module
according to your meter’s power supply and operating ranges. See “Sag/Swell
Module Configuration” on page 201. See also the ION Reference for detailed
descriptions of this module.

In This Chapter
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Resetting and Pausing Power Availability ............................... 201

@ DefailedBehavior . ...l 204
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Introduction

Availability on

Power availability predicts, based on historical data, the probability that a specific
power system will be functioning in its correct state at some point in the future.
The availability calculation measures the time that power was available at the
meter’s monitoring point. This value can be used alone or incorporated with other
reliability calculations.

Typically, a utility distribution system provides an availability of approximately
99.9%. Many applications require better availability than this: up to 99.9999% or
better. At this level, the number of consecutive nines becomes difficult to
determine at a glance. High levels of availability are commonly referred to as
“Number of Nines”: 99.9% corresponds to 3 nines; 99.9999% is 6 nines.

Once the meter is installed, the availability calculations must be reset to ensure
valid time counts. You can reset availability calculations using ION software. You
can also pause availability calculations for meter maintenance or
decommissioning purposes (see “Resetting and Pausing Power Availability” on
page 201).

the Meter Front Panel

The following power availability values display on the meter’s front panel, and are
viewable in the Vista component of ION Enterprise or ION Setup software:

¢ Number of Nines: the number of consecutive nines that appear in the most-
significant digits of the availability value (e.g. “10” on the front panel indicates
10 nines: 99.99999999).

¢ Availability-ppm: the fraction of time that the power is available, in parts per
million (ppm).

¢ Evaluation Time (days): the number of days that have elapsed since the
calculation was last reset. This gives an indication of the time interval over
which the availability calculation is made.

The availability framework is found at this location within Designer: Advanced
Setup > Power Quality Framework > Power Availability Framework.

Sample Availability Framework Behaviors

Scenario 1: 3-phase powered meter + power system outage

The Sag/Swell total disturbance time includes the outage. The meter downtime
from the diagnostics module is added to the meter uptime to account for the total
time of observation.

Scenario 2: 3-phase powered meter + meter decommissioned

The Sag/Swell module logs the downtime as disturbance time. When the meter
powers back up, the meter downtime from the diagnostics module is added to the
meter uptime.
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Scenario 3: single-phase powered meter + power system outage

The Sag/Swell total disturbance time includes the outage. The meter never loses
power, which means that there is no meter downtime and the meter uptime is
equivalent to the total time of observation.

Scenario 4: single-phase powered meter + meter decommissioned

The Sag/Swell module does not log a disturbance time. When the meter powers
back up, the meter downtime from the diagnostics module is added to the meter
uptime.

Assumptions
The above scenarios assume that:

1. The single-phase powered meter assumed the power system was within specs
during a meter down time if it didn't detect a disturbance prior to powering
down.

2. The Sag/Swell module is configured correctly to monitor voltage disturbances.

3. The Sag limit is set above the voltage level at which the meter starts powering
down.

4. An single-phase powered meter is used for applications that require a highly
accurate measurement of power system downtime.

Sag/Swell Module Configuration

Your meter’s power availability framework requires that the Sag/Swell module be
configured to the limits of your meter’s power supply specification.

For the most current specifications, see the ION8800 Installation Guide.

See the ION Reference for detailed information on the operation of the Sag/Swell
module.

Resetting and Pausing Power Availability

The power availability framework in the ION8800 meter allows the user to pause
or reset its operation. The framework can be paused and reset with ION software.

Using the Front Panel

You cannot reset availability using the meter’s front panel.

Using ION Setup

With ION Setup software, you can reset availability calculations by clicking on the
# of 9s Reset button in the Verification > Normal Mode > Power Quality tab.

1. Connect to your meter in ION Setup, Basic Mode, and open the Setup
Assistant.
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2. Select the Verification screen. On the Verification tab, double-click Normal
Mode.

3. In the Normal Mode screen, select the Power Quality tab.

4. Inthe Power Quality screen, click # of 9s Reset to reset availability calculations.
Provide a password (if requested) and click OK.

Normal Mode [ %]

Energyl Rolling Demandl ‘alts, Amps and Power  Power Quality |

Harrmanic: Power Quality

U1 THD% 5.000 Mumber of Mines 0.000
U2 THD 5.000

U3 THD 5.000

11 THD% 5.000

12 THD% 5.000

13 THD% 5.000

\ # of 93 Reset | Master Reset |

Lloze | §aveAs...| FErint | Help |

Using Vista

With Vista software, you can manually reset availability calculations. A meter is
typically reset after installation to ensure valid time counts.

Open your meter in Vista and select the Power Quality tab. Click the Setup and
Control grouping object. In the Power Quality Controls section, click the Reset
Availability Statistics button (see circle below).

Power—QuaIity Controls Use the back button to get to the main diagram

Reset Dip/swell counters @ Reset Availability Statistics @ Pause Availability ﬁl Resume
u| Pause
Manually trigger waveform recording @ Reset Harmonics Min/Max &
Click in the boxes below and type a value, Press Enter when you are done.,
Enable:
Dip/Swell detection ﬁ; Swell limit 106

. Dip limit a8
Waveform recording ﬁ;l i -
Change criteria
Harrmonics Logaging ﬁl

o Morminal voltage If nominal voltage is zero, power quality features are disabled

2\ NOTE

To ensure correct availability calculations, do not reset during a sag (dip) or swell.
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Pausing Availability

The availability framework allows a user to temporarily pause the meter uptime
counter and ignore any meter downtime and disturbance time. This allows a user
to decommission the meter without affecting the availability statistics. Availability
statistics are also paused when the Availability framework is “turned off.” Note
the “Pause Availability” switch on the graphic below.

Power—QuaIity Controls Use the back button to get to the main diagram

Reset Dip/swell counters @ Reset Availability Statistics @ Pause Availability ﬁl Resume
u| Pause

Manually trigger waveform recording @ Reset Harmonics Min/Max &

Click in the boxes below and type a value, Press Enter when you are done.,
Enable:

Dip/Swell detection ﬁ; Swell limit 106

. Dip limit a8
Waveform recording ﬁ;l i -
Change criteria
1

Harrmonics Logaging ﬁ .
o Morminal voltage If nominal voltage is zero, power quality features are disabled
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Detailed Behavior

The Availability framework measures Disturbance time from the Sag/Swell
module, Uptime from a counter module, and meter Downtime from the
Diagnostics module. Meter Downtime is added to the Uptime count to provide the
total time of observation.

The meter uses three measurements when calculating the availability:

1. Meter Uptime: the time the meter is powered and actively monitoring. The
time is measured by counting 1-second pulses from a Periodic Timer module.

2. Meter Downtime: this time is measured by the meter’s internal clock and made
available through the diagnostics module. The diagnostics module downtime
register is updated on each power up. This calculation is accurate across a single
month boundary: any additional month boundaries are assumed to have 30
days. You must set the Sag (dip) limit above the minimum voltage level specific
to the power supply and wiring configuration of the meter (see “Sag/Swell
Module Configuration” on page 201). If there is no control power then it is
assumed there is no power anywhere, and this time counts against availability.

When the meter powers up, it takes about 15 seconds before the ION modules
are operational again. This power up time counts against the availability (a
single power up per year limits total availability to 6 nines). If the application
requires better resolution than this, then a UPS or other auxiliary power supply
for the meter should be considered.

If the meter or control power circuit is taken out of service for maintenance, you
can disable the measurement of meter downtime with ION software; see
“Pausing Availability” on page 203.

Number of Nines | ppm (% x 10,000) | Downtime (seconds/year) | Downtime per year
1 90% 3153600 36.5 days

2 99% 315360 3.7 days

3 99.9% 31536 8.8 hours

4 99.99% 3153.6 52.6 minutes
5 99.999% 315.36 5.3 minutes

6 99.9999% 31.536 31.5 seconds
7 99.99999% 3.153599998 3.2 seconds

8 99.999999% .3153599998 .32 seconds

9 99.9999999% .03153599998 .032 seconds
10 99.99999999% .003153599998 .0032 seconds

3. Voltage Disturbance Duration: the total number of seconds that the voltage was
outside the envelope determined by the Sag/Swell module. If several sags or
swells occur during one second, only the last one counts toward the total. The
Sag/Swell module settings may be used to control the voltage tolerance. If the
Sag/Swell module is not enabled, no voltage disturbances are counted.
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Terminology

¢ 3-phase powered meter: the power to run the meter is derived from the Voltage
input terminals that are connected to the monitored system. The meter loses
power if the monitored system is down.

¢ Single-phase powered meter: The power to run the meter is derived from an
independent power source. The meter remains powered when the monitored
system is down.

¢ Meter uptime: the time the meter is powered and actively monitoring. The time
is measured by counting 1-second pulses from a Periodic Timer module.

¢ Meter downtime: the time the meter is not powered. This time is measured by
the meter’s internal clock and made available through the diagnostics module.
The diagnostics module downtime register is reset at the beginning of each
outage.

¢ Availability: the probability of finding a system in the operating state at some
time into the future. Availability is calculated as:

Availability = Time the power system is operating .within specifications
Total time of operation*

= Meter uptime - disturbance time
Meter uptime + meter downtime

* Where total time of observation = uptime + meter downtime

¢ Unavailability: calculated in the framework and then converted to number of
nines, and Availability in percent and parts per million (ppm):

Time the power system is operating outside specifications
Total time of operation®

Unavailability =

— Disturbance time
Meter uptime + meter downtime

* Where total time of observation = uptime + meter downtime
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This chapter provides instructions for viewing various meter reports and logs.

In This Chapter
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Introduction

Accumulated meter values are saved in logs. These logs are acquired by your
energy management software (ION Enterprise or third-party) and saved in its
database for analysis and reporting.

The Reporter component of ION Enterprise is a database reporting application that
lets you define, generate, and manage comprehensive reports based on the
information in your system database. It processes selected data and generates a
finished report in Microsoft Excel 2000 format.

For more information on reports, see the Reporter section of the online ION
Enterprise Help.

Viewing Meter Logs

View meter logs using ION software or the front panel.

Using the Front Panel

The front panel only displays recent high priority events (Event Log screen).

DATE TIME EVENT CODE
12/08/2005 10:23:45 Shutdown SD25
12/08/2005 10:42:03  Power Up SD25

12/08/2005 11:19:26 Changed Setup  SD25
VIEW EVENT LOG THROUGH COMMUNICATIONS
9:36:54  12/09/2005 123 Q1 NORM H_]

Press the Up and Down buttons to navigate to the Event Log.

Using ION Setup

Display various meter logs or reports using the Report Assistant.

1. Open ION Setup and connect to your meter, using Basic Mode.
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2.

5.

In the Setup Assistant, navigate to the Reports folder.

Setup Assistant E

Meter [nfo |

This shows the meter event information.

Fevenue Log
Energylemand Lo

Meter Configuration

E= Disp!ays. Configuration Comparizon
== “erification Template Comparizon
== Reports
\ viviy_|
< Back | Mewt > | Exit | Help

Select one of the logs or comparisons in the list and click Display to view the

associated log.

Select which records you want to view (all, specific number, or date range) and

click OK.

Upload Log Records [_ (O] =]

£ Al available records

o Last I Irecords 'l
€ Since [March -] [z [z008

()3 I Cancel |

Below is an example of an Events Log.

1 Event Log for PQ-D206A010-03 ]

D ate/Time Cause Walue Effect

18/411/2004 1:2312533 P Front Panel Changed Setup SD395ub Intvl - 900
18/411/2004 1:2312884 P Front Panel Changed Setup SD405ub Intvl - 900
18/411/2004 1:2313.045 P Front Panel Changed Setup SD41 SubIntel 900
15/411/2004 1:2313.444 P Front Panel Changed Setup SD42SubIntvl - 900
18/411/2004 1:2313675 P Front Panel Changed Setup SD435ubIntyl - 900
18/411/2004 1:2313.912PM  Front Panel  Changed Setup SD44 Sub Intvl 900
18/411/2004 1:2314.310 P Front Panel  Changed Setup SD45 Sub Intvl - 900
18/411/2004 1:2314.476 P Front Panel Changed Setup SD46 Sub Intvl 900
18/411/2004 1:2314.777 P Front Panel  Changed Setup SD47 SubIntvl - 900
15/411/2004 1:2314.953PM  Front Panel Changed Setup SD48SubIntvl - 900
18/411/2004 1:2315.353 P Front Panel Changed Setup SD495ub Intvl - 900
15/11/2004 1:2315.586 PM  Front Panel  Changed Setup SDA0Sub Intvl 900
1841172004 1:2315.812PM  Front Panel Changed Setup SD51 SubIntvl 900
18/411/2004 1:2315.993 P Front Panel Changed Setup SDB2 SubIntvl 900
15/411/2004 1:2316.386 PM  Front Panel Changed Setup SDB3 SubIntyl - 900
18/411/2004 1:2316552 PM  Front Panel Changed Setup SD54 SubIntvl 900
15/411/2004 1:2316.850 PM  Front Panel Changed Setup SDES Sub Intvl - 900
15/11/2004 1:2316.951 P Front Panel Changed Setup SDBE Sub Intvl 900 LI

Cloze | Save bz | Frint | Help |

You can view, save, or print the log. Click Close to exit.

© 2007 Schneider Electric. All rights reserved.
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Using Vista
Open your meter in Vista and click on the various tabs available. Click a grouping
object to view the associated logs. The following logs are available in Vista:
¢ System & Logs tab:
+ Voltage

Current
Power

.
.
+ Power factor / Frequency
+ Revenue data

.

Meter events
¢ Power Quality tab:
+ Harmonics trending
+ Dip/Swell statistics CBEMA
+ Waveforms/Sequence of Events (if supported)
.
.

Transient (if supported)
EN50160 (if supported)
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22

Verifying Accuracy

All ION8800 meters are tested and verified at the factory according to ANSI and
IEC (International Electrotechnical Commission) standards; however, before a
new revenue meter is installed it is important to perform a final accuracy
verification.

ION meters are digital and do not require calibration, only verification of their
accuracy. This chapter outlines a procedure for accuracy testing ION8800 meters.

In This Chapter
@ Infroduction ....... ..ol 212
Accuracy Standards ............. . 212
Current Ranges . . ... 212
Testing Overview ........ ... 212
TestProcedure ..........ccciiiiiiiiiiiiiiiiiiiiiiiiiiinnn. 214
Connectingthe TestHarness . ...........c.cciiiinenennennennnn. 215
Connecting the Control Equipment . ..................coiiinn... 216
Usingthe LEDs . ... i i 216
Using the Digital Outputs ........... ... ... . o i il 216
& Configuring Test SeHings . . ..o ovvvevtnnineenneenenenenennnns 217
Digital Outputs settings ............. ... ... ... .. i 217
LED pulsersettings ................ .. ... . i 217
Changing the energy pulse rate from the Front Panel ................. 217
Changing the energy pulse rate in ION Setup ........................ 217
Changing the energy pulse rate in Designer ......................... 218
TestPoints ...... ... e 218
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Introduction

The revenue-accurate ION meter is digital and therefore needs no servicing. It is
tested for accuracy at the factory and remains accurate for the life of the meter. In
contrast, electro-mechanical meters need mechanical adjustment before
installation and periodic calibration thereafter. This procedure of ‘calibration
testing’ is unnecessary for digital meters.

Digital meters require ‘accuracy’ testing, or verification to ensure the meter meets
required accuracy specification. If you know your meter is within required
accuracy specification before installation, errors observed in the field could be
attributed to incorrect connections or instrument transformer ratio settings.

Accuracy Standards

Current Ranges

Testing Overview

The meter conforms to the following accuracy standards:
¢ [EC 62053-22 Class 0.2S (for 1A and 5A)
¢ ANSI C12.20 Class 0.2

The meter meets the following current ranges:
¢ Compatible with CTs in the range of 10 mA to 10A
¢ Opver-range current of 14 A

& Starting current of 1 mA

/i\ DANGER

During normal operation of the meter, hazardous voltages are present which can cause severe injury or
death. These voltages are present on the connector pins of the device and throughout the connected
potential transformer (PT), current transformer (CT), status input, relay, and control power circuits. Only
qualified, properly trained personnel should perform installation and servicing.

The most common method for testing meters is to inject voltage and current from
a stable power source in combination with a reference meter. Although meter
shops use different methods for testing revenue meters, most test equipment
requirements are similar. The sections below provide an overview and some test
equipment guidelines for verifying the accuracy of your ION8800.

Test harness

A test harness is essential for non-socket meters. Ensure that the test harness for
the meter is wired properly. The current and voltage transformers must be
accurately rated and must perform within specifications to provide accurate
results.

Page 212
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Power source

Itis important to have a steady power source. Power that energizes the meter must
be reliable and provide: the rated voltage of the meter, unity power factor (1) and
lagging power factor of 0.0 (for varh testing) or 0.5.

Test loads

There are three methods of current loading: customer’s load (a meter in service),
resistance load (characteristics similar to a lighting load), phantom loading (a test
board). Your test load device or other loading circuit must be set within the current
capacity ranges for the meter. The procedure outlined in this chapter describes
verification using a phantom load or test board.

Control equipment

Control equipment is required for counting and timing the pulse outputs
(revolutions) from the front panel LEDs. Most standard test benches have an arm
with infrared sensors used for this purpose.

Environment

The meter should be tested at the same temperature as the testing equipment. The
ideal temperature is about 22°C (72°F). Ensure the meter is warmed-up sufficiently
before testing (at least 30 minutes).

2\ NOTE

Ensure the accuracy and precision of any measurement equipment you use (i.e. voltmeters, ammeters,

power factor meters).

© 2007 Schneider Electric. All rights reserved.
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Test Procedure

The following are guidelines for testing the meter. Your meter shop may have other
testing methods:

1.

Place the meter into the test harness or other standard measuring device.
Ensure all voltages are in parallel with the meter being tested and all currents
are in series (see “Connecting the Test Harness” on page 215).

Connect the control equipment used for switching the voltage to the test
standard device.

Connect the control equipment used for counting the standard output pulses
using either method:

¢ align the infrared sensor on the standard test bench armature over the
appropriate front panel LED pulser (Wh or varh).

OR

¢ connect to the meter’s digital outputs (see “Connecting the Control
Equipment” on page 216).

Apply the rated current and voltage to the terminals of the meter.

Before performing the verification test, let the test equipment power up the
meter. Apply voltage for at least 20 seconds. The warm-up allows the internal
circuity and capacitors to stabilize.

Set the meter’s volts mode to 4W-WYE.

You may choose to place the meter in test mode (see Test Mode chapter for more
details). This allows the meter to enter the field with no Wh values in the
registers. If you are performing field testing, put the meter in test mode to avoid
incorrect customer billing.

Perform testing on the test points (see “Test Points” on page 218).

Run each test point for at least five seconds to allow the test bench equipment to
read an adequate number of pulses. Allow three seconds of dwell time between
test points.
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Connecting the Test Harness

WECO model 8CA-1 adapter provides an easy means of connecting an ION8800
meter to a WECO test machine.

1. Connect the harness wires to the meter’s voltage and current inputs:

Test Machine Socket

O
V1

O

)]

Meter Voltage and Current Inputs

2. Plug the adapter into the WECO test machine’s socket.
3. Set the WECO machine to 9S.

© 2007 Schneider Electric. All rights reserved.
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Connecting the Control Equipment

You can use either the meter’s front panel LEDs or the digital outputs for control
purposes.

Using the LEDs

1. Carefully position the test machine’s optical arm over the applicable LED
pulser (Wh or varh).

2. Set test machine to “adjust optics” and ensure that LED pulses are being read.

Using the Digital Outputs

Connect the meter’s Form C solid-state digital outputs to the WECO test machine.
The Essailec connectors are found on the rear of the meter. See your meter’s
Installation Guide for details on your specific I/O wiring configuration.

+5VDC from WECO

Form C Solid-State Solid-State Input

Digital Output

K (common) NO
- +
J» 600 Ohm
= From WECO
From WECO .
Solid-State Input Solid-State Input o/‘-/ o

[

|

+12 VDC from WECO
RELAY - SPST Solid-State Input
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Configuring Test Settings

When testing the meter, ensure the test parameters are suited to your testing
methods. You may need to adjust the energy pusling outputs’ pulse rate (Kt value),
pulse width, and the test mode timeout.

Digital Outputs settings

Four Form C digital outputs are preconfigured for energy pulsing as follows:
¢ DOI1 = Wh Delivered

¢ DO2 = Wh Received

¢ DO3 = varh Delivered

¢ DO4 = varh Received

LED pulser settings

Two LEDs on the front panel are preconfigured for energy pulsing -- one for Wh
and one for varh. The adjacent smaller infrared outputs are connected to the LEDs
and pulse at the same rate. You may need to increase the pulse rate if the LED does
not pulse.

Changing the energy pulse rate from the Front Panel

You cannot change the energy pulse rate from the meter’s front panel.

Changing the energy pulse rate in ION Setup
1. Connect to your meter in ION Setup, Basic Mode, and open Setup Assistant.
2. Navigate to Pulsing outputs folder.

For LEDs, select LED Pulsing and select the tab of the LED you want to
configure. Edit the Wh and varh values as desired.

= Template kKih |kvarh I
= Basic Setup
E= Security Specifies the number of watt-hours that are accumulated per LED
(2] Communications pulke
== Clock
== Demand
(Z] Pulsing outputs
= LED Pulsing CAPT Kt
= Energy Pulsing W Pulse Width 0.05
T Pulser Mode  Always
ED_ ;?'?’%;gﬁonection wh pulse ovild Pulsing normally
2 Revene
== Dizplayz
= Werification INumeric Bounded Format j
= Reports
Edit | ()3 I Cancel | Help |
T
< Back | Mest » | Exit | Help |

© 2007 Schneider Electric. All rights reserved. Page 217



Chapter 22 - Verifying Accuracy ION8800 User Guide

For Digital Outputs, select Energy Pulsing and select the tab of the energy
pulsing value you want to configure. Edit the settings as desired.

Setup Assistant E

Kiwh Del | Kwh Rec | kvath Del | kvarh Rec |

Specifies the number of delivered watt-hours that are accumulated
per physical pulze.

(27 Pulsing outputs

== LED Pulsing LA 1
== Energy Pulsing CAP3 Pulse Width  0.05
= Egging CAP3 Outputbode K2
. CaP3 Port Port DO [Formi)
== PT/CT Carrection wh del ovrld Pulsing narmally

R
- D;\,;Tar;ie Enter CAP3 Kt =]
= Repartz INumeric Bounded Farmat j

&I ak. I Cancel | Help |

< Back | Mext » | Exit | Help |

Changing the energy pulse rate in Designer

1. Open the meter using Designer and open the Energy Pulsing Setup grouping
window.

2. Right-click the Calibration Pulser module you want to modify.
Double-click the register you want, make your change and click OK.
4. Click the Save icon (or select File > Send & Save).
The Kt value entered defines how much energy the module accumulates before a

pulse is sent to the hardware channel. The front panel Wh and varh LEDs are
factory set to the same pulse rate.

Test Points

2\ NoTe

It is recommended that you test the ION8800 meter at Full and Light Loads.

Wh test points

It is common practice to test these points:

Wh Test Point Specifications
Rated test
current is Full Load 100% of the rated current, test voltage and rated frequency at unity
ull Loa
found on power factor, or one (1).]
the
meter’s 0 :
front e Light Load 10% of the rated current, test voltage and rated frequency at unity power
e factor, or one (1).
panel. -
. 100% of the rated current, test voltage and rated frequency at 0.50
Lagging Power Factor . . o
lagging power factor (current lagging voltage by 60° phase angle).
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! The rated test current is found on the ION8800 meter front panel label.

varh points

It is common practice to test these points:

kvarh Test Point Specifications

Full Load 100% of the rated current, test voltage and rated frequency at zero power
ull Loa
factor (current lagging voltage by 90° phase angle).

Light Load 10% of the rated current, test voltage and rated frequency at zero power
g factor (current lagging voltage by 90° phase angle).

100% of the rated current, test voltage and rated frequency at 0.50

Lagging P Fact
A991ng Fower ractor lagging power factor (current lagging voltage by 60° phase angle).
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